CLASS X

Information Technology

NSQF LEVEL-2

Central Board of Secondary Education
Shiksha Kendra, 2, Community Centre, Preet Vihar, Delhi-110301
Information Technology
NSQF Level-2, Class X

Price: ₹ 130/-

First Edition: June 2015, CBSE

Copies: 5000

Paper used: 80 GSM CBSE Watermark White Maplitho

“This book or part thereof may not be reproduced by any person or agency in any manner.”

Published by : The Secretary, CBSE, Central Board of Secondary Education, Shiksha Kendra, 2, Community Centre, Preet Vihar Delhi-110301

Design, Layout : Sheel Packers Printing Press
& Printed by : 10/63-G, Kirti Nagar Industrial Area, New Delhi-110015
भारत का संविधान

उदेश्यका
हम, भारत के लोग, भारत को एक सम्पूर्ण प्रभुत्व-संपन समाजवादी पंथनिरपेक्ष लोकतंत्रात्मक गणराज्य बनाने के लिए, तथा उसके समस्त नागरिकों को:

सामाजिक, आर्थिक और राजनैतिक न्याय,
विचार, अभिव्यक्ति, विश्वास, धर्म
और उपासना की स्वतंत्रता,
प्रतिष्ठा और अवसर की समता
प्राप्त कराने के लिए
tथा उन सब में व्यक्ति की गारंटी
'और राष्ट्र की एकता और अखंडता
सुनिश्चित करने वाली बंपुत्र बढ़ाने के लिए

दुबुद्धकल्प होकर अपनी इस संविधान सभा में आज तारीख 26 नवम्बर, 1949 ई को एनद्वारा इस संविधान को अग्रिमगत,
अधिनियमित और आत्मनिर्भर करते हैं।

1. संविधान (बायालीसवां संशोधन) अधिनियम, 1976 की धारा 2 द्वारा (3.1.1977) से "प्रभुत्व-संपन लोकतंत्रात्मक गणराज्य" के रूप में प्रस्तावित।
2. संविधान (बायालीसवां संशोधन) अधिनियम, 1976 की धारा 2 द्वारा (3.1.1977) से "राष्ट्र की एकता" के रूप में प्रस्तावित।

भाग 4 के
मूल कर्त्तव्य

51 के, मूल कर्त्तव्य – भारत के प्रथम नागरिक का यह कर्त्तव्य होगा कि वह –

(क) संविधान का पालन करें और उसके आदेश, संस्थाओं, राष्ट्ररक्षक और राष्ट्रीय आदेश का आदर करें;
(ख) स्वतंत्रता के लिए हमारे राष्ट्रीय आदेशों को प्रतिष्ठा करने वाले उच्च आदेशों को हदय में संजोए रखें और उनका पालन करें;
(ग) भारत की प्रभुत्व, एकता और अखंडता की रक्षा करें और उसे अस्थायी रखें;
(घ) देश की रक्षा करें और आह्वान किए जाने पर राष्ट्र की सेवा करें;
(ड) भारत के सभी लोगों में समस्तता और समान भागिन्य की भावना का निर्माण करें जो धर्म, भाषा और प्रदेश या वर्ग पर आधारित सभी भेदभाव से दूर हों, ऐसी प्रतिकृतियाँ का व्यापार करे जो सिखियों के समान अश्रु हैं;
(च) हमारी सामाजिक संस्कृति की गौरवशाली परिपदा का महत्त्व समझे और उसका परिश्रम करें;
(छ) प्राकृतिक पर्यावरण की जिसके अंतर्गत वन, झील, नदी, और वन जीव हैं, रक्षा करें और उसका संरक्षण करें तथा प्राणिमात्र के प्रति दयाभाव रखें;
(ज) वैश्वानिक दृष्टिकोण, मानववाद और ज्ञानजीन तथा सुधार की भावना का विकास करें;
(झ) सार्वजनिक संपत्ति को सुरक्षित रखें और हिंसा से दूर रखें;
(ञ) व्यक्तिगत और सामूहिक गतिविधियों के सभी क्षेत्रों में उत्कृष्ट की ओर बढ़ने का सतत प्रयास करें जिससे समाज निरंतर बढ़ते हुए प्रयत्न के साथ उसकी नई उन्नयन को छोड़ दें;
(ट) यदि माता-पिता या संस्कार है, छह वर्ष से चौदह वर्ष तक की आयु वाले अपने, व्यक्तिगत, बालक या प्रतिपाल्य के लिये शिक्षा के अवसर प्रदान करें।

1. संविधान (बायालीसवां संशोधन) अधिनियम, 2002 द्वारा प्रस्तावित।
THE CONSTITUTION OF INDIA

PREAMBLE

WE, THE PEOPLE OF INDIA, having solemnly resolved to constitute India into a SOVEREIGN SOCIALIST SECULAR DEMOCRATIC REPUBLIC and to secure to all its citizens:

JUSTICE, social, economic and political;

LIBERTY of thought, expression, belief, faith and worship;

EQUALITY of status and of opportunity; and to promote among them all

FRATERNITY assuring the dignity of the individual and the unity and integrity of the Nation;

IN OUR CONSTITUENT ASSEMBLY this twenty-sixth day of November, 1949, do HEREBY ADOPT, ENACT AND GIVE TO OURSELVES THIS CONSTITUTION.

1. Subs, by the Constitution (Forty-Second Amendment) Act. 1976, sec. 2, for "Sovereign Democratic Republic" (w.e.f. 3.1.1977)
2. Subs, by the Constitution (Forty-Second Amendment) Act. 1976, sec. 2, for "unity of the Nation" (w.e.f. 3.1.1977)

---

THE CONSTITUTION OF INDIA

Chapter IV A

FUNDAMENTAL DUTIES

ARTICLE 51A

Fundamental Duties - It shall be the duty of every citizen of India:

(a) to abide by the Constitution and respect its ideals and institutions, the National Flag and the National Anthem;

(b) to cherish and follow the noble ideals which inspired our national struggle for freedom;

(c) to uphold and protect the sovereignty, unity and integrity of India;

(d) to defend the country and render national service when called upon to do so;

(e) to promote harmony and the spirit of common brotherhood amongst all the people of India transcending religious, linguistic and regional or sectional diversities; to renounce practices derogatory to the dignity of women;

(f) to value and preserve the rich heritage of our composite culture;

(g) to protect and improve the natural environment including forests, lakes, rivers, wild life and to have compassion for living creatures;

(h) to develop the scientific temper, humanism and the spirit of inquiry and reform;

(i) to safeguard public property and to abjure violence;

(j) to strive towards excellence in all spheres of individual and collective activity so that the nation constantly rises to higher levels of endeavour and achievement;

(k) to provide opportunities for education to his/her child or, as the case may be, ward between age of 6 and 14 years.

CBSE has introduced Information Technology (IT) as Vocational course at secondary level in class IX (Level-1) and class X (level-2). In the present day of globalized competition, Information Technology plays a significant role. Information Technology (IT) has created a revolution in every field and enabled students towards progressive learning. To enable students towards progressive learning CBSE equip the students with specialized vocational training.

This Students Handbook titled "Information Technology NSQF Level-2" for class - X was prepared by PSSCIVE Bhopal for the benefit of the students who opt for the course.

Ample care has been taken to align the subject with National Occupation Standards (NOS) which are competency based standards identified by the IT industry to train students in knowledge and skills that equip students to perform effectively with confidence.

The language used in this book is simple and easily understandable to the students at class X level. Relevant pictorial illustrations, tables, examples and simplified concepts provided in this book help the students to learn with ease and comfort.

This book is authored by competent educationists in the field of Information Technology under the supervision of PSSCIVE with focus on helping the students to learn without any difficulty and use this book as a tool for easy learning.

I congratulate everyone who is associated in developing this book which is a very useful resource for the benefit of the students.

Dr. Satbir Bedi, IAS
Chairperson, CBSE
ACKNOWLEDGEMENTS

ADVISORS

• Dr. Satbir Bedi, IAS, Chairperson, CBSE
• Shri M.V.V Prasada Rao, Director (Voc & Edusat), CBSE

CONTENT DEVELOPED BY

• PSSCIVE, Bhopal

EDITING & COORDINATION

• Dr. Biswajit Saha, Additional Director (Voc. Education), CBSE
# INFORMATION TECHNOLOGY – (SUBJECT CODE - 402/462)

**NSQF LEVEL II – CLASS X**

## FIRST TERM (SA 1)

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Unit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIT 1</td>
<td>Functional English (Intermediate)</td>
</tr>
<tr>
<td>UNIT 2</td>
<td>Web Applications (Basic)</td>
</tr>
<tr>
<td>UNIT 3</td>
<td>Word Processing (Intermediate)</td>
</tr>
</tbody>
</table>

## SECOND TERM (SA 2)

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Unit Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIT 4</td>
<td>Spreadsheet (Intermediate)</td>
</tr>
<tr>
<td>UNIT 5</td>
<td>Digital Presentation (Intermediate)</td>
</tr>
<tr>
<td>UNIT 6</td>
<td>E-Mail Messaging (Intermediate)</td>
</tr>
<tr>
<td>UNIT 7</td>
<td>Data Base Development (Basic)</td>
</tr>
</tbody>
</table>

## Practical

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
</tr>
<tr>
<td>Viva based on Project</td>
</tr>
<tr>
<td>Practical File / Report and Portfolio</td>
</tr>
<tr>
<td>Demonstration of Skill Competency in Lab Activities</td>
</tr>
</tbody>
</table>

(vii)
<table>
<thead>
<tr>
<th>Sl. No.</th>
<th>Name of Unit</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit 1</td>
<td>Functional English (Intermediate)</td>
<td>1</td>
</tr>
<tr>
<td>Unit 2</td>
<td>Web Applications (Basic)</td>
<td>75</td>
</tr>
<tr>
<td>Unit 3</td>
<td>Word Processing (Intermediate)</td>
<td>117</td>
</tr>
<tr>
<td>Unit 4</td>
<td>Spreadsheet (Intermediate)</td>
<td>148</td>
</tr>
<tr>
<td>Unit 5</td>
<td>Digital Presentation (Intermediate)</td>
<td>181</td>
</tr>
<tr>
<td>Unit 6</td>
<td>Email Messaging (Intermediate)</td>
<td>209</td>
</tr>
<tr>
<td>Unit 7</td>
<td>Database Development (Basic)</td>
<td>238</td>
</tr>
</tbody>
</table>
Unit 1: Functional English (Intermediate)

Practice and Speak Fluent English
CONTENTS

Unit 1: Functional English (Intermediate)

SESSION 1: ORDERING FOOD AT A RESTAURANT .................................................................3
SESSION 2: MAKING RESOLUTIONS ....................................................................................5
SESSION 3: TALKING ABOUT CHANGE .................................................................................8
SESSION 4: PLANNING AN OUTING ..................................................................................11
SESSION 5: NARRATING A STORY .......................................................................................14
SESSION 6: DESCRIBING A KNOWN PLACE ......................................................................17
SESSION 7: GIVING DIRECTIONS .......................................................................................21
SESSION 8: DESCRIBING AN EVENT ..................................................................................25
SESSION 9: RECOUNTING AN EXPERIENCE ......................................................................28
SESSION 10: FINDING A PLACE TO STAY .........................................................................31
SESSION 11: SAYING NO ..................................................................................................35
SESSION 12: DESCRIBING A LOST ITEM ..........................................................................38
SESSION 13: APPRECIATING SOMEONE ...........................................................................41
SESSION 14: ATTENDING A PHONE CALL .........................................................................43
SESSION 15: GIVING INSTRUCTIONS ...............................................................................48
SESSION 16: REGISTERING A COMPLAINT .......................................................................51
SESSION 17: CALLING UP TO FIND ABOUT A JOB VACANCY .........................................55
SESSION 18: WRITING A RESUME ....................................................................................57
SESSION 19: WRITING A COVERING LETTER .................................................................62
SESSION 20: FACING AN INTERVIEW ...............................................................................67
SESSION 21: TAKING A TELEPHONIC INTERVIEW ..........................................................70
SESSION 22: ACCEPTING A JOB OFFER ...........................................................................72
SESSION 1: ORDERING FOOD AT A RESTAURANT

Relevant Knowledge

Imagine that you are at a restaurant. The waiter has come to ask what you would like to have, and you want to order a plate of vegetable chowmein. How would you place the order? Think about it and try to frame some sentences to do so.

When we place an order, there are some common terms used. Some of them are introduced here. Read aloud the following terms:

- **Starters** - The first course in a meal, also called “appetizers” or “starters”.
  Usage: “I would like to have Fried Vegetarian Momos for starters.”

- **Main course** - The primary or main dish in a meal.
  Usage: “I would like to have Shahi Paneer, Chane Pindi, Raita and Rumali Roti for the main course.”

- **Dessert** - The final course of a meal - it may be fruits or a sweet dish.
  Usage: “I would like to have Kheer for dessert.”

Study the dialogue given below and fill up the blanks using the following information:

- Starters - Chilly Potatoes.
- Main course - Vegetable Fried Rice and Chicken Manchurian with gravy.
- Dessert - Chocolate Ice-cream.
- A bottle of mineral water.

Using Articles - a, an, the

Examples

A false friend is worse than an enemy.

Are you a good teacher?

Are you the teacher who is going to teach English?

**EXERCISE**

Given below is a conversation between a waiter and the customer at a restaurant. Imagine that you are the customer. Now fill in the blanks with the statements that you like to make while talking to the waiter.

1. **Waiter** : Are you ready to place your order, Ma’am/Sir?
2. **Customer**: Yes. For __________, I would like to have
3. **Waiter**: How many?
4. **Customer**: Just one plate will do.
5. **Waiter**: Okay.
6. **Customer**: For ______________, I will have
7. **Waiter**: Okay. Anything else Ma’am/Sir?
8. **Customer**: Yes. I would like to order a ______________
9. **Waiter**: Okay. One Chilly Potatoes, one Vegetable Fried Rice, one Chicken Manchurian with gravy, and one Chocolate Ice-cream. Is that correct, Ma’am?
10. **Customer**: Yes.
11. **Waiter**: Can I get you anything else?
12. **Customer**: Could you get me ________________?
13. **Waiter**: Sure, Ma’am/Sir.
14. **Customer**: _________________ you. That will be all.

**ASSESSMENT**

**Fill in the blanks with the correct articles A, AN, and THE, wherever necessary.**

1. Could you get me _______________ bowl of chicken soup? (a, the).
2. I would like to cancel _______________ (a, the) Masala Dosa I ordered and have _______________ plate of Tandoori chicken with fried rice instead (a, the).
3. I ordered _______________ chocolate ice cream, not strawberry (a, the, no article needed).
4. I will have a tomato and mushroom pizza with _______________ cheese topping. (a, the, no article needed).
5. For dessert, _______________ plate of kheer will do (a, the, no article needed).
6. I will have _______________ kheer for dessert (a, the, no article needed).
7. Our specialty is _______________ Tandoori chicken. Do try it (a, the, no article needed).
8. Please get me _______________ glass of water.
9. I would like to have _______________ onion masala dosa and vanilla ice-cream.
10. Excuse me, where is _______________ washroom?
11. What is _______________ specialty of this restaurant?
12. Can I smoke _______________ cigarette here?
13. Can we sit on _______________ upper floor?
14. What is on _______________ menu today?
15. Do you serve _______________ Chinese food here?
16. Please give me some _______________ tissue paper.
17. Could you tell me _______________ recipe of this dish?

SESSION 2: MAKING RESOLUTIONS

Relevant Knowledge
Have you ever made a promise to yourself? A promise could be as simple as:
1. I will never lose my temper again.
2. I will try to study hard this year and get a 1st division.
3. I will talk less on my mobile.
4. I will help mother out with her household chores when she comes home tired from work.
5. I will get 95% in Math this year.
6. I will learn to speak properly in English within six months.

Think about what you would like to promise to yourself. These promises are actually what are known as your own “resolution”. In the session, we will learn about this concept.

Simple future tense
The use of words like will and shall denote the future time of action.

Now read the following sentences:

Set A
1. I will try to learn English well.
2. I will try to see fewer movies.
3. I will learn three new words every day.
4. I will exercise every morning for 1 hour.
5. I will not carry forward any regrets.
6. I will keep my room neat and clean.
7. I will accept the terms and conditions.
8. He will not let you join.
9. But we will argue in your favour.

Now compare the above sentences with the following:

Set B
1. I try to learn English well.
2. I try to see fewer movies.
3. I learn three new words every day.
4. I exercise every morning for 1 hour.
5. I take care of the dogs in my colony.
6. I do not carry any regrets.
7. I keep my room neat and clean.

Do you see the difference between the two sets i.e. set A and B of sentences? The first set of sentences is in simple future tense. The second set denotes a fact or a habit, and are all in the simple present tense.

EXERCISE

Read the following sentences. These are incomplete sentences. Try to fill them with what you wish to do in your life.

1. I promise to...
2. I promise I will...
3. I resolve never to...
4. I resolve to...
5. I will try to...
6. I will try my best...
7. I am never going to...

ASSESSMENT

From the following options, select and tick the one that is in the simple future tense.

1. I did not smoke.
   (a) I will not smoke.
(b) I will not smoking
(c) I will not smoked.

2. I exercise everyday to stay fit and healthy.
   (a) I will exercised everyday to stay fit and healthy.
   (b) I will exercising everyday to stay fit and healthy.
   (c) I will exercise everyday to stay fit and healthy.

3. I opened a small flower shop in the market.
   (a) I will open a small flower shop in the market.
   (b) I will opened a small flower shop in the market.
   (c) I will opening a small flower shop in the market.

4. The president and his wife raised funds for charity.
   (a) The president and his wife will raising funds for charity.
   (b) The President and his wife will raised fund for charity.
   (c) The President and his wife will raise fund for charity.

5. I stuck to my resolution.
   (a) I will sticking to my resolution.
   (b) I will stick to my resolution.
   (c) I will stuck to my resolution.

6. I changed most of the furniture in my house before Diwali.
   (a) I will changed most of the furniture in my house before Diwali.
   (b) I will changing most of the furniture in my house before Diwali.
   (c) I will change most of the furniture in my house before Diwali.

7. I started going for driving classes on Tuesdays.
   (a) I will started going for driving classes on Tuesdays.
   (b) I will starting going for driving classes on Tuesdays.
   (c) I will start going for driving classes on Tuesdays.

8. Team India won every match against Australia in the World Cup.
   (a) Team India will won every match against Australia in the World Cup.
(b) Team India will every match against Australia in the World Cup.
(c) Team India will waning every match against Australia in the World Cup.

9. I spoke in English with my friends.
   (a) I will speak in English with my friends.
   (b) I will speaking in English with my friends.
   (c) I will spoke in English with my friends.

10. I wore the seat belt while driving.
    (a) I will wore the seat belt while driving.
    (b) I will wearing the seat belt while driving.
    (c) I will wear the seat belt while driving.

---

**SESSION 3: TALKING ABOUT CHANGE**

**Relevant Knowledge**

In this session, you will learn how to talk about change. Read aloud and try to understand from the examples given below.

1. **Change for the better** - *to change so as to improve*.
   
   **Example:** He does not watch junk movies anymore and it is a change for the better. He now enjoys serious cinema.

2. **Change for the worse** - *to change but become worse*.

   **Example:** She has started reading novels. But it is a change for the worse as she reads them more than her school books!

3. **Change with the times** - *to accept and adapt to new developments*.

   **Example:** Our school is changing with the times. We now have computer labs with free internet connection.

4. **For a change** - *as something different*.

   **Example:** Why don’t you wear a salwar suit for a change? You always wear sarees.

5. **Time for a change** - *an expression used when it is time to make a change*.

   **Example:** I asked her if she wanted a cake for her birthday, and she said, “It’s time for a change-let’s have pizza instead!”
6. **Times are changing** - a response made when you hear a surprising piece of news.

   **Example:** Man: “They charged me 500 Rupees for this tie!”. Woman: “Well, times are changing. Ties do not cost 100 Rupees anymore.”

7. **Sea change** - a major change.

   **Example:** There is a sea-change in the choice of careers. Many youngsters are more interested in MBA nowadays than in medicine or civil services.

8. **Times change** - as time passes, different things become acceptable.

   **Example:** The old man scolded his grandson for not cutting his long hair. He said that when he was young, he had to keep it short and oiled. His grandson said, “Times change, Grandpa!”

### Active and Passive Voice

Read the examples given below:

**Active** : The hair stylist changed the color of my hair.

**Passive** : The color of my hair was changed by the hair stylist.

**Passive** : I was praised by the headmaster.

**Active** : The headmaster praised me.

In certain sentences in the passive voice, the subject may not be mentioned:

1. You should do the work - *The work should be done.*
2. We completed the marathon at last - *The marathon was completed at last.*
3. Has she finished her homework? - *Has her homework been completed?*

### EXERCISE

Now, identify and tick the sentences that are in **Active Voice**:

1. They have been scolded.
2. I bought some clothes yesterday.
3. The teacher is correcting the test papers.
4. The test papers have been submitted.
5. We went there last summer.
6. We were welcomed by the hotel owner.
7. She believed him but we did not.
8. He was trusted neither by us nor by her.
ASSESSMENT

Select and tick the option that is in the passive voice.

1. Ravi had to revise the document.
   (a) Ravi had to be revised in the document.
   (b) The document had to be revised by Ravi.

2. Ram should learn how to adjust to change.
   (a) Adjusting to change is what Ram should learn.
   (b) How to adjust to change must be learned by Ram.

3. Seema has changed the curtains of the bedroom.
   (a) The curtains of the bedroom have been changed by Seema.
   (b) The curtains of Seema’s bedroom are changed.

4. Can Nayan update this file?
   (a) Can this file update Nayan?
   (b) Can this file be updated by Nayan?

5. The youth should change things for the better.
   (a) Things should be changed for the better by the youth.
   (b) The youth have to change things for the better.

6. He made some changes to this document.
   (a) To this document some changes he made.
   (b) Some changes were made to this document by him.

7. You can change your future by learning English.
   (a) Your English can change your future.
   (b) Your future can be changed by learning English.

8. Nothing can change his mind.
   (a) His mind can’t be changed by anything.
   (b) His mind can be changed by nothing.
9. The party workers do not like the new policies.
   (a) The policies do not like the new workers.
   (b) The new policies are not liked by the party workers.

10. Change makes progress possible.
   (a) Progress is made possible by change
   (b) Change makes possible progress.

SESSION 4: PLANNING AN OUTING

Relevant Knowledge
An outing can be going for a picnic, going for a movie, going out for lunch or dinner, or going out for shopping. All such outings require some preparation - the extent of the preparation may vary depending on the nature of the outing.

Imagine that you have to plan a picnic for your family and friends. You may have to prepare a “To Do” list of all that you need to do and take to the picnic. What would you do to prepare for the picnic? Think!

Making a suggestion for an outing:
1. Let us go for an outing!
2. Let us go for a picnic!
3. Let us go to the movies!
4. Let us go out for lunch!
5. Let us go shopping and have lunch outside.
6. How about going for a movie?
7. Shall we go for a picnic this Sunday?
8. How about a shopping trip and lunch afterwards?

Planning the outing:
1. I will book the cab and you can arrange for the food.
2. You can take care of the plates and glasses.
3. Bring bottles of water, napkins, and some plastic bags.
4. Can you bring two mats or an old bedcover to spread on the grass?
5. Can you check till what time the park is open?
6. Can you book the movie tickets?
7. We can meet at 6 outside the theatre.
8. I will call up Meena and Rakesh and see if they want to come along.

**Pronouns**

In this session, you will learn how to make use of pronouns. The reflexive pronouns discussed in this session are: myself, ourselves, themselves, yourself, yourselves, himself, herself, and itself.

Reflexive pronouns are used usually in 3 situations:

**Situation 1:** When the subject and object are the same.
For example:
1. I hurt myself.
2. The music group calls themselves “Dire Straits”.
3. He shot himself.

**Situation 2:** As the object of a preposition, when the subject and the object are the same.
For example:
1. I bought a present for myself.
2. She did it by herself. (She did it alone)
3. That man is talking to himself.

**Situation 3:** When you want to emphasize the subject.
For example:
1. I’ll do it myself (No one else will help me).
2. They ate all the food themselves (No one else had any).

**EXERCISE**

Identify the incorrect use of the pronouns.
1. Mitali and I went to the cafe to buy us some snacks.
2. When I saw me in the mirror, I was horrified to see red spots all over my face.
3. Did you learn typing yourself or you went to a school?
4. What he saw was so unexpected that he pinched him to see if it was for real.
5. Please help yourselves to the food - there is plenty!
6. I hurt myself while fixing the broken shelf.
7. I am busy...can’t you do the work yourself?
8. I bought a nice dress for me from the mall.

**ASSESSMENT**

Fill in the blanks with the correct pronouns.

1. Except Ruhi and ____________, everyone else arrived late at the movies.
   (a) I (b) me

2. Ravi was very helpful to ____________ when we went trekking in the mountains.
   (a) us (b) ourselves

3. We really enjoyed ____________ on the trip to Manali last month.
   (a) us (b) ourselves

4. His friends did not appreciate ____________ going to the fair alone.
   (a) his (b) himself

5. Please bring some cotton for your ears if you do not want to be bored by ____________ continuous chatter on the trip.
   (a) his (b) him

6. As our driver had fever, Naman and ____________ offered to drive the car for the rest of the journey.
   (a) mine (b) I

7. One of ____________ will have to speak to the travel agent and make arrangements for the trip.
   (a) you (b) your

8. We must reach the airport on time, or else ____________ will miss the flight.
   (a) we (b) us

9. It was ____________ who wanted to go to the mountains instead of the beach.
   (a) Himself (b) he
10. Two of the group members, including _____________, have offered to make food and travel arrangements for the trip.

(a) he  (b) him

SESSION 5: NARRATING A STORY

Relevant Knowledge

Have you ever been told a story before? Perhaps many times! What it is that you like the most about the narration of stories? Perhaps you like to know what happened to other people, or stories tell you what you could do in a similar situation, or maybe because it helps you to relieve tension and entertains you. You may have many other reasons. Think about them.

You will soon see that narrating a story is similar to narrating an incident - only story narration is desirable because it is presented in an animated fashion with the right intonations, pauses and exclamations.

When we narrate an incident too, we could use voice modulation to express what is being said with emotions. That would definitely make it interesting for the listener.

Narrating a Story of “Two Wolves”

Read out the following story aloud. Try to narrate the story as best as you can.

One evening, an old tribal told his grandson about a battle that goes on inside people. He said: “My son, the battle is between “two wolves” inside us all... One is Evil. It is anger, envy, jealousy, sorrow, regret, greed, arrogance, self-pity, guilt, resentment, inferiority, lies, false pride,... superiority, and ego. The other is good. It is joy, peace, love, hope, serenity, humility, kindness, benevolence, empathy, generosity, truth, compassion, and faith.”

The grandson thought about it for a minute, and then asked his grandfather: “Which wolf wins?”

The old tribal simply replied: “The one you feed.”

Simple Past Tense

In this session, you’ll learn how to make use of Simple Past Tense. Read aloud the following sentences:

1. My grandmother loved to narrate the story of Ram and Ravan to me when I was young.

2. I used to listen eagerly to her.
3. She always left off the story at an interesting point, and said “I will tell you what happened after that tomorrow”.

4. I would eagerly wait for the next day to come.

5. The next day I would pester her to tell me what happens next.

6. I enjoyed the storytelling sessions with my grandmother very much.

7. I don’t know if I will be able to entertain my grandchild in the same way.

8. Most probably I will not have many stories to tell or my grandchild will not be interested in listening to stories.

9. But I can surely say that telling stories helps to expand a child’s imagination in a way that no other thing does.

10. I was exhausted.

11. It was a very tiring journey.

12. I had a tiring journey.

13. The journey exhausted me.

EXERCISE

Do you remember the difference in the tenses? Now, identify the sentences that have been written in the present and future tense.

1. My grandmother loved to narrate the story of Ram and Ravan to me when I was young.

2. I used to listen eagerly to her.

3. I would eagerly wait for the next day to come.

4. I enjoyed the storytelling sessions with my grandmother very much.

5. I don’t know if I will be able to entertain my grandchild in the same way.

6. Most probably I will not have many stories to tell or my grandchild will not be interested in listening to stories.

7. I was exhausted.

8. It was a very tiring journey.

9. I had a tiring journey.
ASSESSMENT

From the options, select and tick the sentence that is in simple past tense.

1. (a) Seema visiting aunt Rekha at her house near the beach last weekend.
   (b) Seema visited aunt Rekha at her house near the beach last weekend.
   (c) Seema visit aunt Rekha at her house near the beach last weekend.

2. (a) It were a beautiful summer day.
   (b) It was a beautiful summer day.
   (c) It is a beautiful summer day.

3. (a) Seema building a giant sand castle on the beach.
   (b) Seema build a giant sand castle on the beach.
   (c) Seema built a giant sand castle on the beach.

4. (a) Aunt Rekha took pictures of the castle.
   (b) Aunt Rekha take pictures of the castle.
   (c) Aunt Rekha taking pictures of the castle.

5. (a) Seema wanted to play on the beach and build another sand castle.
   (b) Seema want to play on the beach and build another sand castle.
   (c) Seema wanting to play on the beach and build another sand castle.

6. (a) But soon it has become very hot outside.
   (b) But soon it became very hot outside.
   (c) But soon it becomes very hot outside.

7. (a) Aunt Rekha advised Seema to wear a hat.
   (b) Aunt Rekha advising Seema to wear a hat.
   (c) Aunt Rekha advises Seema to wear a hat.

8. (a) But Seema does not have a hat.
   (b) But Seema did not have a hat.
   (c) But Seema didn’t had a hat.
9. (a) So Aunt Rekha gave Seema one of her hats.
   (b) So Aunt Rekha giving Seema one of her hats.
   (c) So Aunt Rekha gives Seema one of her hats.

10. (a) Seema wearing the hat and made another sand castle.
    (b) Seema wears the hat and made another sand castle.
    (c) Seema wore the hat and made another sand castle.

**SESSION 6: DESCRIBING A KNOWN PLACE**

*Relevant Knowledge*

Descriptive writing is an art form. It is like painting a word picture so that the person who reads what you have written or listens to what you have said, “sees” exactly what you meant to describe. To practice descriptive writing, think of a few sentences about the city you grew up in. You could start off as:

1. The city that I grew up in is ________________ (name of the state).
2. It is a large/small city in__________________(name of the state).
3. The weather there is quite ________________.

*Adjectives and adverbs*

1. I am ready to take the test. - adjective
2. I am readily taking the test. - adverb
3. She ran out of the room in a hasty manner. - adjective
4. She ran out of the room hastily. - adverb
5. I was happy when I received the certificate. - adjective
6. I happily received the certificate. - adverb

Here are some adjectives to describe a city:

- **City**: active, bustling, noisy, busy, clean, dirty, windy.
- **Traffic**: loud, congested, snarled.
- **Buildings**: old, shabby, rundown, crumbling, modern, futuristic, sleek, towering, squat.
**EXERCISE**

I. Read aloud the following phrases on “Describing Nainital”. Combine the phrases so as to form a paragraph that describes Nainital. For example:

**Example:** *Nainital is a beautiful hill-station in Uttarakhand.*

1. Nainital is a beautiful hill-station...
2. It is surrounded by...
3. ...in Uttarakhand.
4. ...above sea-level.
5. ...high mountain peaks
6. Nainital is a very...
7. ...especially during winter...
8. ...popular tourist spot,
9. ...when the snow falls.
10. It attracts a lot of tourists in...
11. ...during the British Raj.
12. The temperature varies between...
13. ...which were established...
14. 15°C and -3 °C at that time.
15. ...and is situated at an altitude of 1,938 meters.
16. Apart from its beautiful scenery...
17. ...its many schools,
18. Nainital is also known for...
II. Now read aloud and very carefully, the description given below: “Ladakh”.

1. Leh, Drass valley and Leh-Manali track are popular tourist spots.
2. Ladakh is a region situated in Jammu and Kashmir.
3. Tourists come for fishing and trekking.
4. Ladakh has a population of about 2,60,000.
5. The Kunlun mountain range lies to the north and the Himalayas lies to the south.
6. The language is written in the Tibetan script.
7. The people of Dha-Hanu follow Tibetan Buddhism.
8. Ladakhi culture and Tibetan culture share many similarities.
9. Popular sports include archery, ice hockey, and cricket.
10. Buses and taxis are available as means of transport.
11. The dances are about the fight between good and evil.
12. The people speak Ladakhi which is also known as Western Archaic Tibetan.
13. About 18,000 tourists visit Ladakh every year.
14. On the other hand, those living around Dras have converted to Islam.
15. It is the highest plateau of Kashmir.
16. The Ladakhis celebrate masked dance festivals.

III. Read carefully the following passages on “adjectives and adverbs” and identify whether the words in bold are adjectives or adverbs:

1. I went to Jaipur, also known as Pink City. Many people readily agree it is one of the best structured places in India. The town was carefully planned according to Vastu Shastra. It was built in the form of an eight-part Mandala known as Pithapada.

2. I have never seen as heavenly a place as Kerala’s backwaters. I took a ride in a kettuvallam (house boat) and what I saw was truly beautiful. Palm trees, pandanus shrubs, a variety of leafy plants and bushes attractively decorated the place.

3. My family went on a trip to Manipur. One of the many places we visited was the Keibul Lamjao National Park. It is the only floating national park in the world. The place is marked by floating plants called Phumdi. The park is the home of the Sangai or Brow Antlered Deer, an endangered species which cannot be found anywhere else on earth.
Fill in the blanks with the appropriate word from the given options:

1. I __________________ moved to a new city.
   (a) recently (b) daily

2. I now live __________________ in the heart of Delhi.
   (a) comfortable (b) comfortably

3. My house is a __________________ two-bedroom flat in Mayur Lok.
   (a) spaceful (b) spacious

4. I live here with my __________________ friend, Manish.
   (a) best (b) better

5. There is a __________________ monument near our house.
   (a) history (b) historical

6. When I first moved to Delhi, I found the city to be too __________________ and crowded.
   (a) noisy (b) noiseful

7. Now that I have lived here for a couple of years, I can’t imagine moving back to my
   __________________ town.
   (a) small (b) tiny

8. Delhi is the capital of India and is __________________ connected to all major cities of the
   country by road, rail, and air.
   (a) good (b) well

9. Mayur Lok is one of the __________________ localities in Delhi.
   (a) best (b) good

10. The area is well-maintained and planned __________________
    (a) prettily (b) beautifully
SESSION 7: GIVING DIRECTIONS

Relevant Knowledge

Look at the following map. How would you give the direction to City Mall?

Read the “Terms and phrases for giving directions” given below.

1. **Intersection** - Also known as “junction” and “crossroad”, it is a place where two or more roads meet.
   
   **Example:** We kept driving till we came to an intersection. We did not know which road to follow, so we asked the traffic police for directions.

2. **Fork** - The point at which a road divides into branches.
   
   **Example:** Keep walking left till you come to a fork; take the road on your right and keep walking. The shop is there at the end of the road.

3. **U-turn** - A U-shaped turn made by a vehicle so as to take a direction opposite to the original course.
   
   **Example:** The market is on the other side of the road. You will have to take a U-turn to reach it.

4. **Turn left/right** - Go to your left/right.
   
   **Example:** The man told me to walk down the street and at the end, turn left.

5. **Signpost** - A post bearing a sign that gives information.
   
   **Example:** The signpost says that we have to take the road on the left for Noida.

6. **Landmark** - An easily seen building or place that serves as a guide.
   
   **Example:** The City Mall serves as a landmark for their office.
7. **Across the street** - On the other side of the street.
   **Example:** The book store is just across the street.

8. **Next to** - Beside.
   **Example:** Mohan Lal Grocery is next to the mobile shop.

9. **Go straight down** - Keep walking along the road.
   **Example:** Go straight down this road and turn right. You will find the hospital there.

10. **Take the first/second road on the left/right.**
    **Example:** To reach the school, go straight and then take the second road on the right.

11. **Around the corner** - Near the corner.
    **Example:** The market is just around the corner of the DESU residential complex.

12. **At the end of** - Last Part.
    **Example:** You will find the store at the end of this road.

---

**EXERCISE**

Study the flowchart given below:
In short, there can be more than one route in which you can give directions to reach DMK Hospital.

Prepositions

A preposition is a word that links a noun and pronoun to other words in a sentence. For example:

1. We went to the market.
2. The market is just around the corner.
3. Many kinds of stores can be found at the market.

Prepositions are used as follows:

- **Prepositions of time:** at, on, in, during, since, until, by, etc. We reached the hostel at 9 pm. We reached the hostel on Monday. We will reach the airport in an hour. **Note:** Use at for specific times, on for days and dates, and in for non-specific times.

- **Prepositions of place:** at, on, in, over, above, under, beside, behind, etc. We went to the library. The library is on Hudson Lane. **Note:** Use at for specific places, on for roads, streets, etc., and in for cities, countries, etc.

- **Prepositions of direction:** to, from, across, through, around, into, towards, etc. The electronics shop is across the street. The cricketers went in that direction.

- **Prepositions indicating other relationships:** by, with, of, for, etc. This sari is made of silk. A surprise is waiting for you.

**ASSESSMENT**

I. Fill in the blank with the correct preposition given in the bracket:

1. Go straight down Kingsway Street and you will find the shop ___________ your right (in, on).

2. The jeweler’s store is right next ___________ the bus-stop (for, to).

3. The florist’s stall is ___________ Kamna’s house (below, under).

4. You can find her house ___________ the corner of the main street. (around, from)
5. Walk ______________ you reach the traffic point (till, before).

6. The book store is just ______________ the street (across, under).

7. Walk straight ______________ this road and you will come to a traffic point (down, beside).

II. Fill in the blank with the correct preposition given in the bracket:

1. I'm very excited about meeting my friend today ______________ Dilli Haat in the evening at 4.
   (a) on            (b) at

2. My friend stays in INA colony near Dilli Haat, whereas my house is quite far _________ it.
   (a) across      (b) from

3. In the morning, my friend had given me the directions _____________ this place over the phone.
   (a) to              (b) about

4. I will take Bus no. 540 ______________ the Central Terminal and get off the INA bus stand.
   (a) from, in     (b) from, at

5. My friend had said that Dilli Haat is right ______________ the road.
   (a) across      (b) over

6. She will be waiting for me ______________ the Sikkim food stall.
   (a) on             (b) at

7. The Sikkim food stall is located ______________ the Manipur and Rajasthan food stalls.
   (a) across      (b) between

8. The hot momos served there are so tasty - I can't wait _____________ eat them!
   (a) for             (b) to

9. Oh! I think that’s my bus ______________ that red truck.
   (a) behind      (b) over

10. I must hurry up and get ______________ it or my plans for a great evening will be spoilt.
    (a) onto          (b) in
SESSION 8: DESCRIBING AN EVENT

Relevant Knowledge

Have you attended any event recently? It may be a wedding, a birthday party, or any function - any event. Try and form sentences about the event. Maybe answering the following questions might help you:
1. When was the event held?
2. Where was it held?
3. How many people came?
4. How was the food (if it was a party)?
5. Were there any special programs? If so, what were they?

Present Continuous Tense

The Present Continuous Tense is used to describe an action that is continuing at the moment.
1. I am walking.
2. She is preparing lunch for everyone.

The verb will always take the form “is/am/are+verb+ing” depending upon the subject.
1. He/she/it/Meena/Rajan is walking.
2. They/we/you/the people are walking.
3. I am walking.

Read the following:
1. I describe an event. I am describing an event.
2. She/he/Reena/Karan/etc. describes an event. She/he/Reena/Karan/etc. is describing an event.
3. You/we/they/the students/etc. describe an event. You/we/they/the students/etc. are describing an event.

The sentences with “is/am/are describing” as verb describe an action that is continuing at the moment. Therefore,
1. We are learning the Present Continuous Tense.
2. We are learning how to describe an event.
3. We are learning English.
I. Read the following sentences and identify whether they are in the present continuous tense or not.

1. Everyone is **enjoying** Sarita’s party.
2. Sarita is **distributing** cold drinks to her guests.
3. Devjit **wants** to play his guitar and sing a song for her.
4. All the guests **encouraging** him to do that.
5. Even Sarita herself is **telling** him to perform.

II. Read the sentences on “Smita’s Birthday” given below.

1. It was Smita’s birthday ____________.
2. We arranged a surprise birthday ____________.
3. All her friends ____________.
4. ____________ as it is her favourite.
5. Everyone arrived ____________.
6. ____________ at 12 p.m.
7. We screamed “__________“!
8. Then, she blew the candles and ____________.
9. Asha and Sumeet ____________.
10. ____________ sang a song and entertained everyone.
11. We played Antakshari ____________.

III. Using the following phrases fill in the blanks and complete the sentences.

1. “Surprise”
2. ...were invited.
3. Smita entered the room...
4. ...cut it for everyone
5. Smita even...
6. ...party for her.
7. ...on time.
8. ...distributed food and drinks
9. We got a chocolate cake...
10. ...on Sunday.
11. ...and dumb charade.

ASSESSMENT

Choose and tick the correct option, which is in the Present Continuous Tense.

1. a. We are gone to attend a friend’s wedding at Sainik Farms on Saturday evening.
   b. We are going to attend a friend’s wedding at Sainik Farms on Saturday evening.
   c. We went to attend a friend’s wedding at Sainik Farms Saturday evening.

2. a. Everybody will having a great time at the party.
   b. Everybody is having a great time at the party.
   c. Everybody have a great time at the party.

3. a. The bride is looking gorgeous in a traditional red silk saree.
   b. The bride looking gorgeous in a traditional red silk saree.
   c. The bride will looking gorgeous in a traditional red silk saree.

4. a. The waiters serving delicious snacks and drinks.
   b. The waiters serves delicious snacks and drinks.
   c. The waiters are serving delicious snacks and drinks.

5. a. The DJ is playing soft music while the guests have their dinner.
   b. The DJ is playing soft music while the guests are having their dinner.
   c. The DJ plays soft music while the guests are having their dinner.

6. a. He is going to play some popular Bollywood numbers.
   b. He has some popular Bollywood numbers to play.
   c. He going to play some popular Bollywood numbers.

7. a. Some kids have running around while some will be dancing on the dance floor.
   b. Some kids are running around while some are dancing on the dance floor.
   c. Some kids are running around while some dancing on the dance floor.
8. a. We are planning to drink coffee to stay awake through the night.
   b. We are planning to drink coffee to be staying awake through the night.
   c. We drink coffee to be staying awake through the night.

9. a. Pandit Ji reciting mantras and performing various rituals.
   b. Pandit Ji is going to reciting mantras and performing various rituals.
   c. Pandit Ji is reciting mantras and performing various rituals.

10. a. Everybody is showering flowers on the newlyweds.
    b. Everybody are showering flowers on the newlyweds.
    c. Everybody showering flowers on the newlyweds.

SESSION 9: RECOUNTING AN EXPERIENCE

Relevant Knowledge

The purpose of a recount is to list and describe past events by retelling the events in the sequence in which they occurred. A recount tells about something that happened in the past. Hence it is written in the past tense. (e.g. I run - I ran, I go - I went). The details in the recount can include what happened, who was involved, where it took place, when it happened and why it occurred.

A writer or speaker uses a recount to tell us about a story or an event. Recounts are usually given in the order that the event occurred. Recounts can be:

• Factual, such as a news story
• Procedural, such as telling someone how you build or make something
• Personal, such as a family holiday or your opinion on a subject

Examples of a recount include:

• Biographies and autobiographies
• Newspapers or the television news
• Letters and postcards
• Textbooks
• Conversations with friends
A well-structured recount includes details of the event or topic and personal opinions. Oral (spoken) recounts may have a title if you are giving a presentation. However if you are simply talking with friends you wouldn’t announce the title of your conversation!

**Past continuous tense**

The Past Continuous Tense describes an action that was happening at a time in the past. A verb in this tense will always take the form: **Was/were + verb (+ing)**

- I/she/he/it/Meena/Rajan/the man was walking.
- They/we/you/the people were walking.
- She was working on her painting.
- He was rehearsing for his performance.

Some examples of Past Continuous Tense are given below:

- I am walking - Present Continuous Tense
- I was walking - Past Continuous Tense
- She/he/it/Tina is walking - Present Continuous Tense
- She/he/it/Tina was walking - Past Continuous Tense
- We/they/the people are working - Present Continuous Tense
- We/they/the people were working - Past Continuous Tense

Can you tell the difference between the two tenses?

The Present Continuous Tense describes an action that is happening presently while the Past Continuous Tense describes an action that was happening at a time in the past.

A verb in the Past Continuous Tense will take the form:

**Was/were + verb (+ing)**

Now, from the following sentences, identify the sentences in the Past Continuous Tense.

1. I was going to tell you a story.
2. They told me they playing a game.
3. She is making breakfast.
4. We were planning to visit the zoo.
5. The zoo was closed.
6. Celebrations were happening all over the world.
EXERCISE

Read the points given below, very carefully. Now, construct them into a paragraph:

• Taking a walk in the park.
• Saw some people playing badminton.
• Sat down and watched.
• Realized one of the players was an old classmate.
• Called out to her.
• She came to me.
• Told me she was my classmate’s twin.
• I apologized.
• She asked me to join their game.
• I agreed.
• Enjoyed a nice round of badminton with them.

Read the phrases in “Trip to A Mall”. Fill in the blanks with appropriate phrases.

• ...we decided to go.
• I told him...
• ...for our lunch!
• Then we went looking...
• ...if I had any plans this Saturday.
• ...the food court had not been built...
• ...in the mall.
• ...where it was located...
• ...for a while.
• ...to search the huge mall.
• We were already hungry...

My friend called me up and asked me ____________ . ____________ I was free. So __________
to the new mall. There were many good stores ________________. We ________________
window-shopped. ____________ for the food-court. But we couldn’t find it. ____________ and
we were forced ________________ ! At last, we asked ____________ a guard ____________
and he told us that ____________ as yet. We ____________ came out of the mall and had to go to a dhaba ____________.

**ASSESSMENT**

Fill in the blanks with the past continuous form of the verbs given in brackets. The first two have been done for you.

1. I was visiting my childhood friend Venkat yesterday.
2. We were going to watch the movie Don on DVD.
3. We ____________ (see) the movie for the second time.
4. We ____________ (enjoy) the popcorns more than the movie.
5. In the evening, we ____________ (plan) to make a chocolate cake.
6. Both of us ____________ (go) to the market to buy vegetables for dinner.
7. We ____________ (driving) to the supermarket.
8. The supermarket ____________ (offer) sale on all stocks.
9. Everybody ____________ (move) towards the entrance at the same time.

**SESSION 10: FINDING A PLACE TO STAY**

**Relevant Knowledge**

Imagine that you have just moved into a new city and are looking for a place to stay. How they would go about doing it? You can use the following pointers:

- What kind of place do you want?
- What would you require in a room?
- Would you take the help of a broker?
- Would you negotiate the rent?

**Make appropriate sentences**

Given below is a list of terms you will encounter when you want to rent a residence. Read aloud the “Renting Terms”, understand its meaning and usage:

1. **Broker:** One that acts as an agent for others in negotiation, bargain, etc.
   
   *E.g.* *The broker helped me find a room at a reasonable price.*
2. **Rent**: Payment made by a person for staying in a place owned by others.
   
   *E.g.* *I and my three friends are living on rent now.*

3. **PG (Paying guest)**: Someone who lives on rent in the owner’s house.
   
   *E.g.* *PG accommodations are easily available these days.*

4. **Apartment**: A flat
   
   *E.g.* *Sheila and Renu have rented a two-room apartment in Pune.*

5. **Landlord/landlady**: A man/woman who provides rooms for rent.
   
   *E.g.* *Our landlady allows us to stay out till 10 p.m. only.*

6. **Tenant**: A person who lives on rent.
   
   *E.g.* *Mr. Gupta’s tenants always pay their rent on time.*

7. **Single-room flat**: A flat with only one room.
   
   *E.g.* *As I am planning to stay alone, I will look for a single-room flat.*

8. **Double-room flat**: Flat with two rooms.
   
   *E.g.* *As we are planning to stay together, we will look for a double-room flat.*

9. **Commission**: A fee that you have to pay to an agent/broker for their services.
   
   *E.g.* *We also have to pay the broker his commission.*

10. **Security**: Money given as guarantee that you will pay rent as due. Also known as “deposit”.
    
    *E.g.* *We have to pay 2500 Rupees as security.*

11. **Notice**: A formal announcement that you have to make if you want to move out/ask a tenant to leave.
    
    *E.g.* *The landlord has a simple rule - every tenant must give a month’s notice if they want their security back.*

Read the dialogue section below on “**Finding a Place to Stay**”. This is a conversation/dialogue between a broker and his client. The client is looking for a room.

You have to fill in the blanks by forming complete questions using the points given in brackets. Two of them have been done to help them understand.

**EXERCISE**

**Client** : I am looking for a place to stay.

**Broker** : Ok. Do you want a single room or double room? (Single room or double room)

**Client** : Since I am going to stay alone, I would prefer a single room.

**Broker** : ___________________________? (just a single room, or with kitchen)
**Client**: I want a single room with attached bathroom plus a separate kitchen. **Broker**: You have come right on time. A room which has all these has just been vacated.

**Client**: ___________________________? (how much the rent is)

**Broker**: 4500 Rupees.

**Client**: ___________________________? (whether includes electricity bill and water bill)

**Broker**: Yes, yes. It includes both.

**Client**: Do I have to pay security? (whether I have to pay security) **Broker**: Yes. You have to pay a security of 2000 Rupees.

**Client**: ___________________________? (how much your fee is)

**Broker**: I charge only 25% of the rent.

**Client**: ___________________________? (whether fee is negotiable)

**Broker**: I am afraid it isn’t. It is quite low. Most brokers charge around 50%. **Client**: Ok then.

**Broker**: ___________________________? (whether you want to see the room now)

**Client**: Yes.

**Future continuous tense.**

The Future Tense describes an action that will be ongoing in the future. A verb in the future continuous tense will always take the form:

“**will**+be+verb+ing”. For example:

- I **will be reporting** on the news channel tonight.
- He **will be coming** home at around 10.
- They **will be working** hard to win the match.
- You **will be doing** your homework.

We can understand the Future Continuous Tense with the help of the following examples:

- We are **looking** for a new room. (Present Continuous Tense). We **will be looking** for a new room. (Future Continuous Tense)
- I am **looking** for a new room. (Present Continuous Tense). I **will be looking** for a new room. (Future Continuous Tense)
- She is **looking** for a new room. (Present Continuous Tense). She **will be looking** for a new room. (Future Continuous Tense)
While in the Present Continuous Tense, we describe an action that is ongoing, in the Future Continuous Tense, we describe an action that will be ongoing in the future. The verb will always take the form: will / will not + be + verb (ing)

Now, read the following sentences and identify the sentences that are in the Future Continuous Tense:

1. The rent will be 4,000 Rupees.
2. I will be hiring a broker to search for the room.
3. She will not be taking the flat.
4. The landlord will not returning the security.
5. They will be staying in a double room flat.

ASSESSMENT

Change the following sentences to the Future Continuous Tense.

1. Shantanu helped me locate a good room.
   _______________________________________________________________________.

2. The landlord charged me too much.
   _______________________________________________________________________.

3. I was negotiating with him to lower the rent.
   _______________________________________________________________________.

4. I also asked the landlord if he would provide me a cooler.
   _______________________________________________________________________.

5. If not, I am buying the cooler myself.
   _______________________________________________________________________.

6. I am staying here till December.
   _______________________________________________________________________.

7. Next year, I am moving to Mumbai.
   _______________________________________________________________________.

8. I contacted my broker Vijay.
   _______________________________________________________________________.

9. Vijay is searching for a two-room flat for me.
   _______________________________________________________________________.

10. I reminded him that the flat should have a separate kitchen.
    _______________________________________________________________________.
SESSION 11: SAYING NO

Relevant Knowledge

Sometimes, in our lives, situations arise where you have to politely decline a person’s offer. This can be difficult; especially when you care about the other person.

Some people might say “Yes” when they actually mean “No”. As a result, they feel bitterness and anger towards the person they have said “Yes” to, even though the person has done nothing wrong. People who cannot say “No” often become annoyed and upset with themselves and if anyone continues this behavior for a long time, it affects their self-esteem and adds to stress. On the other hand, some people might say “No” but, in an impolite, disrespectful and aggressive manner. This may result in others disliking them for being angry and rude. So what’s the way out?

How would you say “No” to the following?

1. A friend invites you to a party but you have to refuse.
2. A friend wants to borrow a book but you have to refuse.
3. A friend wants to go shopping with you but you have to refuse.

Think about it!

Read aloud the following phrases (polite ways of refusing):

1. I am sorry but - I am sorry but I won’t be able to come.
2. Thanks for the offer but - Thanks for the offer but I won’t be able to come.
3. I will have to say no - I really want to come but I will have to say no.
4. This is very kind of you. However... - This is very kind of you. However, I won’t be able to come.
5. I would love to...but can’t because of prior engagement - I would love to come but can’t because of prior engagement.

Read aloud the following phrases

- You can’t work against the law.
- I can’t abide by the law if it is not fair.
- I am working at the warehouse.
- You are working for the manager.
EXERCISE

Study the following situations in “Saying No”. Choose what would be the appropriate way of saying no in each situation. Some situations may have more than one appropriate option. Fill in the blanks with the appropriate option(s).

**Situation 1**
Speaker 1: Can I borrow some money?
Speaker 2: ______________________________________________________.
(a) No, you cannot.
(b) I am sorry but I won’t be able to lend you.
(c) I am sorry but you can’t borrow right now.

**Situation 2**
Speaker 1: I am going to my aunt’s house. Would you like to come?
Speaker 2: _____________________________________________________.
(a) I won’t be able to come, but thanks for the offer.
(b) I am sorry but I won’t be able to come.
(c) I am sorry but I won’t like to come at all.

**Situation 3**
Speaker 1: There is a party at my place on Friday. You have to come.
Speaker 2: ___________________________________________________.
(a) Thanks. But I can’t come as I have a prior engagement.
(b) Sounds great! But, no! I am not coming.
(c) I am sorry. I will not be able to make it. But thanks for the invitation.

**Situation 4**
Speaker 1: It is quite late now. Why don’t you stay at our place tonight?
Speaker 2: ___________________________________________________.
(a) This is very kind of you. However, I can’t stay.
(b) Thanks! But I really have to get back home.
(c) Thanks a lot. But I can’t stay at your place tonight.
**Situation 5**

Speaker 1: Would you like to join us for a drink?

Speaker 2: ____________________________________________.

(a) Thanks! But I will have to say no.
(b) Sounds fun! But, no! I can't join you.
(c) A drink? No. Not now.

---

**ASSESSMENT**

I. Fill in the blanks using the correct preposition given in the bracket:

1. They invited me ___________ their party, but I had refuse (to, for)

2. They said they will meet ___________ 3 sharp. (in, at)

3. But I have to meet my grandparents ___________ Monday. (at, on)

4. So, I said no. ___________ now, I have never refused them. (till, before)

5. They were a little disappointed ___________ me. (on, with)

6. But I haven't met my grandparents ___________ a long time. (for, from)

7. I haven't seen them ___________ last July. (since, from)

II. Fill in the blanks using the correct preposition given in the bracket:

with against for from by on at

1. Vikrant keeps borrowing money ___________ me. The next time he asks me, I will say, “I am sorry, Vikrant. I can't lend you anymore.”

2. My friends wanted to share a drink ___________ me. But I refused saying “Thanks ___________ the offer. But I will have to say no.”

3. My boss makes me get tea ___________ him every day. So, yesterday, I finally said “I am sorry, Sir. I have got work to finish.” At that moment, I really did not care if it would have any effect ___________ my job.

4. My grandfather wants me to get up at 4 every morning and jog for an hour. I had to politely refuse ___________ saying, “Great idea! I will try that some day. Thank you.”

5. Leena asked Rajul to do her homework again. It seems Rajul replied, “I am not going to do whatever you ask me to.” And now, they are not talking ___________ each other.

6. The opposition candidate wanted the people to vote ___________ the ruling party, but they shouted ___________ him and told him to go back.

7. Though it was raining hard yesterday, my tutor wanted me to buy a book ___________ the market. I said, “I am sorry, Sir. But the weather is really bad. Can I buy the book tomorrow?”
SESSION 12: DESCRIBING A LOST ITEM

Relevant Knowledge

Describing a lost item is a simple matter of stating the features of the item that may help in identifying it. For example to describe a book you have lost, you could describe its following attributes:

- Name of book
- Author’s name
- Size of book
- Description of cover
- Publishers’ name

There are some words that are used to express the quantity of things that can be counted and some words that are used to express the quantity of things that cannot be counted. Study the following table:

<table>
<thead>
<tr>
<th>For Countable Nouns</th>
<th>For Uncountable Nouns</th>
<th>For Both</th>
</tr>
</thead>
<tbody>
<tr>
<td>Many</td>
<td>Much</td>
<td>Some</td>
</tr>
<tr>
<td>A few, few</td>
<td>A little, little</td>
<td>Any</td>
</tr>
<tr>
<td>Several</td>
<td>A bit of</td>
<td>All of the/most of the</td>
</tr>
<tr>
<td>A couple of</td>
<td>A good/great deal of</td>
<td>A lot of/lots of</td>
</tr>
<tr>
<td>None of the</td>
<td></td>
<td>Plenty of</td>
</tr>
</tbody>
</table>

Some more examples are:

- Their family has a lot of influence over the local government.
- I bought a lot of children’s books for my son.
- Some people don’t agree with the new bill.
- There was much disagreement over the new bill.

EXERCISE

Now, read the details given below and fill in the blanks using the information given:

- A mobile phone
- Nokia 0010
• Black color
• Lost while traveling in a train
• 15th May, 2009, 2:00 p.m. to 9:30 p.m.
• Train from Allahabad to Delhi
• Shiv Ganga Express
• Compartment no. S 14, Berth 28, Sleeper Class

Policeman : Yes, may I help you?
Complainant : I lost ___________________.
Policeman : Where?
Complainant : I was traveling from____________________ to ___________________.
Policeman : Which train was it?
Complainant : ___________________.
Policeman : When was the journey taken?
Complainant : ___________________.
Policeman : What time approximately?
Complainant : ___________________.
Policeman : Where was your seat?
Complainant : ___________________.
Policeman : Please describe the phone.
Complainant : It is a_____________________. The colour is_____________________.
Policeman : Okay.

ASSESSMENT

I. Choose the correct quantifier from the given choices and fill in the blank:

1. I lost __________ books when I stayed at the hostel (several, much)

2. Hema asked __________ students if they had seen her new leather wallet (some, a little)

3. The warden confirmed that __________ thefts had occurred in the hostel, so she had every room checked (a few, any)

4. __________ students, including Hema, put up posters describing the items that they had lost (A lot of, much)
5. Finally, ____________ of the lost items were found in Hema’s room - she had nerve to pretend that her wallet too had been stolen! (much, many)

II. Fill in the blanks with the correct quantifier from the options given below:

1. I was having ____________ fun with my family at the airport until I realized that two of my bags were missing.
   (a) a lots of  (b) many    (c) a lot of

2. The black bag contained ____________ valuable things that I had bought for my sister’s wedding.
   (a) many  (b) more  (c) much

3. It contained a diamond pendant, ____________ gold bangles, a diamond ring, etc.
   (a) a few  (b) enough  (c) a little

4. It also had silver jewellery.
   (a) many  (b) a few  (c) some

5. The brown bag had ____________ important documents such as my passport, pan card, driving license, etc.
   (a) many  (b) more  (c) much

6. The bag also contained clothes, ____________ silver coins, and a silver key.
   (a) enough  (b) a few  (c) a lot

7. Though the black bag contained ____________ expensive items, its loss does not bother me as much as the loss of the brown bag does.
   (a) little  (b) a little  (c) plenty of

8. It is more important to find the brown bag because it contains ____________ important documents.
   (a) much  (b) very  (c) some

9. I do not have ____________ hope of getting back my bag. Still, I am going to lodge an FIR at the police station.
   (a) little  (b) much  (c) few

10. I will also post an advertisement about my bag in the ‘Lost and Found’ section of ____________ newspapers.
    (a) more  (b) little  (c) some
SESSION 13: APPRECIATING SOMEONE

Relevant Knowledge

How would you feel if someone you knew very well and you had helped comes up and says to you “Someday I hope to give to you a fraction of all you’ve given me”? For employers and employees, businessmen and clients, family members close friends and associates, expressing appreciation for everything a person means to you is absolutely necessary. It lifts your heart and makes the day to day stresses that you face more manageable. Take the time today to tell someone “I appreciate you.” To do so, you need to know how to appreciate and that’s what you will learn today.

Look at the following situation: A friend of yours has done a favor for you Now, how would you express your appreciation for your friend? Think about it.

We generally show our appreciation when:
1. Someone has done something for which they are grateful or thankful
2. Someone has done something praise-worthy.

Therefore, appreciation may be shown not only when someone has done you a favor but also when a person has done something good or admirable.

Read the details given below:

“Appreciating Someone 1”

1. When someone has done you a favor:
   • Thanks a lot!
   • Thanks! You are a life-saver.
   • Thanks! I really appreciate it.
   • Thanks! You really made my day.

2. When someone (e.g. a junior at work) has done his job well:
   • Great job!
   • Well done!
   • Nice work!
   • Good work! Keep it up.
   • You did very well!
   • Keep up the good work.
   • I appreciate your effort.
3. **When someone (e.g. a singer/dancer) has performed well:**
   - That was a great/an excellent/an outstanding performance!
   - You performed very well!
   - I enjoyed your performance.

4. **When someone shows concern and support:**
   - I appreciate your concern.
   - Thank you for your concern.
   - Thanks for the support. I really need it.
   - Thanks for standing by me.

5. **Appreciating someone close to you (parents, friends, etc.):**
   - You are a wonderful/an amazing person!
   - Thank you for being who you are.

**EXERCISE**

Study the situations described here. Fill the blanks with how you would express your appreciation in the given situations. You can use the phrases and sentences you learnt earlier.

**Situation 1:** You want to buy a book but do not have enough money. Your friend lends it to you.

**Situation 2:** Your junior at work used to perform badly. Lately, his performance has improved.

**Situation 3:** It is Mother’s Day and you have bought a card for your mother. You want to write a line showing your appreciation.

**Situation 4:** Your younger brother has come top of his class.

**Situation 5:** You are organizing a campaign for the adoption of stray dogs. A man donates an amount (huge/small) for the cause.

**ASSESSMENT**

1. **Fill in the blanks using the correct option given in the bracket:**
   1. You did me a ________________ favor (great, large)
   2. I am so ________________ that you won! (happy, cheerful).
   3. You are looking ________________ tonight (wonderful, brilliant)
   4. You did a ________________ thing by helping that poor boy. (well, good)
5. We thank you for being so ________________ (kind, gentle)
6. That was a ________________ performance! (fantasy, fantastic)
7. Your generosity is appreciated by ________________ (many, much)
8. You are doing your job ________________ well (very, vary).

II. Choose the right word from the bracket to fill in the blanks:
1. Rama presented the show really well. I think she is very_______________ (arrogant, confident).
2. Sheela is very ________________ (patient, lenient) while talking to clients. She tries to understand them.
3. I wonder how Nilanjana can be so ________________ (relaxed, lazy) before any team meeting.
4. Priya is extremely ________________ (dignified, grand), and that makes her the team favorite.
5. I like the fact that Ram is ________________ (inquiring, nosy), that way he gets his doubts cleared.
6. Raj spends his money ________________ (with a lot of care, like a miser), so he has no major debts.
7. It was because of Ram’s ________________ (hard work, overwork) that we got a new deal.
8. Raj uses ________________ (old-fashioned, outdated) ways to solve problems because he feels that it always works.
9. Ravi is always ________________ (up-to-date, modern) with his work.

SESSION 14: ATTENDING A PHONE CALL

Relevant Knowledge
How do you answer the phone when it rings? This session is about taking phone calls, and that you will begin the lesson with a role play on the situation. Now read aloud the following conversations:

Role Play 1

Student 1 : Hello?
Student 2 : Hello!
Student 1 : Is this (name) speaking?

Student 2 : This is (name) speaking.

Student 1 : I am (student’s name). Is this a good time to talk?

Student 2 : Ok. What is it about?

Student 1 : I am from Public Surveys. We would like to inquire if you are a regular user of the internet.

Student 2 : Yes, I am.

Student 1 : That’s all. Thank you for your co-operation. Have a nice day.

Role Play 2

Student 1 : Hello?

Student 2 : Hello!

Student 1 : Is this (your name) speaking?

Student 2 : This is (your name) speaking.

Student 1 : I am (student’s name). Is this a good time to talk?

Student 2 : No. I am afraid I am a little busy at the moment.

Student 1 : Can I call you later?

Student 2 : Ok.

Student 1 : Thank you for your time. Have a nice day!

Read the details below:

Making a phone call

* Asking for the person you want to talk to:
  * May I speak to (name of the person)?
  * Is (name of the person) there?
  * Am I speaking to (name of the person)?
Identifying yourself:
• I am (your name).
• My name is (your name).
• I am (your name) from (company or organization on whose behalf you are calling).
• My name is (your name). I am calling from (company or organization on whose behalf you are calling).

Asking if the call-recipient is free to talk:
• Is this a good time to talk?
• Are you free to talk?

When the person you want to talk to is not in:
• I would like to leave a message.
• Could you take a message for him/her?
• I will call later/ I will call after some time.

While hanging up:
• Thank you for your time. Have a nice day!
• Thank you. Have a nice day!

Receiving a phone call
When the caller asks for you:
• This is (your name) speaking.
• You are speaking to (your name).

When the caller asks for someone who is not in/cannot come to the phone:
• I am afraid he/she is not in at the moment Or He/she cannot come to the phone right now.
• Would you like to leave message? Or Can I take a message?
• Could you call after some time? Or Could you call later?

When the caller asks you if you are free to talk:
• Sure! What is this about?
• I am sorry. I am a little busy at the moment.

While hanging up:
• Thanks for calling.
Study the details below and fill in the blanks:

1. “Attending to Phone Calls 1”

Receiver : Hello?
Caller : Hello. ___________ (receiver’s name)?
Receiver : This is (receiver’s name) speaking.
Caller : (receiver’s name), ___________ (caller’s name) ____________ Life Care Insurance.
Receiver : Ok.
Caller : ____________________________ ?
Receiver : Sure, we can talk.
Caller : Are you availing any life insurance policy?
Receiver : __________.
Caller : Ok. Would you like to buy another policy?
Receiver : No, thanks.
Caller : Ok, Sir/Ma’am. ________________.

2. “Attending to Phone Calls 2”

Receiver : Hello?
Caller : Hello. _____ (name)?
Receiver : I am sorry. He/she is not in right now.
Caller : Oh!
Receiver : _____ ?
Caller : Yes. _____ him/her that Rajeev Kumar called?
Receiver : Ok.
Caller : _____.
Receiver : No problem. Anything else?
Caller : No, that’s all.

Read the following examples:

- I eat ice-cream daily - Simple Present Tense
- I am eating ice-cream - Present Continuous Tense
- I have eaten ice-cream - Present Perfect Tense
In the first example, the person is saying that he eats ice-cream generally. In the second, he is eating ice-cream right now. In the third, he ate ice-cream in the recent past.

The Present Perfect Tense is thus used to describe an action which occurred recently.

It also used to describe an action which started in the past and is still continuing. For example:

- I have worked here for 5 years.
- She has lived there for 2 years.

Verbs in the Present Perfect Tense will take the following form:

- I/you + have + perfect form of the verb
- It/she/he/Reena/Akash + has + perfect form of the verb
- We/they/the people/the sisters + have + perfect form of the verb.

Read this before you attempt the exercise:

Present Perfect Tense is used to describe an action which occurred recently.

- I have read the essay.
- She has taken breakfast.

It also used to describe an action which started in the past and is still continuing. For example:

- I have worked here for 5 years.
- She has lived there for 2 years.
- Verbs in the Present Perfect Tense will take the following form:
  - I/you + have + perfect form of the verb
  - It/she/he/Reena/Akash + has + perfect form of the verb
  - We/they/the people/the sisters + have + perfect form of the verb.

**EXERCISE**

Identify the sentences in the Present Perfect Tense.

1. She has done her job well.
2. I have a file here.
3. They have been upset.
4. You **have won** the competition.
5. The man **has** a lot to say.

**ASSESSMENT**

I. Change the verbs in brackets to Present Perfect Tense and fill in the blanks:

Two examples are given below.

- I **have driven** a car.
- She **has driven** a car.

A: Hello! My name is Akanksha from ABC Consultants. May I speak to Ms Kavya, please?
B: Kavya ____________ (leave) the office. May I take a message?
A: Well, our company ______________ (plan) a camp at Siri Fort this Saturday. Would she be interested in attending it?
B: Sure! In fact, I would also be interested. We ______________ (attend) such camps before. We found them useful.
A: That’s good. Can you give me your name and contact number as well?
B: My name is Manisha and my contact number is 9987654321. Some of my other friends ______________ (volunteer) at such camps before. Would you like me to ask them to come along?
A: That’s great! You can ask them to call me on the same number if they need more information in this regard.
B: Ok. I will tell Kavya you called. Bye!
A: Bye

**SESSION 15: GIVING INSTRUCTIONS**

**Relevant Knowledge**

Sentences that express an instruction are formed as an order or a direct command. It is always in the Simple Present Tense.

**For example:**

1. Tell us your name - Instruction.
2. What is your name? Not an instruction.
3. Sit on the last bench - Instruction.
4. I am asking you to sit on the last bench - Not an instruction.
5. Write down today’s date on the board - Instruction.
6. You are writing down today’s date on the board - Not an instruction.

Sentences expressing simple instructions begin with the main verb - tell, sit and write. The subject of such sentences is “you” but it is generally omitted.

Read the following words:
1. First
2. Then
3. Next
4. After that
5. This should be followed by
6. Finally

These words are commonly used while giving a series of instructions. Let’s, read the following example to understand the concept:

**How to make an omelette**

“First, heat oil on a pan. Beat the eggs in a bowl and add salt. Fry chopped onions and green chili as soon as the oil is hot enough. Then, pour the beaten egg on the pan. Wait till the eggs get properly cooked on one side. Finally, turn the eggs over on the other side with the help of a flat spoon. Cook for 2 minutes.”

Your facilitator will show you the “Letter Format” Chart. It will have the following on it:

Sender’s address                                    Date:
Recipient’s name
Recipient’s address
Salutation {should be “Dear (name of recipient)”}
Body of letter (main part of the letter)
Yours sincerely,
Name of sender
Attempt to write down a step-by-step set of instructions on how to write a letter.

**Prepositions**

- We are sitting in the dining room.
- We are inside the house.
- Put the mug inside the cardboard box.
- Pour some coffee into the mug.
- We sprinkled water on his head to wake him up.

**EXERCISE**

Choose the appropriate preposition:

1. Come to the shop ____________ 5 p.m. (at, in)
2. Finish the homework ____________ 15 minutes. (at, in)
3. Turn this fan ____________. (of, off)
4. Walk ____________ a straight line. (in, with)
5. Get a kilo of sugar ____________ the grocery. (at, from)
6. Stand ____________ that chair and see if you can reach the shelf. (on, above)
7. Take these vegetables ____________ the kitchen. (to, into)
8. Do not smoke ____________ this area. (in, around)

**ASSESSMENT**

Fill in the blanks with the correct options.

1. Do not honk unnecessarily ____________ traffic signals.
   (a) at    (b) from    (c) under

2. Do not stand ____________ the glass door.
   (a) like    (b) during    (c) near

3. The manager has given a new set of instructions ____________ the staff on office attendance.
   (a) from    (b) to    (c) on
4. As per the school rules, students will not be allowed to enter the school gates ______________ 9:30 am.
   (a) during (b) after (c) to

5. ______________ our stay at Khairi in Chamba, we were not allowed to go out in the evening without an armed guard.
   (a) During (b) Before (c) After

6. Tell the gate keeper to make sure that cigarettes or other tobacco products are not sold ______________ the school building.
   (a) near (b) on (c) through

7. Get me a cup of coffee and a sandwich ______________ the shop across the street.
   (a) for (b) of (c) from

8. You cannot park your car anywhere ______________ this building for security reasons.
   (a) from (b) around (c) like

9. Park your car ______________ the parking lot behind that mall.
   (a) in (b) on (c) for

10. The shop is not far, it is just ______________ the road.
    (a) across (b) on (c) at

---

SESSION 16: REGISTERING A COMPLAINT

Relevant Knowledge

What would be your response to the following situation?

“Your neighbors have been partying for the last three nights. They play loud music and you can’t sleep. You had requested them to keep the volume low but they haven’t done anything about it. So you went to the police and complained. A friend of yours does not know why you went to the police station. How would you tell her?”

Study the details given here.

“Registering a Complaint - 1”

1. To register a complaint: To make a complaint before an authority.
   E.g. We registered a complaint to the Principal regarding the bad canteen food.
2. To lodge a complaint: To make a complaint before an authority.  
   **E.g.** She lodged a complaint against her supervisor to the CEO.

3. To file a complaint: To make a complaint before an authority.  
   **E.g.** They are filing a complaint against their neighbors to the police.

4. To press charges: To make an official complaint in a court of law.  
   **E.g.** The actor is pressing charges against the newspaper for printing rumors about her.

5. Object: To protest against something.  
   **E.g.** We objected to the serving of alcohol at the camp site.

   **E.g.** The students are planning to protest against the teachers.

The Past Perfect Tense is used to describe an action which occurred before another action in the past.

**Verbs in the Past Perfect Tense will take the following form:**  
I/you/lt/she/he/we/they/the people/the sisters + had + past participle form of the verb.

**Read the following examples:**
- I did my homework - *Simple Past Tense*
- I went out to play - *Simple Past Tense*
- I went out to play as I had done my homework - *Past Perfect Tense*

**EXAMPLES**

1. I went out to play as I had done my homework.
2. They had already left by the time we reached the place.
3. I had had my breakfast before the alarm woke you.

**Identify which sentence belongs to the Past Perfect Tense.**

1. I had my dinner.
2. I had had my lunch.
3. He had gone to Paris.
4. Have you understood the theory?
5. I had understood the theory.
6. The dog had gone away somewhere.
7. It **had been** abandoned.
8. It **had** a collar on its neck

**EXERCISE**

Rearrange the sentences to form a conversation between **A** and **B**. The first two have been done for you.

- Because the canteen owner allows them to smoke.
- They should smoke somewhere else as it harms non-smokers too.
- So the problem is with him!
- Then why at the canteen?
- Too many people at our college smoke in the canteen.
- Alright!
- Actually, they don’t smoke anywhere else because of the signs.
- That’s true.
- Who else? Let us write a letter stating our formal complaint and drop it in the “Complaint Box”.
- Exactly! Why should they make us unhealthy too?
- To the Principal?
- But how do we make them stop smoking at the canteen?
- I think we should lodge a complaint against him.
- Hmmm...those **No Smoking** signboards at the gate are not helping much.
- Yes. What do we do?

**A:** Too many people at our college smoke in the canteen.

**B:** That’s true.

**A:** __________________________________________________________

**B:** __________________________________________________________

**A:** __________________________________________________________

**B:** __________________________________________________________

**A:** __________________________________________________________

**B:** __________________________________________________________
ASSESSMENT

Change the verbs in brackets to Past Perfect Tense and fill in the blanks. An example is given below to help you understand this tense.

Simple Past tense: I did my homework.
Past Perfect tense: I had done my homework.

1. Rahul __________________ (lose) cell phone on his way to Delhi from Lucknow. He __________________ (travel) in the first class of the Lucknow Shatabdi. He had no idea how to get his cell phone back. He knew he had to lodge an FIR first. He knew he would have to go to the police station but he was not sure if he would go. He _____________ (hear) stories of how taking the help of the police took a lot of time and effort. Then he remembered what his friend _________________ (tell) him. If his phone was used for some bad purposes, he would have to take responsibility for it. So, Rahul decided it was better to go and deal with the police than end up in some problem later on.

2. I __________________ (drop) a complaint in the complaint-box about the lazy watchman as many people __________________ (complain) against him.

3. Shilpa_________________ (file) an FIR as soon as she found out about the theft.

4. We_________________ (protest) against the use of animal fur in fashion.

5. They_________________ (object) to the use of animal fur in fashion.
SESSION 17: CALLING UP TO FIND ABOUT A JOB VACANCY

Relevant Knowledge

Making calls to inquire about vacancies is a skill you need to acquire, as, sometimes in real life you may need to call up and find out about job vacancies.

Read the following phrases and sentences:
1. I saw your advertisement in the newspaper...
2. I am calling with reference to your advertisement in...
3. Could you tell me if there is a job vacancy in your organization?
4. Could you tell me if there is any vacancy for the post of...?
5. Do you have a vacancy for the post of...?

Modals are helping verbs. They help to express the mood of the main verb.

The various modals are can, could, may, might, shall, should, will, and would. They have various uses:

• **Asking for permission:** May I come in? Can/Could I use your pen? Can I go?
• **Making a request:** Can/Could you pass me the book? Will you be my partner?
• **Expressing obligation:** You should do the work yourself. I shall be responsible for your safety.
• **Expressing determination:** I will finish the project, come what may.
• **Expressing ability:** I can solve the riddle. We could jump over the bench when we were kids.
• **Expressing probability:** I may be able to help you out. It might rain tomorrow.
• **Expressing willingness:** I will meet you tomorrow.

**EXERCISE**

Read the jumbled up conversation in the “Job Vacancy”. The italicized sentences have jumbled words. You need to rearrange the words in order to make meaningful sentences.

A: Hello!
B: Hello! *JobBazaar this Consultancy is? ****************************
A: Yes. What can I do for you?
B: Your in Sunday’s I Times of India saw issue advertisement.
A: Okay.
B: *Is wanted to if find out I a vacancy job there.*
A: Could you tell me what kind of a job you are looking for?
B: I am a high-school English teacher.
   *Looking for am I for a vacancy job same the post.*
A: Okay. You would have to consult our agent for jobs in education.
B: *Do that I do how?*
A: You would have to come to our office with your resume. *An appointment you like would now to make?*
B: *Sure.*
A: Okay. Monday at 11 a.m.
B: *Okay. I will be there. Thanks a lot!*

**ASSESSMENT**

Fill in the blanks with the correct words from the given table: **might, ought, have to, can, shall, may, should, could, would, will.**

**Kavita:** Hello, this is Cure Pharmaceuticals. How ____________ I help you?

**Gargi:** Hi Kavita. This is Gargi here. ____________ I speak to anyone from the HR department?

**Kavita:** Of course, ____________ I connect you to the HR manager?

**Gargi:** That ____________ be great. Thanks a lot.

**Kavita:** Please hold on for a minute. Nilesh: Nilesh speaking.

**Gargi:** Hi Nilesh, This is Gargi speaking. ____________ you tell me if you have any vacancy in your company?

**Nilesh:** We are a large company Gargi, which department ____________ you be interested in?

**Gargi:** That ____________ be the HR department itself, as I have an MBA in HR from Amity.

**Nilesh:** MBA in HR from Amity? That ____________ to be useful. Let me have a look...You’re in luck. ____________ you come down here tomorrow for an interview?

**Gargi:** That ____________ be a problem. ____________ I come in day after?

**Nilesh:** Let me see...that ____________ be possible. Can you come by 9 am?

**Gargi:** Yes that’s fine. I ____________ be there by 9. Thanks a lot.
SESSION 18: WRITING A RESUME

Relevant Knowledge

What is a resume and why spend time writing one? Resume writing is a crucial part of the job application process. If you rush a job application and send your resume without thinking it could damage your chances of finding a job. Considering the current economic climate, there is fierce competition in most industries so spending time to make your resume stand out from the rest is very worthwhile.

A resume - sometimes called a ‘Curriculum Vitae’ or ‘CV’ - is a summary of your skills, education and work experience. A good resume demonstrates how your skills and abilities match up with the requirements of a job.

Here are a few reasons why writing a good resume is very important:

- It promotes you! A resume is a self-promotional document that presents you in the best possible light for the purpose of getting selected for a job interview.
- A good resume will compliment your cover letter writing and make your overall application stronger.
- You can achieve your dream job. By spending time perfecting your resume you stand a better chance of landing your dream job, especially if you include all relevant work experience.
- Networking can be boosted with a good resume. If your resume stands out from the rest an employer is more likely to speak to people in their industry about you.
- It opens up referral job applications. If an employer likes your resume but doesn’t have any suitable vacancies they are likely to recommend you for other job openings.

Read the following list, and tick the ones you think should be included in a resume or Curriculum Vitae (CV).

1. Email address
2. Favorite films and actors
3. Nationality
4. Phone number
5. Computer skills
6. Gender
7. Address
8. Date of birth
9. The newspaper you subscribe to
10. Marital Status
11. Awards and achievements
12. Place of birth
13. Your height and weight
14. Details of education
15. Skills and interests
16. Languages
17. The festivals you celebrate
18. Details of previous employments
19. Your religion

“CV Terms”: Study the terms given below.

1. Contact details: Your name, address, phone number, and email address
2. Objective: A statement of what you intend to achieve and contribute through your service to the organization. E.g., *To use my skill and work to the best of my ability for the development of the organization.*
3. Personal information: You may include your gender, date of birth, place of birth, nationality, marital status, and languages known to you under this heading. Optional information includes spouse’s name and number of children.
4. Area of expertise: The work skills that you have
5. Employment history: This states your work history. It should include the different organizations where you were employed previously, the length of each employment, and the positions you held.
6. Educational qualification: Details of the education that you have received -details of degrees and training
7. Skills and interests: You can state here other skills and interests that you have
8. Other enhancements/Awards and achievements: Any other achievement or work that you want to make special mention of
9. About me/Biography: This is an optional section where you give a short account of yourself.

Connectors and conjunctions

Connectors are words used to express relationship between ideas and combine paragraphs and sentences. For example: but, also, however, moreover, firstly, next, then, therefore, in brief, still, for example, thus, of course, certainly, hence, at the same time, on the contrary, etc.
Conjunctions are words used to connect phrases and words. For example: but, so, as, and, nor, yet, so, although, though, because, either...or, neither...nor, as soon as, and or.

Note: Conjunctions can also be used as connectors.

EXERCISE

Look at the format given below and develop your CV:

“CV Format”

Name:
Address:
Email address:
Telephone number:
Objective:

Personal Information
Date of birth:
Place of birth:
Nationality:
Marital status:
Languages known:
Employed: Yes/no
Area of expertise: E.g. Direct sales, customer help, and visual merchandizing.

Employment history (if any)
E.g. Worked as sales representative for SellWell for 2 years.
1. ______________________________________________________
2. ______________________________________________________
3. ______________________________________________________

Educational qualification
E.g. 1. HSC from Amravati High School (CBSE), Chandigarh, in 2003;
2. Diploma course in Basic Computer Education from All, Chandigarh, in 2004

1. 
2. 
3. 

Computer Skills

1. 
2. 

Skills and interests

E.g. 1. Possess good communication skills
2. Reading books

1. 
2. 
3. 

Awards and achievements

E.g. 1. Won “Sales Representative of the Year” Award at SellWell
2. Captain of the college cricket team for 2 years

1. 
2. 
3. 

Fill in the details to make your own CV. Examples have been given to show how some information may be filled in.

Note: There is a small difference between a resume and a curriculum vitae (CV) i.e., the length of the document. While a resume is brief and concise summary of your skills, experience and education - less than a page or two, a curriculum vitae is a longer (at least two page) and more detailed synopsis.

Covering Letter

Improve the following covering letter by changing some sentence structures. The sentences that can be changed (or linked) have been underlined.
To
The HR Manager
Healthy Pharmaceuticals
Healthpur
Healthy Pradesh

Dear Madam,

I’m writing to you regarding sales positions at Healthy Pharmaceuticals. I’m also writing to you about marketing positions.

I’m a fresh graduate. I have a B.Com degree in marketing. I would like to work in a sector that improves our society. I want to improve people’s lives. I have a keen interest in working with a pharmaceutical company. I am interested in working with Healthy Pharmaceuticals.

Though I have no experience in sales and marketing so far, I’m confident that I will be a successful salesperson. I have good people skills. I am disciplined. I am a hard worker. Also, at my college I participated in many activities. I participated in awareness campaigns for youth.________________. I think I’m suited for a job that requires communicating with customers.

I hope you will consider my job application positively. Please consider me for an interview.

Do you require any additional information? Please let me know.

Sincerely,

ASSessment

Fill in the blanks with suitable connectors/conjunctions

1. I went to see her ____________ she wasn’t at home. (and, but)

2. It started raining ____________ we went out. (as soon as, because)

3. We came back ____________ she was not at home. (as, yet)

4. She was not at home ____________ we came back. (so, however)

5. ____________, boil the water. ____________ add the sugar. (First-then) (Then-first)

6. _______ we missed her _______ she never received our message. (Either-or, Neither-nor)

7. We drove fast. _______ we could not reach on time _______ of the traffic jams. (However-because, Because-however)

8. He told you that he gave me the book?__________, the book is still with him. (Thus, On the contrary)

9. I came to see you ____________ you are not well. (because, so)

10. ____________ I had messaged them, they still were not ready on time. (Although, And)
SESSION 19: WRITING A COVERING LETTER

Relevant Knowledge

A covering letter written by Mr. A of Arjun Nagar in response to an advertisement placed by Welcome Travels, Sarojini Nagar is given below. There are four errors in the format and you have to spot them.

Arjun Nagar.
Email: a@hotmail.com
Ph no: 09891989198

Dated: 22 Dec, 2008

Subject: Application for the post of sales executive

Welcome Travels,
The HR Manager,
Sarojini Nagar

Dear Sir,

With reference to your advertisement in Times Ascent, dated 21 Dec, 2008, I wish to apply for the post under concern.

I have just graduated in Commerce (with Honours) from Delhi University. I am a dedicated individual who possesses good communication skills and I am eager to join your company.

My CV is enclosed herewith.

Thanking you,

Mr. A.,
Yours faithfully.

---

Read the “Lines for Covering Letters” given below.

*The lines with which a covering letter begins when it is written in response to a vacancy advertisement:*

1) I am writing in response to your advertisement............ for the post of............
2) With reference to your advertisement in............ I wish to apply for the post of............

*The lines written to show that you have the ability to handle the job:*

1) I will be able to handle responsibilities well.
2) I have the skills that are required for the concerned job.
The lines written before the last paragraph:
1) Please find attached a copy of my resume.
2) My CV is enclosed herewith.
3) My resume is enclosed for your review.

The lines written in the last paragraph:
1) Thank you for your consideration.
2) I would appreciate it if my application is considered for the post.

The lines written in the last paragraph, following the lines given above:
1) Looking forward to your response.................
2) I look forward to hearing from you soon.

EXERCISE

Read the details given below.
“Siddhesh Sharma’s Covering Letter”

Siddhesh Sharma’s contact details
• B-12, Manak Chand Basti, Arjun Nagar, Delhi -11003.
• Email: siddhesh.sharma@gmail.com
• Phone: 09891223314

Contact details of recipient
• HR Manager
• SellWell Organization, Maurice Road, Delhi - 110007

Subject: Application for the post of Sales Manager

Body of the letter (you have to rearrange the sentences):
• I would appreciate it if my application is considered for the post.
• My resume is enclosed for your review.
• Thus, I have the skills as well as experience required for the concerned job.
• I also have a MBA in Retail from AIBM, Hyderabad.
• I am writing in response to your advertisement in The Times of India for the post of Sales Manager.
• I look forward to hearing from you soon.
• I was hired by GoShop, a reputed supermarket chain, as Sales Manager for two years.
You have to write Siddhesh Sharma’s covering letter in the correct format. The details of the letter have been given. The sentences that make up the body of the letter have also been provided. However, you have to rearrange them so that they are presented in the correct order. The salutation and leave-taking have to be inserted by you.

**Reported speech**

Let’s understand Reported Speech with the help of the following examples and explanations:

1. He said, “I am thirsty” - *Direct Speech*
2. He said he was thirsty - *Reported Speech*.
3. She said, “What are you doing?” - *Direct Speech*.
4. She asked me what I was doing - *Reported Speech*.
5. They said, “We have won the match” - *Direct Speech*.
6. They said they had won the match - *Reported Speech*.

Reported speech (or indirect speech) is used to tell what people say or think. While changing a sentence from direct speech to reported speech, the verb will change into its past form.

**For example:**

- am/is - was
- are - were
- has/have - had
- do - did
- am doing - was doing
- have done - had done
- will - would
- can - could
- shall - should
- may - might

**But these remain the same:**

- had - had
- would - would
- could - could
- should - should
- might - might
- ought to - ought to
Other standard changes include:

- yesterday - previous day/the day before
- this - that
- these - those
- now - then
- here - there
- tomorrow - the following day
- next (day/week/etc.) - the following (day/week/etc.)

Note: The following remain the same: that - that, those - those, then - then, and there - there.

ASSESSMENT

Read the following and identify the correct options:

1. Meena said to me, “I can’t go tomorrow.”
   (a) Meena told me that she couldn’t go tomorrow.
   (b) Meena told me that she can’t go the following day.
   (c) Meena told me that she couldn’t go the following day.

2. I asked, “Why aren’t you going tomorrow?”
   (a) I asked Meena why she wasn’t going tomorrow.
   (b) I asked Meena why she were not going tomorrow.
   (c) I asked Meena why she wasn’t going the following day.

3. She said, “I have to go to the post office to mail a covering letter.”
   (a) Meena said that she had to go to the post office to mail a covering letter.
   (b) Meena said that she will go to the post office to mail a covering letter.
   (c) Meena said that she have to go to the post office to mail a covering letter.

4. I said, “Can I go with you?”
   (a) I asked if I could go with her.
   (b) I asked if I can go with her.
   (c) I said I could go with her.
5. Meena said, “That would be great!”
   (a) Meena told me that would be great.
   (b) Meena told me this would be great.
   (c) Meena told me that will be great.

The following is a conversation between a boy and a girl. You have to turn the direct speech to reported speech. The first three have been done for you.

1. **Boy**: “I have never written a covering letter.”
   Reported speech: The boy said that he had never written a covering letter.

2. **Girl**: “Would you like to learn how to write one?”
   Reported speech: The girl asked him if he would like to learn how to write one.

3. **Boy**: “Yes, I would like to learn to write one.”
   Reported speech: The boy replied that he would like to learn to write one.

4. **Boy**: “Who can teach me how to write a covering letter?”
   Reported speech: ________________________________________________________.

5. **Girl**: “I have written a lot of them so I can teach you.”
   Reported speech: ________________________________________________________.

6. **Boy**: “Are there a lot of rules?”
   Reported speech: ________________________________________________________.

7. **Girl**: “Yes. Even something like writing a covering letter has a lot of rules.”
   Reported speech: ________________________________________________________.

8. **Girl**: “Often people write these letters in any way they want.”
   Reported speech: ________________________________________________________.

9. **Boy**: “Have you sent any covering letter recently?”
   Reported speech: ________________________________________________________.

10. **Girl**: “I sent one to a company just yesterday.”
    Reported speech: ________________________________________________________ .
SESSION 20: FACING AN INTERVIEW

Relevant Knowledge

Read carefully the “Common Interview questions” given below:

1. **Please introduce yourself/ Could you tell us a little about yourself?**
   Interviews usually start with this question. You have to introduce yourself by stating some basic personal information (Refer to session 6 of Level 1 textbook).

2. **Why have you applied for this job?**
   For this question, you may need to do some background research on the company. You may also add that the skills and experience you have makes you suitable for the job.
   For example: “I am interested in this job as I will get to work for a well-known and successful organization. I also believe that the skills and experience I have makes me suitable for the job.”
   OR “I am interested in this job because I like the work profile. I also believe that the skills and experience I have makes me suitable for the job.”

3. **What are your key areas of expertise?**
   For this question, you will state the skills that you have which are related to your job. For example, the key areas of expertise of a sales representative may be direct sales, customer help, visual merchandising, etc.

4. **Why do you think you are suited for this job?**
   For this question, you should talk about your qualities as well as skills that would make you suitable for the job.
   For example, a sales representative should have good communication skills as well as knowledge of current trends. If the candidate is experienced (i.e. not a fresher), then he must also talk about how the skills he has acquired from a previous job can contribute to the new one.
   For example: “I have been working as sales representative for a year and I am skilled in direct sales as well as marketing. Therefore, I can easily adapt myself to the new job.”

5. **Why did you leave your last job?**
   While answering this question, you should never give any negative comments about your previous employers. Instead of saying, “I was not happy with my last job as it was boring” say “I was not unhappy with my last job. But I am eager to take on more challenges.”
6. **What are your career objectives?**

While answering this question, talk about the job first and then about what you can do for the company. For example, “My career objectives are to do my job well and to contribute to the overall development of the company.”

7. **What are your salary expectations?**

If you are a fresher, then it is better to ask the interviewer the salary range of the position you have applied for. For example, “As this is my first job, I have no idea of the salary range of this position. I would be happy with your decision.”

If you have experience, then you must have already quoted your current income in your resume. It is safe to quote around 10-15% more than your current salary if you are applying for the same post. If you are applying for a higher post, you can quote 20-25% more. While negotiating, you must mention your skills and the advantage of your experience.

For example, “I am already earning ___________ and I have my experience and skills. Therefore, I would expect a salary of ______________.”

8. **Can you tell me what your strengths and weaknesses are?**

While discussing your strengths in an interview, focus on those skills which are related to the job. For example, “I have the ability to work well in a team and to communicate well with people.”

While discussing your weaknesses, do not mention personal ones, such as, “I have a short temper” or “I am very lazy”. Instead, talk about those weaknesses which can be easily overcome. For example, “I have not handled such a big team before. But I am confident that I will learn on the job.”

---

**EXERCISE**

You need to imagine that you are having a conversation with your facilitator. He/she will say the answers and you have to frame the questions to them.

1. The train leaves at 10:20 a.m.
2. I am reading a book.
3. Yes, you can borrow the book.
4. No, I don’t think the train will be late today.
5. I know because I always take that train and it has never been late.
6. The interview went very well.
7. No, They said they will inform me of the outcome next week.
ASSESSMENT

Choose the correct option and fill in the blank:

1. Nishi: __________ I come in, Ma’am? (may, might)

2. Interviewer: Come in, come in. Have a seat.
   Nishi: Thank you, Ma’am.

3. Interviewer: It is Nishi, __________? (is it, isn’t it)
   Nishi: Yes, Ma’am.

4. Interviewer: __________are you? (where, how)
   Nishi: I am fine, thank you.

5. Interviewer: Ok. So tell us, Nishi __________ have you applied to SellWell? (why, how)
   Nishi: SellWell is one of the largest supermarket chains in India. It is a successful organization that has been popular ever since it started five years ago.

6. Interviewer: __________you have any experience as a sales executive? (do, did)
   Nishi: Yes, Ma’am. I have worked as sales executive at Shopper’s Haven for a year.

7. Interviewer: That’s good. We take only experienced people here. __________departments were you in? (which, whose)
   Nishi: I worked at food section for the first six months and clothing for the next six months.

8. Interviewer: __________salary are you expecting? (what, how much)
   Nishi: My previous salary was 10,000 Rupees per month. So, I am expecting around 13,000 Rupees at SellWell.

9. Interviewer: Okay. That is reasonable. __________will you be able to join? (when, where)
   Nishi: I can join this Monday.

10. Interviewer: Great! We are one member short in our shoes and bags department. __________ you comfortable with this post? (have, are)
    Nishi: Yes, Ma’am.

11. Interviewer: Good. __________there any question you would like to ask? (are, is)
    Nishi: No, Ma’am.
SESSION 21: TAKING A TELEPHONIC INTERVIEW

Relevant Knowledge

Read the statements below:

“Telephonic Interview”

1. I am a little busy right now. Can we reschedule the interview?
   • Used when the interview call is unexpected and you are not prepared, or when you are busy in some work.

2. I am sorry. I will not be able to join on Monday as I have some urgent work. Is it okay if I join on Tuesday?
   • Used when you are unable to join work on the day that the caller/interviewer suggests.

3. I was looking forward to your call.
   • Used when the interview is pre-scheduled.

4. I hope you can hear me ...
   • Used if the phone line is not clear. Avoid sentences like “Speak louder!” and “I can’t hear you.”

5. When am I likely to hear from you?
   • Used while hanging up, when the caller/interviewer has not specified when he/she is going to call you back.

These are some standard lines that can be used during a telephonic interview.

Note: The questions discussed in the previous session under the “Common Interview Questions” are equally relevant to a telephonic interview.

You will again have a role play like in the last session, but this time, it will be a telephonic interview.

EXERCISE

Identify the sentences in the Present Perfect Tense.

1. I have had my telephonic interview.

2. She had tried to call you.

3. Did you get selected?

4. She has told me that I can join on the 22nd.
5. I haven’t received the call as yet.
6. I have been asked to bring all documents on the day I join.
7. I have read the contract and have agreed to sign.
8. I have had my dinner.
9. Have you done the job?
10. They have not come yet.

RELEVANT KNOWLEDGE

Change the italicized sentences to present perfect tense.

Caller : Hello! This is Ranjita Mehta calling from SellWell.

Sarthak : Hello.

Caller : May I speak to Mr. Sarthak Gupta?

Sarthak : This is Sarthak Gupta speaking.

Caller : I received the job application email that you sent me.

(1) ____________________________________________.

Sarthak : Okay.

Caller : I just read your resume.

(2) ____________________________________________.

Sarthak : OK.

Caller : I am pleased to inform you that we have a vacancy at the moment.

Sarthak : That’s great news.

Caller : Sarthak, did you ever take a telephonic interviewer?

(3) ____________________________________________.

Sarthak : No, I did not.

(4) ____________________________________________.

Caller : Well, we need to take your interview this way. We need to fill in the vacancy urgently.

Sarthak : Okay then.

Caller : So, Sarthak. We need someone who can keep an account of the stocks. Are you doing anything similar to this?

(5) ____________________________________________.
Sarthak: Yes, Ma’am. I was also in charge of the daily stock count apart from sales.

(6)____________________________________________.

Caller: Okay. You will be doing something related to that. You will be placed in charge of receiving stocks, stacking shelves and daily stock count.

Sarthak: I am familiar with the work.

Caller: And Sarthak, did you ever read planograms?

(7)____________________________________________.

Sarthak: Yes, I read them.

(8)____________________________________________.

Caller: Good. This is all we require from you. When can you join us?

Sarthak: I can join this coming Monday.

Caller: Ok. What are your salary expectations?

Sarthak: I earned an annual income of 1,20,000 Rupees at my previous company. I would therefore like a higher pay.

Caller: Ok Sarthak. We are offering a monthly salary of 10,500 Rupees presently. That is what we wrote informed at our website.

(9)____________________________________________.

Sarthak: Yes, I am aware of that.

Caller: But on account of your experience and excellent resume, we decided to offer you 13,500 Rupees. Is that agreeable?

(10)____________________________________________.

Sarthak: That sounds agreeable.

Caller: So Sarthak, can we expect you on Monday?

Sarthak: Yes, I will be there. Thanks for the opportunity.

SESSION 22: ACCEPTING A JOB OFFER

Relevant Knowledge

Writing a job acceptance letter when you have received a job offer is one of the best and most pleasurable things to do as it represents the culmination of all your efforts in searching for a new job.
A job acceptance letter is a letter that you write to a company which has offered you a job. In such a letter, the following points are included in the given sequence:

- Written acceptance of the job offer.
- The terms and conditions of employment (salary, benefits, etc.).
- Starting date of employment.
- Thanks and appreciation for the opportunity.
- Request for notification of any changes or if the candidate is required to do anything before starting employment.

**Note:** You don’t have to write the subject line of the letter.

Read the details given below: **“Accepting a Job Offer”**

**Written acceptance of a job**
- It is with great enthusiasm that I accept your offer of the post of Sales Executive at Sell/Well Org. Please consider this letter as my formal acceptance of it.
- I would like to express my pleasure at your offer of the post of Sales Executive at Sell/Well Org. Please consider this letter as formal acceptance of it.
- I am writing this letter as an acceptance of your offer of the post of Sales Executive at Sell/Well Org.

**Terms and conditions of employment**
- I understand that I will be receiving a starting salary of Rs 12,000 per month. I also understand that I will get full pay and benefits during the 3 months’ probationary period.
- As discussed, my starting salary will be Rs. 12,000 per month. I also understand that I will receive full pay and benefits during the 3 months’ probationary period.

**Starting date of employment**
- As agreed, my joining date will be the 1st of June, 2009.
- As discussed, I will be starting work from the 1st of June, 2009.

**Thanks and appreciation for the opportunity**
- Thank you once again for this wonderful opportunity. I look forward to joining your team/organization/company and becoming a part of the continued success that the team/organization/company represents.
- Thank you for the opportunity. It is an honour to be selected for your team/organization/company.
• Thank you for this wonderful opportunity. I will put in my best efforts to make a positive contribution to your team/organization/company.

**Request for notification if the candidate is required to do anything before starting employment.**

• Do let me know if I need to do anything prior to joining the company.
• If there is anything I need to do before my starting date, please let me know.

**Find out the meaning of the following words and phrases that have been taken from the “Accepting a Job Offer”.**

• Prior to - before/after/during
• Enthusiasm - laziness/eagerness/happiness
• Positive - useful/useless/unhelpful
• Per - one/each/first
• Opportunity - offer/order/chance
• Probationary - on trial/sample/training
Unit 2: Web Applications (Basic)
## CONTENTS

**Unit 2: Web Applications (Basic)**

<table>
<thead>
<tr>
<th>Session</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Working with Accessibility Options</td>
<td>77</td>
</tr>
<tr>
<td>2</td>
<td>Networking Fundamentals</td>
<td>83</td>
</tr>
<tr>
<td>3</td>
<td>Introduction to Instant Messaging</td>
<td>90</td>
</tr>
<tr>
<td>4</td>
<td>Chatting with a Contact – Google Talk</td>
<td>93</td>
</tr>
<tr>
<td>5</td>
<td>Creating and Publishing Web Pages – Blog</td>
<td>96</td>
</tr>
<tr>
<td>6</td>
<td>Using Offline Blog Editors</td>
<td>100</td>
</tr>
<tr>
<td>7</td>
<td>Online Transactions</td>
<td>104</td>
</tr>
<tr>
<td>8</td>
<td>Internet Security</td>
<td>110</td>
</tr>
</tbody>
</table>
SESSION 1: WORKING WITH ACCESSIBILITY OPTIONS

Relevant Knowledge

Computer Accessibility refers to the user friendliness of a computer system for all, regardless of their disability. This is mainly a software issue. However, when a combination of hardware and software, it enables a person with a disability or impairment to use a computer. It is known as Assistive Technology. In this session, you will learn about the basic accessibility options available on your computer.

There are numerous types of impairment that impact computer usage. These include:

- Cognitive impairments and learning disabilities, such as dyslexia, attention deficit-hyperactivity disorder (ADHD) or autism.
- Visual impairment such as low-vision, complete or partial blindness, and color blindness.
- Hearing impairment including deafness.
- Motor or dexterity impairment such as paralysis, cerebral palsy, or carpal tunnel syndrome and repetitive strain injury.

Accessibility Options in Control Panel are used to customize the way your keyboard, display, or mouse function. Many of these features are useful for people with disabilities as discussed earlier. In this session, you will learn to use accessibility options in Windows XP.

Launching accessibility options

- To launch accessibility options in Windows XP, Click Start > Control Panel > Accessibility Options. The Accessibility Options window appears.

Keyboard Tab

StickyKeys

StickyKeys is an accessibility feature to help computer users with physical disabilities, but it is also used by others as a means to reduce repetitive strain. StickyKeys allows the user to press and release a modifier key, such as Shift, Ctrl, Alt, or the Windows key, and have it remain active until any other key is pressed.
To enable StickyKeys, select **Use StickyKeys**.

Click **Apply**.

Click **OK**.

The StickyKeys icon appears in the system tray (figure 2).

After having enabled StickyKeys, you will now practice and see its effect.

- Start Notepad. To do so, click **Start > All Programs > Accessories > Notepad**.
- Type some text (3 - 4 lines at least) and place the cursor at the beginning of the text.
- Press CTRL key on your keyboard.
- Press letter A on your keyboard.

Notice the entire text gets selected. This action is equivalent to pressing CTRL+A simultaneously!

To disable StickyKeys, uncheck **Use StickyKeys** and then click on **Apply > OK**.

**FilterKeys**

**FilterKeys** is a feature of Microsoft Windows. It is an accessibility function that tells the keyboard to ignore brief or repeated keystrokes, making typing easier for people with hand tremors.

- To enable FilterKeys, check **Use FilterKeys**.
- Click **Settings** under FilterKeys and check “**Ignore Repeated Keystrokes**”.
- Click **Apply**.
- Click **OK**.

The FilterKeys icon appears in the system tray (figure 3).

After having enabled FilterKeys, you will now practice and see its effect.

- Start Notepad and type some repeated characters.

Notice that the repeated characters are ignored.
To disable FilterKeys, uncheck *Use FilterKeys* and then click on *Apply > OK*.

**ToggleKeys**

ToggleKeys is also a feature of Microsoft Windows. It is an accessibility function which is designed for people who have vision impairment or cognitive disabilities. When ToggleKeys is turned on, computer emits sound cues when the locking keys (Caps Lock, Num Lock, or Scroll Lock) are pressed. A high sound is emitted when the keys are switched on and a low sound is emitted when they are switched off.

- To enable ToggleKeys, Check *Use ToggleKeys*.
- Click *Settings* under ToggleKeys.
- Click *Apply*.
- Click *OK*.

Having enabled ToggleKeys, you can see its effect by any one of the following keys NUM LOCK, CAPS LOCK or SCROLL LOCK. Notice that on doing so, you hear a beep.

To disable ToggleKeys, uncheck *Use ToggleKeys* and then click on *Apply > OK*.

**Sound Tab**

Select the Sound Tab. A window with options to configure accessibility options for sound is displayed (figure 4).

**SoundSentry**

SoundSentry is designed to help users with auditory impairments. SoundSentry generates visual warnings, such as a blinking title bar or a flashing border, whenever the computer generates a sound.

- To enable SoundSentry, Check *Use SoundSentry* under Sound Tab. Doing so activates a drop down list wherefrom you can choose the type of visual warning desired.
- Click *Apply*.
- Click *OK*.

For understanding SoundSentry, you need to create an error!

- Click *Start> Run*. Type *note* instead of *notepad* and press *Enter*.
• Type some repeated characters in the notepad. Notice that the desktop will flash for a fraction of second along with visual error sound code.

To disable SoundSentry, uncheck **Use SoundSentry** and then click on **Apply > OK**.

**ShowSounds**

ShowSounds instructs applications that convey information by sound, to also provide information visually, through text captions or informative icons.

• To enable ShowSounds, Check **Use ShowSounds** under Sound Tab.
• Click **Apply**.
• Click **OK**.

**Display Tab**

Select the Display Tab. A window with options to configure accessibility options for display is displayed.

**High Contrast**

High Contrast is an accessibility feature to assist people with vision impairment. You can change the size and color of fonts and the background for ease of viewing.

• To enable HighContrast, Check **Use HighContrast** Under Display Tab (figure 5).
• Click **Apply**.
• Click **OK**.

Notice the difference on your monitor as the High Contrast option is enabled.

To disable High Contrast, uncheck **High Contrast > Apply > OK**.

**Cursor Options**

Cursor Options is also an accessibility feature that assists people with vision impairment by changing the blink rate and width of the cursor.

• To change the speed of the cursor blink, move the **Blink Rate** slider back and forth. Notice the cursor blinking at various speeds.
• To change the width of the cursor, move the **Width** slider back and forth. Notice the with of the cursor changing.
Mouse Tab

MouseKeys

MouseKeys is an accessibility feature that assists people who have difficulty using a mouse. This option uses the keyboard (especially numeric keypad) as a pointing device instead of a mouse.

Select the Mouse Tab, a window to configure accessibility options for mouse will be displayed (Figure 6).
- To enable MouseKeys, Check Use MouseKeys.
- Click Apply.
- Click OK.

![Figure 6](image)

Notice the MouseKey icon in the System Tray (figure 7).

![Figure 7](image)

Use number pad keys for moving mouse pointer instead of using mouse after enabling “Use MouseKeys”. Use number key 4 to move left, 6 to move right, 2 to move down and 8 to move up.

To disable MouseKeys, uncheck Use MouseKeys and then click on Apply > OK.

General Tab

This tab enables you to configure accessibility options for all users.

Select the General Tab, a window to configure additional accessibility options will be displayed (figure 8).

“Turn off accessibility features after idle for”, “Give warning message when turning a feature on” and “Make a sound when turning a feature on or off”.

Now check these features one by one and see what happens.
SerialKeys

SerialKeys is an accessibility feature that assists people that have difficulty using a keyboard or a mouse (or both). They can use special devices such as Sip, Puff and Breath Switches to provide input to the computer through Serial Ports.

For example, sipping on the tube activates one device, while puffing on the same tube activates another.

Figure 8

A user controlling a device using a sip and puff switch

- **Apply all settings to logon desktop** can be used to apply configured accessibility options to this user at logon.
- **Apply all settings to defaults for new users** can be used to apply configured accessibility options to all users using a particular computer.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Use StickyKeys option</td>
</tr>
<tr>
<td>2.</td>
<td>Use SoundSentry option</td>
</tr>
<tr>
<td>3.</td>
<td>Use High Contrast option</td>
</tr>
<tr>
<td>4.</td>
<td>Use SerialKeys option</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks

1. The option in Microsoft Windows XP used for helping users with physical disabilities and to reduce repetitive strain is ________________.
2. Sound Sentry is designed to help users with ________________ impairments.
3. The High Contrast option in Microsoft Windows XP is designed to assist people with ________________ impairments.
4. ________________ is designed to assist people that have difficulty using a keyboard or a mouse.

SESSION 2: NETWORKING FUNDAMENTALS

Relevant Knowledge

A computer network is a collection of computers and other hardware components interconnected by communication channels (cables or satellites) that allow sharing of resources and information. This session introduces you to the basic fundamental concepts of networking and Internet and using different types of Internet connection.

Networks are designed using the following architecture:

Peer-to-peer (P2P) Architecture:

Networks in which all computers have an equal status are called peer to peer networks. Generally in such a network each terminal has an equally competent CPU.
**Client-Server Architecture:**

Networks in which certain computers have special dedicated tasks, providing services to other computers (in the network) are called client server networks. The computer(s) which provide services are called servers and the ones that use these services are called *clients*.

**Types of networks**

There are two major types of network Local Area Network (LAN) and Wide Area Network (WAN).

**Local Area Network**

A local area network (LAN) is one which connects computers and devices in a limited geographical area such as home, school, computer laboratory, office building, or closely positioned group of buildings.

Usually local area networks offer very high speeds and are used for connecting computers and peripherals such as printers, scanners, etc.

**Wide Area Network**

A wide area network (WAN) is one which covers a broad area (i.e., any network that links across metropolitan, regional, or national boundaries). The Internet is the most popular WAN, and is used by businesses, governments, non-profit organizations, individual consumers, artists, entertainers, and many others.

**Internet**

The Internet is a global system of interconnected computer networks that use the standard Internet protocol suite to serve billions of users worldwide. It is a network of networks that consists of millions of private, public, academic, business, and government networks.

Internet is one of the most useful technologies of modern times which help us in our daily, personal and professional life. Internet is widely used by students, educational institutes; scientist and professionals to gather information for research and general information. Businesses use the Internet to access complex databases such as financial database. The Internet is the largest encyclopaedia for all age groups. The Internet helps in maintaining contact with friends and relatives who live across different locations via Internet chatting systems and email software. Internet is also becoming a major source of entertainment for the general public.

**World Wide Web**

World Wide Web (abbreviated as WWW or W3, commonly known as the Web), is a system of interlinked hypertext documents accessed via the Internet. With a web browser, one can view web pages that may contain text, images, videos, and other multimedia, and navigate between them via hyperlinks.
Information is stored on web servers referred to as web pages are retrieved by using a web browser such as Firefox on the local computer. A Web Browser is a software used to view Web sites and acts as an interface between the user and the World Wide Web. A Web server is a computer that stores web sites and their related files for viewing on the Internet.

Some of the advantages associated with networking are:

- **Data Sharing:** One of the most important uses of networking is to allow the sharing of data. Users can send text files, spread sheets, documents, presentations, audio files, video files, etc. to other users.

- **Hardware Sharing:** Hardware components such as printers, scanners, etc. can also be shared. For example, instead of purchasing 10 printers for each user, one printer can be purchased and shared among multiple users thus saving cost.

- **Internet Access Sharing:** You can purchase a single Internet connection and share it among other computers in a network instead of purchasing multiple Internet connection for each computer. This is very commonly found in Internet café (browsing centres), schools, colleges, companies, etc.

- **Usage of network based applications:** Such as web browsers, email clients, chat application, audio & video calling, etc is another advantage.

**Getting access to the Internet**

To use the Internet, you need an Internet connection. Internet connections are provided by Internet Service Providers such as Bharat Sanchar Nigam Limited (BSNL), Airtel, MTS, Vodafone, Tata Docomo, etc.

**Internet Service Provider**

An Internet service provider (ISP) is an organization which provides you with access to the Internet via a dial-up (using modem) or direct (hard wired) or wireless connection.

Choosing connectivity depends on the availability of a particular technology, speed and connection type in your area. Usually small and medium business users, home users use connectivity types such as DSL, cable modem, dial-up, broadband wireless, WiMAX or 3G. Medium to large business users or customers with more demanding requirements may use high speed connectivity such as DSL (High Speed), ISDN, etc.

**Modem**

A modem is a device that converts digital computer signals into a form (analog signals) that can travel over phone lines. It also re-converts the analog signals back into digital signals. The word modem is derived from its function MOdulator/DEModulator.
Types of Common Internet Connectivity

There are different types of Internet Connectivity available today; it can be widely categorized into wired and wireless access. Following table is a summary of different types of Internet connectivity categorized into wired and wireless:

<table>
<thead>
<tr>
<th>Technology</th>
<th>Type of Connectivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial-Up</td>
<td>Wired</td>
</tr>
<tr>
<td>DSL</td>
<td>Wired</td>
</tr>
<tr>
<td>Cable Internet Access</td>
<td>Wired</td>
</tr>
<tr>
<td>3G</td>
<td>Wireless</td>
</tr>
<tr>
<td>WiMAX</td>
<td>Wireless</td>
</tr>
<tr>
<td>Wi-Fi</td>
<td>Wireless</td>
</tr>
</tbody>
</table>

Some of the commonly used Internet connectivity are:

**Dial-up:** Dial-up Internet access is a form of Internet access that uses the facilities of the public switched telephone network (PSTN) to establish a connection to an Internet service provider (ISP) via telephone lines using a device called MODEM. Users dial a particular number provided by the ISP and gain access to the Internet.

Dial-up connections are extremely slow and in most cases, it is replaced by a high speed connection such as DSL or Cable Modem.

**DSL:** Digital subscriber line (DSL) provide Internet access by transmitting digital data over wires of a local telephone network. DSL service is delivered along with wired telephone service on the same telephone line. On the customer premises, a DSL filter removes the high frequency interference, enabling simultaneous use of the telephone and data transmission. For using a DSL connection, you need a DSL modem and a subscription.

**Cable Internet Access:** Cable Internet Access is a form of broadband Internet access that uses the cable television infrastructure. Cable Internet Access is provided through existing cable TV networks; this is similar to DSL that is provided over existing telephone lines.

**3G:** 3G, short for 3rd Generation is a set of standards used for mobile devices and mobile telecommunication services and networks. High-Speed Downlink Packet Access (HSDPA) is 3G mobile telephony communications protocol that allows higher data transfer speeds and capacity. If support for 3G is available on your mobile phone, you can subscribe to the 3G connectivity with your ISP in order to get high speed Internet connection on your phone.

**WiMAX:** WiMAX (Worldwide Interoperability for Microwave Access) is a wireless communications standard designed to provide mobile broadband connectivity across cities and countries through
a variety of devices. WiMAX is a long range system, covering many kilometres and is typically used where DSL or Cable Internet Access cannot be used; this could be difficulty in laying out cables for home or offices located in remote locations but need access to the Internet.

**Wi-Fi:** Wi-Fi is a popular technology that allows an electronic device such as computers or mobile phones to exchange data wirelessly over a network, including high-speed Internet connections. Wi-Fi devices such as personal computer, smartphones, video game console, etc. can connect to a network resource such as Internet through a device called the Wireless Access Point (WAP). Wi-Fi is used where cables cannot be run (such as old buildings, outdoor areas) to provide network and Internet access. Wi-Fi can also be used where users require mobile connectivity.

Wi-Fi connectivity is used in home & offices, hotels, college & school campus typically for Internet Access. Shopping malls, coffee shops, resorts mostly offer free or paid Wi-Fi access to the Internet for their customers.

**Data transfer on the Internet**

Having talked of data transfer and the Internet, have you ever wondered how sitting in one corner of the world, you get information from another distant area in a few seconds?

In very simple language, let's see what happens to a piece of data, say a Web page, when it is transferred over the Internet:

- The data is broken up into bits of same sized pieces called **packets**.
- A **header** is added to each packet explaining where the data has come from, where it should end up and where it fits in with the rest of the packets.
- Each packet is sent from computer to computer until it finds its **destination**. Each computer on the way decides where next to send the packet. All packets may not take the same route.
- At the destination, the packets are **examined**. If any packets are missing or damaged, a message is sent asking for them to be re-sent. This continues until all packets have been received intact.
- The packets are now **reassembled** into their original form. All this done in seconds!

To access the Internet, you need an active internet connection. You need to gather and understand your requirement carefully before subscribing to an internet connection plan. In this exercise, you will learn how to choose an Internet connection.

**Some of the common questions that help you in your decision are:**

- What is the purpose of getting this connection?
- Will you use the connection regularly?
- How much data will be downloaded on an average per month?
• How much speed do you need?
• What technology is available in your particular area?
• What are the different plans available from the ISP?
• Is there any limitation or catch for the selected plan?

Use the following table to compare different subscription plans to get an estimate and analyze if that would suit your requirement.

<table>
<thead>
<tr>
<th>ISP</th>
<th>Plan Name</th>
<th>Download Speed</th>
<th>Download Limit</th>
<th>Free Modem</th>
</tr>
</thead>
<tbody>
<tr>
<td>3G</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cable Internet Access</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WiMAX</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To access Wi-Fi, you need an access point with an active Internet connection. Usually when you subscribe to an Internet connection, the ISP provides options to purchase or rent a Wi-Fi router that can act as both an internet connectivity device and an access point for Wi-Fi connectivity. Setting up a Wi-Fi network requires technical expertise; however, you can access the Wi-Fi network by connecting to an access point that is already setup for use. On computers that run Windows XP, you can view the list of wireless networks available by using the following procedure:

• Right-Click on the Wireless Icon in the system tray and Click View Available Wireless Networks (figure 10)
Windows XP will display the list of available Wi-Fi networks; you can choose any of the connection from the list. Select by Double-clicking on the name displayed in the list.

![Figure 11](image)

**Note:** You may be prompted to enter a password if the selected network is secure. You will receive a confirmation that you are connected to a wireless network. Now the system is ready to be used for network related applications such as Firefox, Chrome, Skype, etc.

**EXERCISE**

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>List any 3 ISP’s available in your city. After collecting information such as connectivity type, speed and charges, compare them and state which is the best ISP and why?</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

I. **Fill in the blanks:**

1. The acronym for LAN is __________.
2. Three types of Wired Internet Connectivity are __________, __________ & __________.
3. Three types of Wireless Internet Connectivity are __________, __________ & __________.

II. **Answer the following:**

1. What is the definition of networking?
2. What are the advantages of networking?
3. What are the different types of networking?
4. Explain LAN and WAN.

SESSION 3: INTRODUCTION TO INSTANT MESSAGING

Relevant Knowledge

Instant messaging (IM) is a form of communication over the Internet that offers an instantaneous transmission of text-based messages from sender to receiver. Most instant messaging software include the option for performing file transfers, audio chat, video calling and conferencing, sharing desktops, etc. apart from standard text chat. Instant messaging software is widely used for personal and commercial use. In this session, you will be introduced to the concept of instant messaging, the steps to create an instant messaging account and also work with instant messaging software.

Unlike email, instant messaging happens in real-time and the response from participants can be spontaneous. Some instant messaging software allows users to view messages received when they are not logged on. These are called “Offline Messages”.

For utilizing audio and video chat or conferencing, you need to have microphones and headsets or speakers and web cameras so that users can talk or see each other.

Key Features of an instant messaging are as follows:

- Text Messages can be sent to one or more person (Similar to SMS)
- Audio calling and conferencing.
- Video calling and conferencing.
- File transfers (Not limited to documents, spread sheets, audio files, video files, etc.)
- Message history (Save messages for future reference).

Instant Messaging Account

Participants messaging to each other need to be signed in to the same instant messaging software. To use instant messaging software, a user must have a valid instant messaging account.

Instant messaging accounts differ in formats; some instant messaging software such as Yahoo! Messenger, Windows Live Messenger use email addresses for managing the account and software such as Skype use standard names.
**Instant Messaging Services**

There are two kinds of instant messaging software – application based and Web based.

- Application based instant messaging software is downloaded and installed on user’s computer. Some of the popular instant messaging software are:
  - Google Talk
  - Yahoo! Messenger
  - Skype
  - Windows Live Messenger
  - Rediff Bol, etc.

- Web based instant messaging software is accessed using browsers such as Internet Explorer, Mozilla Firefox, Google Chrome, etc. Some of the popular web based instant messaging software are:
  - Meebo
  - Yahoo! Messenger for the Web
  - MSN Web Messenger
  - IMO, etc.

**Creating an instant messaging account**

In this exercise, you will learn to create an instant messaging account for using Google Talk.

Google Talk is an instant messaging service that provides both text and voice communication developed by Google Inc. Google Talk can also be used for making video calls and to view updates from GMAIL mailbox.

Google Talk is free and is available as application based (users need to download and install Google Talk application to their desktops, mobiles or laptops) and web based (users can use Google Talk through a browser after signing into their Gmail account).

Before you start using Google Talk, a Gmail account is required. You have learned how to create a Gmail account earlier. In this exercise, you will learn how to use Google Talk.

**Note:** You need to download and install Google Talk application from www.google.com/talk prior to this exercise.

**Launching Google Talk**

- To launch Google Talk, Click **Start > Programs >Google Talk>Google Talk.**
• You can also double-click on the Google Talk icon on the desktop if available.

You need to have a list of contacts that are available for chat. If you don’t have any contacts, you can add their Gmail account to your contact list by sending an invite.

If you don’t have a Gmail account already you can create a new Gmail account.

**Signing In into your Google Talk Account**

To use Google Talk, you need to sign in with your account details.

After signing in into your Google Talk account, you should see a window similar to the one displayed below. Now the Google Talk application is ready for use.

---

**EXERCISE**

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>You have learnt to sign-in into Google Talk. Now try Signing Out and Signing back in using Google Talk.</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

1. **Fill in the blanks:**

   1. ____________ is a form of communication over the Internet that offers an instantaneous transmission of text-based messages from sender to receiver.
2. ____________ , ____________ & ______________ & Web Camera are required for audio and video conferencing.

II. Answer the following:

1. List any five application based instant messaging software.
2. What do you mean by instant messages?

SESSION 4: CHATTING WITH A CONTACT – GOOGLE TALK

Relevant Knowledge

In this session, you will learn to chat with a contact that is already added to your contact list.

• Whenever your friend in the contact list is online you can see the person along with a green dot as in the figure 14:

![Figure 14](image)

• You can start sending text chat message instantly by double-clicking on a contact. A window will pop up as displayed in the figure below. You can type the text in the text box and press enter; the other person will see the text message and respond to your message.

• Go ahead and get the contacts of a couple of your classmates and chat with them.
There are some general rules and etiquettes to be followed while chatting. They are almost the same as those that apply for emails.

• Messages should be short and to the point.
• Always introduce yourself by name if your screen name doesn’t reflect it.
• Always ask if the other person has time to chat first - regardless of how important you think what you have to say is, it’s not going to be well received if the recipient is busy.
• In a business environment, know exactly what you want to discuss.
• Typing your messages in uppercase is extremely rude - it’s considered shouting and very aggressive.
• Give people time to respond - Multiple questions sent to a recipient before they’ve had a chance to answer can seem more like an interrogation rather than a conversation.
• Wherever possible, give the person you are communicating with your undivided attention. It’s not just a sign of respect, but if you have multiple conversations happening or are allowing other issues to distract you, you may miss an important point in the other person’s messages or lose the gist of the conversation.
• It’s important to properly end an IM conversation - you may think the chat is over, but the other person may not. While you’re off doing other things, they may be sitting there staring at the screen waiting for further communication from you!!

**Chatting on Gmail**

In this exercise, you will learn to chat with a contact using the Gmail account through a web browser.
You can also use the chatting services after signing into their Gmail Account. The same procedure will be followed while making voice chats, text chats etc. using the Gmail Account.

Once you sign into your Gmail account, a contact window will be displayed either on the left side or the right side within the browser as displayed below.

If you would like to chat with a contact, double click on the contact’s name. You will see a pop-up similar to the one displayed below.

Now you can start typing the message you want to send and the other contact should be able to respond to your chat message.

**Chatting on Yahoo**

Having learnt to use one IM software, you will experiment with another. In this exercise, you will create an instant messaging account for using Yahoo! Messenger.
**Note:** You may need to download and install Yahoo! Messenger application from http://in.messenger.yahoo.com/download/ prior to this exercise.

Before you start using Yahoo! Messenger, a Yahoo Mail account is required. If you don’t have a Yahoo! Mail Account already you can use the built in option for creating a new Yahoo! Mail Account.

You should a list of contacts that are available for chat. If you don’t have any contacts, you can add their Yahoo Mail account to your contact list by sending an invite.

**Note:** If you would like to import your contacts from other sources such as Microsoft Outlook, Gmail, Hotmail, etc., you can use the import option.

Having used Yahoo! Messenger, now go ahead and chat with your classmates using a Yahoo mail account through a web browser.

You can also try using other chat services such as MSN, Rediff, Sify, etc. Refer to respective websites for further instructions to download and using the software.

### EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Add more contacts to your contact list and chat with multiple contacts.</td>
</tr>
<tr>
<td>2.</td>
<td>Download, install and use Windows Live Messenger, Rediff, Sify messengers. Create respective accounts to practice.</td>
</tr>
</tbody>
</table>

### ASSESSMENT

Answer the following:

1. State any 03 rules and etiquettes to be followed while chatting on the Internet.
2. What are the basic needs to use instant messaging (chat) softwares.

### SESSION 5: CREATING AND PUBLISHING WEB PAGES - BLOG

**Relevant Knowledge**

A blog is a discussion style site used by non-technical (or technical users) users for creating personal web pages. Blogs are similar to an online personal diary and simple to use.
You can use a blog to convey messages about events, announcements, news, reviews, etc. Blogs are usually managed using a web browser and this requires active internet connection. You can also use offline blog software to create content first and later publish the content when an active internet connection is available.

There are hundreds of websites that offer blog service for free. Some of the popular blogs include:

- www.WordPress.com
- www.blogger.com
- www.blog.com
- www.weebly.com
- www.blogsome.com

**Creating a Blog Account**

In this session, you will learn how to create a blog account in WordPress.

WordPress is free web service that you can use to create a beautiful website or blog. WordPress has support for “themes” for customizing the design of a blog. Themes can make the blog or the webpage look attractive.

- Before you start using a blog, a blog account is required. To create one, you need a web browser and an internet connection.
- Open the Web Browser.
- On the address bar type `https://signup.WordPress.com/signup/`. You should now get to a page with the fields Blog address, Username, Password, Email Address and Language.
- **Blog Address**: You must provide a unique address to your WordPress Blog. This is the address which others will use to view your blog.
- **Username**: You should choose a username for managing this blog.
- **Password**: Securing your WordPress blog account with a strong password is important. A combination of uppercase and lowercase letters with some digits along with symbols would be a strong enough password. *You need to enter the password twice.*
- **Email Address**: You must provide your Email Address here. An activation link will be send to you from WordPress after you click “Create Blog”.
- **Language**: You can choose your own language for blogging from the list given.
- Click **Create Blog**.

On doing so, you will be sent an email for activating your blog account. Open your email and click on the activation link. Once you click Activate Blog, you will be redirected to your WordPress Blog.
Account and you should see a web page similar to the one displayed below.

![Figure 19](image)

Now the blog is ready for use. You will be presented with the address of your blog as displayed in the web page above; you can either double click on the link or type the address manually in the web browser. Either action takes you to the homepage of your blog.

Once you have created a blog, you need to submit content that you want others to view. This process is called posting content.

- To create a post, click **New Post**. A Window similar to the one displayed below appears.

![Figure 20](image)

- **Title**: You must provide a title for your post; choose a title that this post will focus on. For example, “School Annual Day Function 2012”.

Using the rich text box, you can type content that you want others to read.

Once you have finished typing the content, you need to publish the post for others to see. Click **Publish Post** to publish your content. To view the post, you can type the blog address in
the address bar of the web browser, you should see your blog along with the post (displayed below).

learningdemo

![My First Post!](image)

I am learning how to blog and this is my first post.

I will use this blog to help others for learning about blogs.

**Figure 21**

You can also add photos, videos, etc. to the blog using the options available in WordPress. You can comment on posts published by others. Usually, the comment option is available towards the end of the post. Look for options such as *Leave a comment, Leave a reply*, etc. in the blog to comment. For example, in WordPress the comment box is located below the post and labelled as *Leave a reply*.

**Figure 22**

- In the *Enter your comment here...* text box, type your comments about the post.
- In the *Email (required)* field, type your email address.
- In the *Name (required)* field, type your name.
- In the *Website* field, you may type your blog address (Optional).
- Once you have typed the content in the comment area, review carefully and Click Post Comment.
Once you click the Post Comment, you will see the blog along with your comment. (displayed below)

![Learndemo2 says:](image)
Your comment is awaiting moderation.
September 19, 2012 at 2:54 am

Nice!
I am also new to blog. Please help me to know things about blog
Thank You

Reply

Figure 23

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>You have learnt to create and work with blogs using WordPress. Now create and work with other blog websites such as blogger, weebly.</td>
</tr>
</tbody>
</table>
| 2. | Create blogs for:  
  • Announcing School Annual Day Function  
  • Blood Donation Camp |

**ASSESSMENT**

Answer the following:

1. Explain the purpose of a blog.
2. List any 5 websites that provide blog service.
3. Difference between web page and website.

**SESSION 6: USING OFFLINE BLOG EDITORS**

**Relevant Knowledge**

If you do not have an active internet connection, you can create blogs using a blog application and publish the blog whenever internet connectivity is available.

There are several free offline blog editors available that can be downloaded and installed on the local computer such as:
In this exercise, you will learn to use an offline blog editor Qumana. Qumana is a free blog application that is simple and easy to use. In this exercise, you will learn about using Qumana.

Note: You need to download and Install Qumana. Qumana can be downloaded from www.qumana.com. Once installed, you can use the program to manage blogs.

**Launching Qumana**

- To launch Qumana, Click Start > Programs > Qumana > Qumana.
- You can also Double-click on the Qumana icon on the desktop if available.

You need an existing blog account to use with Qumana. In this exercise, you will learn to use your existing WordPress account with Qumana. Enter your WordPress blog address and Click Next.

- A login window appears. You need to provide details of your WordPress account. However, if you wish to use it for other blog services, you need to enter appropriate details. Give the WordPress blog address in the Web address field. Enter the Username and password of the WordPress account.

- Click **Next > Finish**.

A window similar to the one below appears.
If posts are already available in your blog, Qumana will download and display the existing blogs as well.

To create a post,

- Click **New Post**.
- A window similar to the one below will be displayed (figure below).

*Figure 25*

Note: Enter the title for the post in the Title field and the post content in the area given below the page title.

- Click **Publish Post**.

Once you click **Publish Post**, the post will get automatically updated to your WordPress blog.

*Figure 26*
To view the published content, open the web browser and type your blog address.

You can include photos or pictures in your blog to make it attractive. To insert a picture,

- Click on the image icon on the right hand side of the application.

![Image Icon](Image.png)

**Figure 27**

- Once you click the image icon, the following window will be displayed.

![Insert Image Window](InsertImage.png)

**Figure 28**

- Click **Browse** to locate the image that you want to publish in the blog.
- Once you click “Browse”, the OS browse window appears, enabling you to locate the image to be loaded. When you have chosen the image click Upload & Insert.
- Click **Publish Post**.

To view the published content along with the picture, open the web browser and type in your blog address.

Now try using other blog applications such as Windows Live Writer, Blogdesk, etc. using different blog accounts.

**EXERCISE**

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Download and use different offline blog editors</td>
</tr>
</tbody>
</table>
ASSESSMENT

Answer the following:
1. Explain the purpose of an offline blog editor.
2. List any five offline blog editors.

SESSION 7: ONLINE TRANSACTIONS

Relevant Knowledge

Online shopping is a form of electronic commerce where customers can buy or sell goods over the Internet. Customers need to have an active internet connection for viewing goods or services offered by a seller; customers can pay online using a credit, debit card or by internet banking.

Online shopping could be useful in situations when:
- A customer does not have sufficient time to visit stores.
- Visiting a store is more expensive than purchasing a product online.
- A product or service that is not available in the local market is available online.

Some of the popular online transaction websites are:
- IRCTC, an online portal for booking flight and train tickets.
- Flipkart, an online shopping portal for buying consumer products.
- EBay, an online portal for buying and selling goods.
- Redbus, an online portal for booking bus tickets.

To perform an online transaction, all you need is a web browser and an active internet connection. In some cases where purchasing is involved, you will need a valid credit card, debit card or online banking support referred to as Net Banking Subscription. Some websites even allow COD (Cash on delivery) where the users can pay once they receive the product or service.

Online Transaction Using Flipkart

In this section, you will learn to perform an online transaction using Flipkart.

Flipkart is an online store where you can purchase a variety of electronic goods, books, accessories, digital cameras, mobile phones and peripherals such as printers, etc.
Flipkart offers multiple payment methods like credit card, debit card, net banking, e-gift voucher, and Cash on Delivery.

To work with Flipkart, you need to use a web browser and an active internet connection.

- Open any Browser such as Firefox, Chrome or Internet Explorer
- Type www.flipkart.com in the address bar and Press Enter.

A web page similar to the one below will be displayed.

![Flipkart webpage](image)

- To perform transactions using Flipkart, you need to sign up for a Flipkart account.
- Locate and click on the Sign Up link at the top of the web page, a window similar to the one below will be displayed for signing up with Flipkart.

![Sign Up window](image)

- Email Address: You must provide your Email Address. The Email Address is also used for sending offer mails, promotional mails to you. The Email Address will be used as the login name for your Flipkart Account.
• Password: You must secure your Flipkart Account by giving a strong password. You need to enter the password twice.

• Click **Sign Up Now!**

Once you have signed up successfully, a window similar to the one below will be displayed.

![Flipkart Home Page](image1.png)

**Figure 31**

Flipkart has a variety of products organized as categories. You can either look for respective product in appropriate category or you can use the search feature to locate a particular item. For example, if you would like to buy a digital camera, you can Digital Camera in the search box and choose a model from the search results window. You can select a model of your choice by clicking on the product image. You can browse the catalog of products available in Flipkart; once you have decided to purchase a product, you can use purchase the product by using the option Buy this now. You can select one or more products before you proceed to payment. Products added to your shopping cart will be available for review prior to payments.

![Shopping Cart](image2.png)

**Figure 32**
Flipkart allows a variety of methods for online payment. You can use credit card, debit card, Net Banking, Cash on Delivery or e-gift voucher to complete the payment; you need to enter appropriate details as required in the mentioned fields and Click Pay to initiate the payment. Depending on the method select, additional windows may be displayed and procedures will vary to complete the online transaction.

Some vendors (websites) also offer payment to be made in installments thus making it a convenient option for the customers. Refer to the website payment terms for information on payment procedures and practices.

**Online Transaction for Booking Rail Tickets**

In this section you will learn how to perform online transactions for booking train tickets using IRCTC.

Indian Railway Catering and Tourism Corporation (IRCTC) is an online portal that can be used for booking travel tickets.

To work with IRCTC, you need to use a web browser and an active internet connection.

- Open any Browser such as Firefox, Chrome or Internet Explorer
- Type www.irctc.co.in in the address bar and Press Enter.

A web page similar to the one below will be displayed.

![IRCTC Website](image)

- To perform transactions using IRCTC, you need to sign up for an IRCTC account.
• Locate and Click Signup link at the top of the web page, a window similar to the one below will be displayed for signing up with IRCTC.

• You will be redirected to a web page for signing up with IRCTC similar to the one below. Follow the onscreen procedures for filling up the details to complete the registration.

Once you logon to IRCTC, you can use the website for booking tickets. By now, you are quite familiar with what each field represents. Go ahead and fill in the details. The ones marked with an star (*) are mandatory fields.
Once you click “Find Trains”, list of available trains with ticket availability will be displayed (Figure below).

You can view the status of available tickets sorted by day (displayed above); once you have fixed a date that is convenient for travel, you can proceed to book the tickets by following the instructions provided in the website.

Once you book the ticket, an electronic copy of the ticket will be displayed on the screen. Additionally, the ticket will be mailed to the email address specified during registration.
EXERCISE

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Register with Junglee (<a href="http://www.junglee.com">www.junglee.com</a>), Yatra (<a href="http://www.yatra.com">www.yatra.com</a>) and practice online transactions.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Answer the following:

1. Explain the purpose of Online transactions.
2. List any five websites that allow online transactions.
3. List any three payment tools to use online transactions.

SESSION 8: INTERNET SECURITY

Relevant Knowledge

Internet security is a branch of computer security specifically related to the Internet, often involving browser security but also network security. Its objective is to establish rules and measures to use against attacks over the Internet. The Internet represents an insecure channel for exchanging information leading to a high risk of intrusion or fraud, such as phishing. This session introduces you to Internet security concepts and how to secure online and network transactions.

Though Internet provides valuable information and entertainment, it may leave your computer unsecure due to many online threats. You need to ensure that your usernames, passwords, credit card or online banking information secure as they are prone to be tracked and used by unauthorized users. Some websites can also install Malware on the computer without user consent thereby leaving the computer damaged or insecure.

Online threats such as Phishing, email spoofing, chat spoofing, etc. can increase the chances of users getting compromised.
You can reduce the risks by using best practices such as using Antivirus Software, Antispyware Software, Firewalls, strong passwords, etc. in addition to spreading awareness of the best practices.

**Best Practices for Security**

**Use strong passwords**, a combination of alphanumeric and special characters could be used for creating a password that is not so easy to crack or guessed by other users. Do not keep passwords such as your favorite color, friends or relatives name, bike number, mobile number either as single or combined option. These passwords are easy to guess if a user knows you personally. Change your password frequently at least 2 or 3 weeks so that your account information remains secure.

Using strong passwords can lower the risk of a security breach; effectiveness of a password depends on the security mechanism of the software and users involvement in generating a strong password.

Most websites check for password effectiveness when a user attempts to register for the first time or when they change password. For example, when you register with Gmail, you may notice a password meter displaying the strength of your password similar to the one displayed below.

![Password Strength](image)

**Figure 37**

**Following is a general guideline for managing strong passwords.**

- Keep the length of the password at least 12-14 characters if permitted.
- Avoid keeping passwords based on repetition, dictionary words, letter or number sequences, usernames, relative or pet names, etc.
- Including numbers, and symbols in passwords if allowed.
- Use capital and lower-case letters.
- Avoid using the same password for multiple sites or purposes.
• Avoid using something that the public or workmates know you strongly like or dislike.
• Use random password generators if possible.

Example of a strong password: u1vX:,4Hd[]$

You may also use websites such as www.strongpasswordgenerator.com that can generate random strong passwords. To generate a strong password using www.strongpasswordgenerator.com do the following:
• Open any web browser. Type www.strongpasswordgenerator.com in the address bar and press Enter.
• Click Generate strong password. Notice the password displayed under your new password.

Backup your data: Always keep copies of personal data in additional media such as compact discs, pen drives, etc. This could be helpful in situation when there is a loss of data. Keep the data away from unauthorized users.

Use encryption software: (Usually available within the operating system) to protect your data from unauthorized users. If encryption software is not available within the operating system, use a 3rd party software.

Keeping your username and password private: Never save your username or password on computers that are used in shared environments such as internet café. Browsers may save your personal data on the local computer that can be used by another user using the same computer.

Registering with websites: Read the privacy statement or policy whenever you register with a website, the statement or policy will include information about how the website use personal data.

Do not share personal information: Websites require you to fill out forms containing fields such as name, gender, age, email address, school, etc. Be cautious when filling out such forms; research and verify if it's a trustable website. Your email addressed could be used by unauthorized users to send you fake or unwanted emails; think twice or thrice before providing information to any website and decide if it is really necessary.

Secure transactions: If you are using online shopping or transactions, websites even store your credit card or online banking personal information such as your credit card number, account details, etc. This information can be tracked and used by un-authorized users often known as hackers to misuse this information. Again, ensure the website is legitimate and uses secure practices for performing and maintaining online transactions. Since information such as credit card details or personal information is sent over the network, it is always recommended to use only secure websites for such transactions. Verify if the website uses secure transaction; usually it is indicated through a digital certificate represented as a golden lock in the web browser’s address bar.
Use antivirus and antispyware software: Computers are prone to attacks from software known as Malware that could harm your computer. Malware track browsing behavior or transmit personal data from your computer; programs such as keyloggers could be installed on your computer track and transmit every key that is pressed on a keyboard (keystrokes) to unauthorized users. Antivirus and Antispyware programs also offer real-time protection monitoring your computer for any changes by malware software. Keep your Antivirus and Antispyware software always up to date, this can help in protecting your computer from recent threats.

Do not immediately respond to mails from unknown users: It may be a fake mail trying to gather personal information such as your bank account details, home address, etc. Some mails could promise you jobs or announce lottery results which in turn could compromise the user. And in some cases, virus or scripts that are dangerous could be attached to the mail; NEVER open the attachment from an unknown source.

Clear browser cookies frequently: Cookies are programs that are created on your local computer when you visit websites. Though cookies are meant for storing data based on your activity performed during your earlier visit such as logon details, details of a shopping cart, visited pages in a website, etc. they could also be tracked by unauthorized users and possibly gain access to your personal information.

Keep the operating system and software applications up to date, though operating systems and applications are designed, tested and distributed, sometimes they may have security holes through which a hacker can take advantage; they may track and gather information or even damage the whole computer. In general, most vendors notify the users whenever a security hole is identified and an update is available to address that particular issue. You can also visit respective vendor’s website to check if there are any updates available, download and keep your operating system and software applications up to date, free from security holes.

Install firewalls: Firewalls could be software or hardware and can assist in keeping a computer and a network secure. Firewalls analyze the network traffic and determine if the traffic should be allowed or not. In most cases, operating systems such as Linux, Windows or Mac include firewall software as a part of operating system thus keeping the computer secure. In rare cases, you may need to configure your firewall for additional security.

Never install software from unknown sources: As they might not be trustworthy; download only from well-known or reputed websites. Verify the source if it is legitimate by searching the internet or referring to comments from other users before downloading them; understand the nature and the purpose of the software before attempting to download and install them.

Remove unwanted or unknown software applications: These might have got installed without your knowledge when you have visited some websites. Unwanted software could get installed as they might have been bundled along with necessary software. Some programs such as toolbars get installed usually through bundled software and are programmed to send personal data without your consent.
Clearing Data Stored In Browsers

Web browsers have built-in password management designed to store passwords used in forms on websites. Browsers often prompt to save usernames and passwords when users attempt to logon to websites.

This facility is offered to users, so that they can logon to their frequently used websites without having to type the usernames or passwords. However it is not advisable to leave the web browser store this data particularly on public or shared computers.

To clear personal data from a web browser such as Mozilla Firefox, launch the browser.

- Click **Tools Menu, click Options.**
- Click **Security Tab.** The following window will be displayed:

![Figure 38](image)

Notice that under **Passwords** section, **Remember password for sites** is checked. This means the browser is configured to save passwords for websites automatically. You can uncheck **Remember password for sites** option, if you prefer NOT to store passwords.

Mozilla Firefox can also store data such as cookies, visited websites or webpages data, browsing history, etc. To clear this stored data, click **General tab > Option.** The following window will be displayed:

![Figure 39](image)
• Click **Privacy** Tab. The following window will be displayed:

![Figure 40](image)

Figure 40

• Under **History** section, click the drop down menu next to **Firefox will**:.

![Figure 41](image)

Figure 41

• Select **Use custom settings for history** from the drop down list. The following window will be displayed:

![Figure 42](image)

Figure 42
Notice the preferences; Firefox is configured to remember browsing and downloading history search and form history and cookies. If you do not wish store the above mentioned data, select **Never remember history** from the drop down list. If you are in a public environment such as a cyber café, you may select the option **Clear all current history**. On selecting this option, the following window will be displayed:

![Figure 43](image)

- Click **Clear Now** and then click **OK**. From now on, Mozilla Firefox will not remember any history as you have configured it that way.
- There are several online threats such as Phishing, email spoofing, chat spoofing, etc.
- You can reduce the risks by using best practices such as using Antivirus Software, Antispyware Software, Firewalls, strong passwords, etc. in addition to spreading awareness of the best practices.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>You have learnt to work with Mozilla Firefox. Now perform tasks outlined earlier using Mozilla Firefox with other browsers such as Internet Explorer, Google Chrome. Use the help file or online help to find procedures.</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Answer the following:

1. Explain the purpose of Internet Security.
2. Explain different kinds of online threats.
Unit 3: Word Processing (Intermediate)
CONTENTS

Unit 3: Word Processing (Intermediate)

SESSION 1: MODIFYING LAYOUT OF A PARAGRAPH .................................................. 119
SESSION 2: MANAGING HEADERS ............................................................................ 122
SESSION 3: MANAGING FOOTERS ......................................................................... 125
SESSION 4: MANAGING STYLES ............................................................................. 126
SESSION 5: DOCUMENT TEMPLATE ...................................................................... 128
SESSION 6: WORKING WITH PAGE AND SECTION BREAKS .................................... 131
SESSION 7: APPLYING CHARACTER FORMATS ..................................................... 133
SESSION 8: INSERT GRAPHICAL OBJECTS AND ILLUSTRATIONS ......................... 137
SESSION 9: TEXT WRAPPING ................................................................................ 140
SESSION 10: INSERTING OBJECTS ......................................................................... 143
SESSION 11: INSERT SHAPES, SYMBOLS AND SPECIAL CHARACTERS ............... 145
SESSION 1: MODIFYING LAYOUT OF A PARAGRAPH

Relevant Knowledge

You have already learnt the basics of word processing. Now consider a situation when you write a lengthy article that spans several pages, and you need to make it easier for the readers to read it? Look at the following example:

What is Culture and Gender Sensitization? Culture in simple terms refers to our values, the way we speak, behave, think, dress, religious beliefs, the music we like, our interactions, and the food we eat. Diversity is a commitment to recognizing and appreciating the variety of characteristics that make individuals unique in an atmosphere that promotes and celebrates individual and collective achievement. Many people mistakenly use such phrases as “Indian culture,” “white/black culture,” or “Western/Eastern culture,” to describe a particular culture but these people fail to acknowledge the presence of cultural diversity, or the presence of multiple cultures and cultural differences within a society. In reality, many different cultural groups exist today in India and most developing and developed countries. Diversity in the workforce means employing people without discrimination on the basis of gender, age and ethnic or racial background. Since globalization is the current overwhelming trend in business, diversity in the workplace is a better accepted and applied concept now more than ever. There are different kinds of diversity that one encounters at the workplace. These include diversity of gender, age, psychology, education, language and culture.

Is the content presented above easy to read? Now, look at the formatted sample below:

What is Culture and Gender Sensitization?

Culture in simple terms refers to our values, the way we speak, behave, think, dress, religious beliefs, the music we like, our interactions, and the food we eat. Diversity is a commitment to recognizing and appreciating the variety of characteristics that make individuals unique in an atmosphere that promotes and celebrates individual and collective achievement.

Many people mistakenly use such phrases as “Indian culture,” “white/black culture,” or “Western/Eastern culture,” to describe a particular culture but these people fail to acknowledge the presence of cultural diversity, or the presence of multiple cultures and cultural differences within a society. In reality, many different cultural groups exist today in India and most developing and developed countries.

Diversity in the workforce means employing people without discrimination on the basis of gender, age and ethnic or racial background. Since globalization is the current overwhelming trend in business, diversity in the workplace is a better accepted and applied concept now more than ever. There are different kinds of diversity that one encounters at the workplace. These include diversity of gender, age, psychology, education, language and culture.
Using paragraphs you can break continuous text to one or more sentences. This way, it is lot easier for the readers to understand and enjoy the content. In this exercise, you will learn to work with paragraphs and layouts.

Have you tried to make a professional looking resume? One important part of working with a resume involves alignment. For the sake of both professional appearance and accessibility, it is conventional for similar parts of a resume to all line up along the same vertical axis. So that all the bullet points are aligned, and so are the headers, and sections. You may come across situations where some bullet points don’t line up, or where there are many empty spaces that complicate editing and revising. So now what do you do?

1. Open a new document in word processor. Click on the Page Layout tab on the Ribbon.
2. Click on the icon under Paragraph group, as shown below.

3. The Paragraph dialog box appears. You can see the options for automatic alignment, spacing, etc. that you can setup while composing the document itself instead of doing the alignment towards the end.
4. Click on Tabs... button, Tabs dialog box appears.
5. You can specify the tab stop position by mentioning the stopping position in the Tab stop position box. After specifying the tab stop position click on Set button and the Tabs window appears.

   Note: You can also the set the initial tab stop position value from the default value (0.5”) by specifying the new value under Default tab stops. You may specify the value at which the tab stops by giving the value specified along with the unit (like 7cm, etc.)
6. Click OK. The ruler of the document will be marked with a L shaped symbol at 2”, meaning that the tab stop position has been set at that position. Now when you press the tab key, the cursor will automatically jump from its initial position to the next tab stop position. And this solves your problem too!
Note: You can also set the tab stop position by clicking at the required point on the ruler.

Now open a new document, type some text and press Enter. Notice that the continuous text is automatically formatted as paragraphs, with the size that you have specified in the Tabs Dialog box.

EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create the details given below (the tab descriptions are provided as a hint for you):</td>
</tr>
</tbody>
</table>
2 Create the one page of Table of Contents of this book using a word processor. Save this document with the name TOC_{your name}. You will use it in the next exercise.

ASSESSMENT

Fill in the blanks:
1. ______________ can be used to break continuous text to one or more sentences.
2. Paragraph group is available under ____________.
3. Default tab stop position is __________.

SESSION 2: MANAGING HEADERS

Headers are text or images included at the top of the page. They usually contain important information such as company or department name, logo, page numbers, name of the author, etc. separated from the work or actual document area.

Look at the following example:

Notice the header in the above document; the title “Application Form, June 2012” will be included on all pages of this document.

In this exercise, you will learn to include a header to a document.

To understand and work with headers, open a new document in word processor
1. Click on the **Insert** tab on the **Ribbon**.
2. Click on the option **Header** in the **Header & Footer** group, as shown below.

3. A drop down list appears which lists predefined header options (Figure below).

Now try inserting any of the predefined options from the list and observe the changes at the header area of the document.

You can insert the page number at any position within the header area by selecting the alignment option under **Page Number**. You can also change the number format for page numbers by clicking **Format Page Numbers...** under **Page Number** options. The **Page Number Format** dialog box appears as shown below.
You can insert date and time by clicking the **Date & Time** option available under **Insert** Group. You can choose the date and time format from the available formats.

You can also insert a picture or clipart within the header. This option can be useful in situations when you need to insert company’s or an event’s logo. Try inserting a picture or a clipart into the header using the **Picture** and **Clip Art** option under **Insert** Group; observe the changes made to the document.

**EXERCISE**

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Open the file saved in the last exercise (saved as TOC_{your name}). Give an appropriate name in the center of the header section with your School name on the left hand side. Download a logo from the Internet or use a picture (Insert&gt;Picture) on the right hand side. Save the file.</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. ___________ can be used for inserting information at the top of each page automatically.

2. Header option is available under ___________ group in Insert Tab.

**Answer the following:**

1. List any five items that can be added to the header area.
SESSION 3: MANAGING FOOTERS

Relevant Knowledge

Footers are text or image included at the bottom of the page and may repeat in all pages of the document. The procedure for creating a footer is similar to that of headers.

For example, if you wanted to create a text book, you can include the name of the text book using the headers and the page numbers using the footer option. This makes the document look neat and organized.

To insert footer to a document, open a new document in Word processor

1. Click on the Insert tab on the Ribbon.

2. Click on the option Footer in the Header & Footer group, as shown below.

3. A drop down list appears which lists collection of predefined Footer options

Now try inserting date and time, page numbers, pictures and clip arts in the footer area and observe the changes.

EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a one page article on “Influence of Gandhiji on Youth Today”. Insert a picture of Gandhiji and the title of the article in the header. Insert your name, class and date in the footer. Save as Gandhiji_{your Name}, print and submit this article to your facilitator for evaluation. You may try the same in Google docs too.</td>
</tr>
</tbody>
</table>
ASSESSMENT

Fill in the blanks

1. ______________ can be used for inserting information at the bottom of each page automatically.

2. The Footer option is available under ____________ group in the Insert Tab.

SESSION 4: MANAGING STYLES

Relevant Knowledge

Styles or Style sets are pre-defined or customized options used for creating good looking professional documents with least efforts. You can find a number of styles available within word processor that can be applied to a document. In this exercise, you will learn to apply and manage styles.

To work with styles, open a new word document in word processor,

1. To view list of styles, locate the Style group under Home tab (Figure below)

2. If you would like to view the list of style sets available, point to Style Set under Change Styles option. A drop-down with different styles will be displayed (Figure below).
Select any of the styles listed by clicking it. The entire document will change to the specified font or color automatically.

EXERCISE

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Open the article on “Influence of Gandhi ji on Youth Today” created in the previous session and try using elegant, formal, fancy and manuscript style sets on different sections of the document and observe the changes.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. _________ are customized options for creating professional looking documents with the minimum efforts.

2. You can change styles by using the _________ group under the Home tab.
SESSION 5: DOCUMENT TEMPLATE

Relevant Knowledge

Templates or document templates refer to a sample fill-in-the-blank document that can help in saving time. Usually templates are customized documents that may have sample content, themes, etc. For example, if you want to create a resume you can use a resume template and modify only the sections that require changes.

In this exercise, you will learn to work with document templates.

To view sample templates available with your word processor,

1. Go to File > New. You will be displayed with different types of templates (Figure below). For example, if you would like to create a letter, you can select the Letters option under Office.com Templates section.

Suppose you need to create certificates for a recently held competition, you can select the Certificates option. You will be displayed with a list of Certificate templates.

Figure 10

Now select any of the templates by double-clicking on it.

A sample certificate window similar to the one below appears. Now you can use this template and customize the contents by replacing the school name, student name, etc.
You can also download other types of templates from websites. Some of the websites that offer free templates are:

- office.microsoft.com/templates
- www.thepapermillstore.com
- openoffice.blogs.com/openoffice/templates/
- www.docstoc.com

You can visit the above mentioned websites to search, download and use a template that suits your needs.

Creating a new document based on a template can save you time and effort because all the work it takes to design the document has already been done. You may use the templates that come with word processing software, or downloading templates created by other people, or you can also create and save your own templates for future use. First of all, you need to create a document that will serve as the template.

**Note:** You create the template as a normal document, but the magic step is where you save it. Click on File > Save As, and give the template a name. Select Word Template from the Save as type: drop down list.

Notice that there is a Templates folder within Microsoft Word. If you save your template there, then we’ll be able to see the template in the My templates category. So select that and click Save.

Now to use the template, click on the File > New. Go to My templates, and as you scroll down, you will find the file {your name}_Invoice, the template you just created. Select that and click OK.

Notice that this is a new document and it’s not the template. So, we’ve just created a new document based on one of your own templates. Now when you save this document, it gets saved as a normal .docx file.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Download and use templates from the Internet</td>
</tr>
<tr>
<td>2.</td>
<td>You will now create a template of an invoice. An invoice is just the kind of document that needs to have a set format and one that will be created over and over again. Save the file with the name – {your name}_Invoice.</td>
</tr>
</tbody>
</table>

Hint on how to create an invoice: You can divide the invoice into 3 main parts: The Header, Body and Footer.

The invoice header may contain Your letterhead: (Your business name, address, telephone & email and web address if available); the word “Invoice” or “Bill” clearly written towards the top of the page; an invoice number (this a running serial number that you maintain and should be unique for every invoice); an invoice date; Your payment terms or how soon you expect to be paid e.g. “COD”, “Cash”, “30 days” etc.; your customer or client name and address; “Our Ref#” or “Our Reference” (here you can enter your quotation number if you issued a quotation prior to the invoice); “Your Ref#” or “Customer Ref” (if you were given a Purchase order or Work Order by your customer, here you should enter the PO or WO number so the customer can match your invoice with their own paperwork).

The invoice body could have a description of the goods you are supplying, quantity, unit of measure, price per unit and total amount for individual items. In the case of services, your brief scope of work and amount for individual items. You may specify information in a tabular form. You are creating a template, so you need to just create the skeleton, the details will be filled in when you use the template and make multiple invoices. The invoice footer could have a Total Amount of all individual items; Payment instructions (only if necessary! This tells recipients how to make their cheque payment, whom to address it to etc. If you expect payments by bank transfer, you should provide your bank account number and details here.); Other comments (delivery instructions, goods return policy, overdue payment policy etc).

ASSESSMENT

Fill in the blanks:
1. Templates or document templates refer to a __________________ document.
2. Creating a new document based on a __________ can save you __________ because ____________________________.
SESSION 6: WORKING WITH PAGE AND SECTION BREAKS

Relevant Knowledge

Page and Section breaks can be used to separate a document into sections.

If you would like to start a new page in a document, you can use a page break.

To separate a section in a document, you can use the section break. For example, you can lay out part of a single-column page as two columns. You can separate the chapters as separate sections in your document so that the page numbering for each chapter begins at 1. You can also create a different header or footer for a section of your document. For example, if you are creating a textbook and you can create different sections for digital literacy, word processing, spread sheets, etc.

To work with breaks, open a new document in the word processor and type some contents. If you need another fresh page, choose the page break option in the Page Layout tab.

a) Click on the Page Layout tab on the Ribbon.

b) Click on the option Breaks in the Page Setup group (Figure below).

c) A dropdown list with options for different types of breaks appears. An explanation is given for each type of page or section break.

A page break can be inserted anywhere in a document to force the end of a page and the beginning of a new one.

To create a new page, you can keep pressing enter and the cursor moves from line to line till a new page starts. But if you add content to the previous page, the content of the new page will automatically shift!

To avoid such problems, there is an easier method – use a page break and start a fresh page! You may also use a page break when you want to be sure that a new chapter or sub-heading automatically starts at the top of its own page.
Section breaks add flexibility to formatting your document. Using them, you can create different headers and footers, different footnote numbering, change the layout of columns, change page borders for different pages, and even change page layouts in the same document! Using section breaks is like having mini-documents in one large document.

A section break controls the formatting of the document content that precedes it, until it reaches another section break. For example, if you have a 10 page document, with a section break on page 3 and on page 8, the section break on page 3 controls the formatting of pages 1, 2, and 3 while the section break on page 8 controls the formatting for pages 4 to 8.

You need to be able to see where your section breaks or page breaks are inserted in order to see where the formatting stops and ends or to delete them. To see a section/page break, click the Show/Hide button on the Home tab in the Paragraph section. The section/page breaks are displayed in your document.

1. Click on the section/page break.
2. Press Delete on your keyboard and the section/page break is removed.

Anytime you need to add a page border to a single page or have a table in Landscape orientation with the rest of the document in Portrait orientation, try using section breaks to make the task easier!
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create Page and Section breaks</td>
</tr>
<tr>
<td>2.</td>
<td>Delete Page and Section breaks</td>
</tr>
<tr>
<td>3.</td>
<td>Open a new document. Divide your page into two columns. (Page Layout&gt;Columns). Pick up an article from a newspaper and key it in. Try using column break and page break anywhere in the text.</td>
</tr>
<tr>
<td>4.</td>
<td>Open a new document. Type in the heading of your Local newspaper. Use section break and divide the next section into columns and key in an article. Save the document file as Newspaper_{your name} and print your document.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks
1. ____________ & _________ breaks can be used to separate a document into sections.
2. Using page breaks, you can create different __________________________.
3. A section break controls the _________ of the document content that ________ it, until it reaches another section break.
4. To see a section/page break, click the _______ button.

SESSION 7: APPLYING CHARACTER FORMATS

Relevant Knowledge

If you are creating a textbook with scientific content, you need to use special formatting for some characters. Character formatting can be applied to a single character or word.

In this session, you will learn to perform character formatting.

Working with Character Formatting

To work with character formatting,
UNIT-3

a. Open a new document in word processor and type the following paragraph:

Water is a chemical substance with the chemical formula H$_2$O. A water molecule contains one oxygen and two hydrogen atoms connected by covalent bonds. Water is a liquid at ambient conditions, but it often co-exists on Earth with its solid state, ice, and gaseous state (water vapor or steam). Water also exists in a liquid crystal state near hydrophilic surfaces. The density of water is 1,000 kg/m$^3$.

Now to make changes, you may need to format the characters as shown below. You will notice that some words of this paragraph are in bold, some are in Italics, some are underlined, some are in colour and some are changed in its position (superscript & subscript).

b. In order to apply formatting to the contents in the document you must select the concerned word or group of words.

Use the following options to make changes to a character or word:

**Font Face:** After selecting the text you need to click Font Name in the Font group to select the particular font style from the fonts listed.

**Font Size:** After selecting the text you need to click Font Size in the Font group to select the particular font size from the values given.

**Grow Font:** After selecting the text you need to click the icon in the Font group to make the font size larger than the current font size by the specified point.

**Shrink Font:** After selecting the text you need to click the icon in the Font group to make the font size smaller than the current font size by the specified point.

**Strikethrough:** After selecting the text you need to click the icon in the Font group to make a strike through the middle of the selected text.

**Subscript:** After selecting the text you need to click the icon in the Font group to make the selected text lower than the normal text position.

**Superscript:** After selecting the text you need to click the icon in the Font group to make the selected text higher than the normal text position.
Clear Formatting: Clear Formatting is used to clear the character formatting (such as Bold, Italics, Underline, font face & size, superscript & subscript etc.) of the selected text. To remove the character formatting, select the text and click on icon in the Font group.

Text Highlight Colour: Use this option to change the background colour. To do so, select the text and click on icon in the Font group. You can choose the background colour by clicking on the down arrow on the icon.

Font Colour: Use this option to change the colour of the text. To do so, select the text and click on icon in the Font group. You can choose the text colour by clicking on the down arrow on the icon.

Change Case: Word processor helps us to change the text case to capital letters or small letters. You can also capitalize each word in the sentence and capitalize the starting word of the sentence using Change Case under Font Group. To do so, after selecting the text you need to click the icon in the Font group.

Sentence Case: On selecting this option from the dropdown list, the first character in the first word of the selected sentence will be converted to Capital Letter (Uppercase).

Lowercase: On selecting this option from the dropdown list, the selected text will be converted to Small Letters (lowercase).

UPPERCASE: On selecting this option from the dropdown list, the selected text will be converted to Capital Letters (UPPERCASE).

Capitalize Each Word: On selecting this option from the dropdown list, the first character in all the words of the selected sentence will be converted to Capital Letter (Uppercase).
**TOGGLE CASE:** On selecting this option from the dropdown list, the small letters in the selected text will be converted into capital letters and capital letters will be converted into small letters.

### EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Change font face</td>
</tr>
<tr>
<td>2.</td>
<td>Change font size</td>
</tr>
<tr>
<td>3.</td>
<td>Change font color</td>
</tr>
<tr>
<td>4.</td>
<td>Highlight text</td>
</tr>
<tr>
<td>5.</td>
<td>Change text case</td>
</tr>
<tr>
<td>6.</td>
<td>Reopen the document created in the previous exercise Newspaper_{your name}. Decorate the first page of your article using each one of the character formats you have learnt in this exercise. Take a printout of page 1 of the document and compare it with the printout taken in the previous session.</td>
</tr>
</tbody>
</table>

### ASSESSMENT

Fill in the blanks:

1. After selecting the text you need to click the ______ in the Font group to make the font size larger than the current font size.

2. To remove the character formatting, select the text and click on ______ in the Font group.

3. On selecting __________________________, the first character in the first word of the selected sentence will be converted to Capital Letter.

4. On selecting __________________________, the first character in all the words of the selected sentence will be converted to Capital Letter.
SESSION 8: INSERT GRAPHICAL OBJECTS AND ILLUSTRATIONS

Relevant Knowledge

Often when you write a technical report, or a newsletter or even letter to friends, including some form of graphics makes the document more interesting!

In a technical report, you may want to incorporate a graph of corporate performance or a technical illustration. While in a newsletter or letter to family and friends, you enjoy sharing memorable events that are represented by photos or maybe even cartoons. The facility to blend these graphics into the document is part of the charm and power of every major word processing program.

But not only can we blend graphic images into our message, but Word, WordPerfect and OpenOffice also allow us to blend in other special features. These features are generally known as “objects”. These objects can be almost any form that can be generated as a computer file. Sounds, Music, drawings, documents, spreadsheets, etc. are all examples of possible objects that you can include in a document, or link to a document.

Note: Embedding an object makes it part of the document while linking an object does not include the object file into the document file. Readers trying to access the linked object must also have direct access to the separate file that forms the object. That may mean they have to have access to your hard drive in order to see the linked object.

Most Word processors has support for inserting illustrations in the form of Clip Arts, Shapes, pictures, charts, etc.

Clip Art can help in making a document look colourful and presentable. Clip arts are pre-defined images available for use in documents. For example, if you would like to create a greeting card for your friend, you can use clip arts such as balloon, flowers, etc. along with text message.

You can use the clip art gallery built-in within the word processor; you can also download clipart from websites. Some of the websites that have free clip arts are:

- www.openclipart.org
- www.pdclipart.org
- www.clker.com
- www.freeclipartnow.com
- www.wpclipart.com

In this exercise, you will learn to use Clip Arts.

a) To insert a clip art in a document,

1. Open a new document in word processor
2. Click on the Insert tab on the Ribbon.
3. Click on the option Clip Art in the Illustrations group (Figure below).

![Figure 16](image1)

4. The Clip Art Task Pane appears. Enter the clipart category name in the search box and Click Go. For example, if you want to insert a logo, type logo in the search box and Click “Go”.

5. Once you click Go (Figure 17), a window appears along with list of clip arts matching the search keyword (Figure 18).

![Figure 17](image2)
Select the clipart that you want to use, double-click on it and it will be inserted into your document. Sometimes, you may need clip arts that may not be available within the word processor application. In such cases, you can visit websites that offer clip arts such as OpenClipart.org.

Now, you will learn to download a clip art from a website and use it in your document.

b) **To download a clip art from www.openclipart.org,**

1. Open the web browser, Type www.openclipart.org in the address bar and press Enter.

You can use the search box available on the website for viewing the list of clip arts to suit your needs. For example, Type School Bag in the search box and Click Search.

You will be displayed with list of clip arts matching the keyword School bag, similar to the one below.

Now you can select the clip art you like, download it to your computer and insert it using the photo option in the word processor.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Insert pictures and Clip art in a document</td>
</tr>
<tr>
<td>2.</td>
<td>Open a new document. Search for “Birthday Balloons” in Clip Art. Select one from what is made available and make a one page birthday card for a family member</td>
</tr>
<tr>
<td>3.</td>
<td>Download a few clip arts from the net and design a poster on Earth Day. In this exercise, you will only insert the appropriate pictures. You will insert relevant text in the next exercise.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. Embedding an object ___________ the document while linking an object does ___________ into the document files.
2. Readers trying to access the linked object must also have ___________ file that forms that object.
3. Clip Art can help in making a document look ___________ and ___________.
4. Clip Art is available under ___________ Illustrations group in Insert Tab

Answer the following:

1. List any two websites that offers free clip arts.
2. What are Objects in a Word processing software?

SESSION 9: TEXT WRAPPING

Relevant Knowledge

You have learnt to insert graphics and illustrations in the last exercise. How do you want the text to fit to the picture? Do you want a graphics to stand alone with text above it and below it? Do you want the text to be along one side of the graphics? Do you want to have the text message split so that part of the text is on the left side and then continue on the right side of the graphics? Do you want the text to run right across the graphics? All these options are possible depending on the text wrap options you choose.
What if the graphic image is too large, or too small? This is a problem you may face when placing graphic images into a document. In all word processing software, if you select the image (left mouse click on it) control handles will appear on the sides and on the corners of the graphics. When you place your mouse on these handles, the cursor changes to a double headed arrow and you can click and drag the handle in or out to decrease or increase the size of the picture. In this exercise, you will learn to use text wrapping.

Open a new word document and type the following:

Apache OpenOffice Writer is the word processor component of the OpenOffice package. It is free and is available for a variety of Operating Systems including Windows, Linux, FreeBSD and Solaris. It is capable of opening and saving documents in a variety of formats.

You can either include a screenshot of the OpenOffice Writer or search for a picture in your computer.

To take a screen shot, simultaneously press <Shift> and <Print Screen> keys. Place the cursor on the right of the text and simultaneously press <Ctrl> and <V> keys.

To search for a picture, place the cursor before the text, click Insert Tab, and click Picture under Illustrations. Browse for the picture and click Insert.

• Once you have inserted the picture, you can wrap the text by using the Wrap Text option under Text section of the Insert Tab after double-clicking on the picture (Figure below). If you
are working on Word, select the picture then select the \textit{Text Wrapping} dropdown arrow in the \textit{Arrange} group under the \textit{Format} tab.

![Figure 21](image)

Now try selecting different Wrap Text options such as \textit{Square, Tight, Through, etc.} and observe the changes made to the wrapping. A screen shot when the \textit{Square} option was used is shown below:

![Figure 22](image)
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Wrap text around a picture</td>
</tr>
<tr>
<td>2.</td>
<td>Reopen the document you had created in Exercise 1, Gandhiji_{your Name}. Search for an appropriate picture of Gandhiji and try all the Text wrapping options. Select the one you feel suits the best and take a printout of your modified article. Save your document with a different name Gandhiji2_{your Name}.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. To search for a picture, place the cursor _______ the text, click Insert Tab, and click _______ under Illustrations.

2. After you have inserted the picture, you can wrap the text by using the _______ option.

Answer the following:

1. List any three word wrapping options available in a word processing software.

SESSION 10: INSERTING OBJECTS

Relevant Knowledge

In addition to graphic images, to add a personal touch to a special message or to illustrate a special feature, you may want to embed sound files or maybe even actual files from other software applications in your document. For example, you can insert a PDF file or a spread sheet within the word processor.

In this exercise, you will learn about inserting objects in a document.

To insert an object,

• Open a new word document
• Select Insert Tab
• Click Object under Text section. A dialog box will be displayed, as shown in figure 23.
• Select Create from File Tab
• Click Browse and select a file such as a spread sheet or a PDF document that is available on your computer, Click Open and Click OK
• Notice the document is available embedded within your word document.

Note: If you would like to edit the embedded document, double-click on it. It will automatically open it for editing using respective application.

Now try inserting different types of document using the procedure mentioned above.

Note: 1. The embedded objects cannot be printed.
2. The person opening your document must have the relevant software loaded on their computer to operate the embedded file.
3. If you embed an object, the size of your document increases significantly and this may cause problems in emailing the document as an attachment.
4. If you link an object, the person opening that document must have a direct connection to the original file location of the object.

EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Insert objects in the text</td>
</tr>
</tbody>
</table>
ASSESSMENT

Fill in the blanks:

1. To open an embedded document, ___________ it.
2. Embedded objects _____ be printed.
3. When you embed objects in a document, you may have trouble emailing it because ___________.

SESSION 11: INSERT SHAPES, SYMBOLS AND SPECIAL CHARACTERS

Relevant Knowledge

You can insert objects that have different shapes such as lines, basic geometric shapes, arrows, equation shapes, flowchart shapes, stars, banners, and callouts using the shape option.

In this exercise, you will learn to work with shapes in a word document.

a) To work with shapes, open a new document in word processor,

1. Click on the Insert tab on the Ribbon.
2. Click on the option Shapes in the Illustrations group, as shown in figure 24.

3. Once you click the Shapes option a dropdown list with pre-defined shape such as box, circle, etc. appears.

4. You can select the shape from the list of shapes available and draw the shape by dragging the mouse with the left button clicked. For example, if would like to insert a square, select the box shaped item from the list, click and drag the shape to draw a square.
Now try inserting other shapes from the list available and work with them by changing colors or adding content inside them.

In some cases, you may need to insert special characters or symbols in documents such as currency sign of a different country, copyright or trademark symbols, etc. In this exercise, you will learn to insert symbols or special characters.

b) **To work with symbols or special characters**, open a new document in word processor.
1. Click on the **Insert** tab on the Ribbon.
2. Click on the option **Symbol** in the **Symbols** group, as shown in figure 25.

![Figure 25](image.png)

3. A dropdown list appears (figure 26).

![Figure 26](image.png)

Select a symbol from the list and double-click on to insert the symbol into the document.

If you would like to view more symbols and special characters for inserting into a document, click on the **More Symbols...** option in the **Symbols** Dropdown list.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Use different shapes, symbols and special characters in a document.</td>
</tr>
<tr>
<td>2.</td>
<td>Create a two page brochure for Nainital or any other tourist spot near your town. The brochure must include pictures. Wrap the text around the pictures. It must also include places to see, hotels to stay in and details of how to reach the place.</td>
</tr>
<tr>
<td>3.</td>
<td>Open a new document. Create the basic flowchart diagram as shown below</td>
</tr>
</tbody>
</table>

![Flowchart Diagram](image)

Figure 27

ASSESSMENT

Fill in the blanks:

1. You can insert lines, basic geometric shapes, arrows, equation shapes, flowchart shapes, stars, banners, and callouts using the ___________ option.

2. Symbol option is available under ________________ group in the Insert tab.
Unit 4: Spreadsheet (Intermediate)
CONTENTS

Unit 4: Spreadsheet (Intermediate)

SESSION 1: USE AUTOSUM IN CELLS ................................................................. 150
SESSION 2: CONDITIONAL FORMATTING ........................................................ 152
SESSION 3: HIDE / UNHIDE / FREEZE ROWS AND COLUMNS ......................... 156
SESSION 4: SET PAGE BREAKS ........................................................................... 158
SESSION 5: SET PAGE LAYOUT .......................................................................... 161
SESSION 6: MANAGE WORKBOOK VIEWS ....................................................... 163
SESSION 7: APPLY CELL AND RANGE NAMES ............................................... 165
SESSION 8: CREATE MODIFY AND FORMAT CHARTS ..................................... 168
SESSION 9: SORT AND FILTER DATA .............................................................. 171
SESSION 10: CALCULATE DATA ACROSS WORKSHEETS .............................. 175
SESSION 11: USING MULTIPLE WORKBOOKS AND LINKING CELLS ............. 177
SESSION 12: SHARING WORKSHEET DATA ................................................. 179
SESSION 1: USE AUTOSUM IN CELLS

Relevant Knowledge

You have learnt to navigate in a spreadsheet, populate cells, and perform calculations. As you know, a spreadsheet offers various mathematical functions to perform the calculations. Sum is one of the functions available in the spreadsheet to perform addition of selected numbers in the sheet. In this exercise, you will learn how to use autosum function to perform addition in a spreadsheet.

Autosum is used for adding the values given in cells automatically without writing the formula to perform the operation.

Open a new spreadsheet and enter the following data.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S.No</td>
<td>Name</td>
<td>English</td>
<td>Hindi</td>
<td>Maths</td>
<td>Science</td>
<td>Total</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Abhas</td>
<td>86</td>
<td>79</td>
<td>92</td>
<td>91</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>Anita</td>
<td>90</td>
<td>84</td>
<td>94</td>
<td>85</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>Raja</td>
<td>75</td>
<td>85</td>
<td>91</td>
<td>98</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>Subbu</td>
<td>78</td>
<td>89</td>
<td>91</td>
<td>77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td>Priya</td>
<td>94</td>
<td>93</td>
<td>100</td>
<td>87</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 1

Now to total the marks of each of the students, do the following:

• Go to cell G2. While the cell G2 is selected, click on the AutoSum option available under Editing Group in the Home tab.

Figure 2

• The values in the cells from c2 to f2 will be automatically selected as shown below.
• Press **Enter**.
  
  o The total marks of Abhas appears in cell G3.
  
  o Similarly, calculate the total marks of the rest of the students.

Note: Autosum automatically selects the values around the cells either horizontally or vertically. In the above example you want to perform addition of numbers listed from left to right, after finding the total of two persons when you try to perform autosum for another person the values on top of the current cell get selected. In that case, you have to select the cell values that you want to perform addition.

Now change the marks of one of the students in one or more subjects. The total marks of that student will get calculated automatically. **Automatic calculation** of formulas is one of the most powerful features of electronic spreadsheets.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Calculate without writing the formulae using the Autosum function</td>
</tr>
<tr>
<td>2.</td>
<td>Create a list of all your personal expenses made during the month and calculate the total expenses using the autosum function</td>
</tr>
<tr>
<td>3.</td>
<td>Create a list of names of the month and holidays in that month. Add and calculate the total number of holidays in a year using the autosum function</td>
</tr>
</tbody>
</table>
ASSESSMENT

Fill in the blanks:

1. _____________________________of formulas is one of the most powerful features of electronic spreadsheets.

2. ________________ is used for adding the values given in cells automatically without writing the formula.

3. AutoSum option is available in _________________ group under the Home tab.

4. Autosum automatically selects the values around the cells either _____________ or ______________.

SESSION 2: CONDITIONAL FORMATTING

Relevant Knowledge

Conditional formatting allows you to change the formatting (font color, border, shading) of the cells based on the values in it. Yes, you can do that manually, but it can be a tiresome task if you have a huge amount of data. So, you specify a condition for the values in the cell, and if the condition is satisfied then automatically the formatting of the cell changes. This feature would be very useful if you were working on a profit and loss spreadsheet, or a temperature variance spreadsheet, or a marksheet. You could highlight cells that have values are greater than a defined rule with one color and those less than another with a different color.

Basically, you can select one or more cells, and create rules (conditions) for when and how those cells are formatted. The conditions can be, based on the selected cell’s contents, or based on the contents of another cell.

You can control the following formats:

- Number format
- Font, font style, and font colour (but not font size)
- Fill colour and fill pattern
- Border colour and border style (but not border thickness)
Open a new spreadsheet and enter the following data.

![Figure 5](image)

Now to apply conditional formatting for the data do the following.

- Select all the cells you want to format conditionally.

![Figure 6](image)

- Click on **Conditional Formatting** option available under **Styles** group in the **Home** tab. A drop down list appears.

![Figure 7](image)

Click on **Highlight Cells Rules option**, a submenu appears.

- **Note:** you can select the condition listed according to your needs. In this example if you want to highlight the values that are greater than 75, select “Greater Than...” available under the
submenu. A dialog box appears.

![Figure 8](image)

- Specify the value in the box and click on the down arrow next to the with field and select a predefined format for the condition from the drop down list. If you want to highlight the cell contents with your own formatting style click **Custom Format** option in the dropdown list.
- A **Format Cells** dialog box appears. You can select a different font color under Font tab, border style and color under Border tab and fill color under Fill tab.
- Go ahead and create the data below and format it in the manner displayed.

![Figure 9](image)

**Note:** Similarly you can set various conditions for the selected value like less than, equal to, between etc.

Optionally, you can also specify the cell address where the value is stored. This can be very helpful as simply changing the value in one place can change the conditional formatting all over the previously selected range. An example is shown in the figure below.

![Figure 10](image)
The result is displayed below.

![Figure 11]

EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Perform conditional formatting on a data subset</td>
</tr>
<tr>
<td>2.</td>
<td>Create a student mark list of at least 10 students and five subjects. Highlight the marks of the students who got marks greater than 80 with green colored text with blue fill. Save the worksheet as Marks_{your name}.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. _______________conditional formatting allows you to change the formatting (font color, border, shading) of the cells based on the values in it.

2. Conditional formatting is available under _______________ Styles group in Home tab.

Answer the following:

1. List any five conditions/formats/items that can be used for conditional formatting.
SESSION 3: HIDE / UNHIDE / FREEZE ROWS AND COLUMNS

Relevant Knowledge

Sometimes you have data in rows and columns which are needed for formulas or charts, but you do not want the data to be visible. A very handy feature of a spreadsheet is the ability to hide a row/column that is not to be shown to the end user. The data in hidden row/column is available for calculations though not visible!

Freezing rows and columns is another helpful feature in a spreadsheet. When you are dealing with a huge amount of data that spans several rows or columns, you may want the headers to remain constant (frozen) while you scroll through the data so that you can see the identifying names of the rows/columns.

Open a new spreadsheet. To hide a row or column, do the following:

• In order to hide any row or column you can either select the particular row or column that is to hidden or just one cell in the corresponding row or column (for example B3).
• Click on **Format** option available under **Cells** group in the **Home** tab.

![Format option](image1)

![Dropdown list](image2)
• Click on **Hide & Unhide > Hide Rows**. The spread sheet will be displayed as shown below.

**Note:** Alternatively, you can select the row/column, right click and select **Hide**.

![Figure 14](image1.png)

**Note:** In this example the cell in the 3rd row of the spread sheet was selected and then Hide Rows option was selected. So, the 3rd row is hidden. What would have happened if you had selected **Hide Columns** instead?

• In order to unhide the row or column that is hidden you have to select any cells before and after the cell that is hidden then click **Unhide Rows** in the **Format** option available under **Home** tab.

**To freeze the rows or columns do the following.**

• Open a new spread sheet.

• In order to freeze rows or columns click on **Freeze Panes** option available under **Window** group in **View** tab.

• A drop down list appears as shown below. Click on Freeze Panes. Doing so will freeze all the rows above and all the columns to the left of the selected cell. Scroll your mouse in the spreadsheet the frozen rows and columns remain constant.

![Figure 15](image2.png)

**Note:** The panes are formed where your cursor is placed. Select the option again and notice the change in the available options! Go ahead and try the other options too. You can also freeze the entire row or column by selecting the entire row or column and click “Freeze Panes” to freeze the entire row or column.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Hide/unhide rows/columns</td>
</tr>
<tr>
<td>2.</td>
<td>Freeze/unfreeze rows/columns</td>
</tr>
</tbody>
</table>
| 3.    | Create the worksheet given below, keeping your cursor on B2, try all the options of freezing cells and observe the effect. Take specific note of column and row movements. Save the worksheet as expenses_{your name}.

ASSESSMENT

Fill in the blanks:

1. When you freeze a row, ___________ remains constant.
2. Freeze Panes option is available under ________ group in ________ tab.
3. The panes are formed where your ___________ is placed.

SESSION 4: SET PAGE BREAKS

Relevant Knowledge

To print a worksheet with the exact number of pages that you want, you can adjust the page breaks in the worksheet before printing it. This feature is very useful especially when printing huge sheets. You can use the Page Break view to see how other changes (e.g. changing row height / column width) affect the automatic page breaks.
In this exercise you will learn how to set page breaks in the spreadsheet.

Open a new spreadsheet and create the sheet below. On the View tab, in the Workbook Views group, click Page Break Preview.

![Application Form](image)

**Figure 16**

Now to set the page break do the following.

- To insert a vertical page break, select the row below where you want to insert the page break. To insert a horizontal page break, select the column to the right of where you want to insert the page break.

- Click on **Breaks** down arrow under **Page Setup** group in the **Page Layout** tab. A dropdown appears as shown below.

![Breaks dropdown](image)

**Figure 17**

- Click on **Insert Page Break** option. The spreadsheet will be displayed as shown below. The content you have typed comes in the first page and you can print it.

- To move a page break, simply drag the page break to the desired location.
Note: You can also remove the page breaks by clicking the Remove Page Break option in Breaks drop down list.

To return to Normal view after you finish working with the page breaks, click Normal in the Workbook Views group under the View tab.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Set, move and delete page breaks</td>
</tr>
<tr>
<td>2.</td>
<td>Create the worksheet given below. Calculate the closing balance. Add 10 more items to the list and set page breaks for printing. Move page breaks if contents do not fit onto one page. Save this file to be used in the following exercise with the name items_{your name}.</td>
</tr>
</tbody>
</table>
ASSESSMENT

Fill in the blanks

1. To insert a _________ page break, select the row below where you want to insert the page break.

2. To insert a ____________ page break, select the column to the right of where you want to insert the page break.

3. The Breaks option is available under______________ group in the Page Layout tab.

4. To return to Normal view after you finish working with the page breaks, you need to click _____________ in the _____________ group under the View tab.

SESSION 5: SET PAGE LAYOUT

Relevant Knowledge

If you have a worksheet that contains a huge amount of data with many charts and you want a professional looking printout, what would you do? Spread sheet software provides various page layout options for organizing pages using the Page Layout option. In this exercise, you will learn how to set the page layout options in the spread sheet application. Open a new spread sheet.

To set the page layout options, do the following:

• Click on Page Layout option under Workbook Views group on View tab. The spreadsheet will be displayed as shown below. You can set the
  • Margins
  • Orientation
  • Page headers and footers
  • Hide or display grid lines
  • Size of the page
  • Define the print area
  • Specify the background

Figure 19
Click on **Margins** option under **Page Setup** group, a dropdown list appears as shown in figure 20.

![Figure 20](image)

You can either select anyone of the predefined margin option available or else you can define your own margin settings by clicking **Custom Margins** option. A dialog box appears.

![Figure 21](image)

You can set the margin values manually from the options available under the dialog box.

You can set the orientation of the page to either Portrait or Landscape by clicking the **Orientation** option under **Page Setup** group in the **Page Layout** tab.

You can set the size of the page by clicking the **Size** option under **Page Setup** group in the **Page Layout** tab.

You can specify the area to be printed by selecting the area and then clicking **Print Area** option under **Page Setup** group in the **Page Layout** tab. A drop down list appears as shown below.

![Figure 22](image)

Click on **Set Print Area** to set the selected to get printed. You can also clear the print area by clicking the **Clear Print Area** option.
• You can specify a background for your sheet using the **Background** option under **Page Setup** in the **Page Layout** tab.

**EXERCISE**

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Reopen the worksheet created in the previous exercise named items_{your name}. Modify the margins, view the document using print preview and observe the changes</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. Spread sheet software provides various page layout options for organizing pages using the ____________ View.

2. Margins option is available under__________ group in the ____________ tab.

3. Two types of page orientation are ________________ & ________________.

**SESSION 6: MANAGE WORKBOOK VIEWS**

**Relevant Knowledge**

Spread sheet offers the users with variable views for the purpose of viewing the outcome of the sheet while printing.

There are five types of views available in the spreadsheet.

- Normal
- Page Layout
- Page Break Preview
- Custom Views
- Full Screen

You can select one of the above said views by clicking the appropriate option under Workbook Views in the View tab.
Normal View: The default view of the spreadsheet application is the Normal. It’s a collection of cells arranged in the work area.

Page Layout: You can select the Page Layout view in order to quickly fine tune a worksheet that contains many charts or huge amounts of data and achieve professional looking results.

Page Break Preview: This option is similar to the Page Layout option except you can set the area that is to be set as a page after inserting page break.

Custom Views: If you would like to view selected areas of a document, you can use the custom view option. For example, if you would like to point out certain row and column, you can add that to the Custom view.

Full Screen: Selecting this option makes the workbook cover the entire screen. All tabs are hidden from view. To get back the tabs, click on File> Restore.

Additionally, in spreadsheet, you can open multiple windows that display the current spreadsheet and then arrange those windows in a variety of ways. You can also open and arrange multiple workbook windows.

To open a second instance of a workbook in a separate window:

- Click the New Window button on the View tab, in the Window group.

To arrange multiple program windows:

- Click Arrange All button in the Window group. An Arrange Windows dialog box appears.
- Click either Tiled, Horizontal, Vertical, or Cascade options.
- To include only windows displaying views of the current workbook, select the Windows of active workbook check box.
- Click OK.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Reopen the worksheets created in the exercises SS 2 named Marks_{your name}, SS3 named expenses_{your name} and SS 4 named items_{your name} Using the commands in the Window group on the View menu, tile the three windows, and then arrange them so that they overlap. Move each window separately and observe what happens in the others. Try the Cascade and Tile options too</td>
</tr>
<tr>
<td>2.</td>
<td>Use the New Window command to open a second instance of one of the workbooks. Then arrange only the two windows of the active workbook horizontally</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. Different types of views are available under _______________ in the View tab.
2. The five types of views available are ______ , ______ , __________, __________ & _________________.
3. The ________________ helps you to view a selected area of a workbook.

SESSION 7: APPLY CELL AND RANGE NAMES

Relevant Knowledge

You can assign names to cells in a worksheet and use it for quickly locating specific cells by entering the names. This could be useful when working with large spread sheets. For example, if you have a lengthy list of groceries and prices, you can use names to quickly locate and find total pricing of fruits from the entire list.

In this exercise, you will learn to work with cell and range names.

Open a new spreadsheet and enter the following (figure below):
Now to apply range names, do the following:

- Select the cost against the cells that have Apple, Banana, Cherry, Grape, Guava, Mango, Pineapple values (Keep the Ctrl key pressed and click on the cells – you will be able to select selective cells together!). Right click and select Name a Range.... Alternatively, you can select Define Name under Defines Names group in the Formulas tab.
- A New Name dialog box appears prompting to enter a name. Enter Fruits in the Name field and click OK (figure below).
• Select the cost against the cells that have *Cabbage, Cauliflower, Chilli, Cucumber, Ginger, Potato, Pumpkin, Spinach, Tomato* values. Right click define the name **Vegetables** for this group.

![Figure 27](image)

If you would like to calculate the total cost of fruits from the list,
• Select an empty cell
• Type Total Cost of Fruits and in the adjacent cell, Type `=SUM(Fruits)` and press **Enter**.

Notice the total cost of all items named as Fruits is displayed.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Apply names to cells and cell ranges and use them in formulae</td>
</tr>
<tr>
<td>2.</td>
<td>Using the worksheet created in this exercise, calculate the cost of Vegetables. Save the workbook as <em>Grocery_{your name}</em></td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. Assigning names to cells in a worksheet help you to ________________ specific cells.

2. The Define Name option is available under ________________ group in the ______ tab.
SESSION 8: CREATE MODIFY AND FORMAT CHARTS

Relevant Knowledge

A chart is a graphical representation of data, in which the data is represented by symbols, such as bars in a bar chart, lines in a line chart, or slices in a pie chart. A chart can represent tabular numeric data, functions or some kinds of qualitative structures.

A Spread sheet enables you to create, modify and format charts based on the data given in the spread sheet. In this exercise you will learn how to create, modify and format chart using the spreadsheet.

Reopen the worksheet expenses_{your name}.

Now to create charts do the following.

- Select all the expenses data.
- Click on the chart type that you want from Charts group under the Insert tab.
- After selecting the chart type the spread sheet will be displayed as shown below.
You can modify the chart values by making necessary modifications in the data table.

Chart has many elements; however, only some of the elements are displayed by default. Following is an description of the elements used in the above chart:

1. **Chart Area** of the Chart
2. **Plot Area** of the Chart
3. **Data Points** that are plotted in the chart
4. **Horizontal and Vertical** Axis in the chart
5. **Legend** of the chart
6. **Chart and Axis Title** used in the chart
7. **Data Label** for identifying details of data point in the chart

**Note:** Once you insert a chart in the spreadsheet three additional tabs are available on the Ribbon namely **Design, Layout** and **Format**. You can edit the chart, its design, layout and formatting options using the three tabs available. You can change the chart type, chart options etc. in the Design tab and can give the titles etc. in the Layout tab and set the borders, colors and size of the option under Format tab.
Chart Types:

Choosing the right type of chart is very important. Different charts display data in very different ways. Using the best chart type and format helps you to display data visually in the most meaningful way.

**Bar charts:** A bar chart (horizontal bars) emphasizes the comparison between items at a fixed period of time. This chart type also includes cylinder, cone, and pyramid subtypes.

**Column charts:** A column chart, unlike a bar chart to which it is often compared, emphasizes variation over a period of time. This chart type also includes cylinder, cone, and pyramid subtypes.

**Line charts:** A line chart shows the relationship of the changes in the data over a period of time.

**Pie charts:** Pie charts contain just one chart data series. A pie chart shows the relationship of the parts to the whole.

**Area charts:** An area chart shows the relative importance of values over time.

**XY (Scatter) charts:** Scatter charts are useful for showing a correlation among the data points that may not be easy to see from data alone.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a chart</td>
</tr>
<tr>
<td>2.</td>
<td>Create a worksheet using the sales data given below:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Location</th>
<th>January</th>
<th>April</th>
<th>July</th>
<th>October</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acapulco</td>
<td>10</td>
<td>5</td>
<td>208</td>
<td>145</td>
</tr>
<tr>
<td>Amsterdam</td>
<td>69</td>
<td>53</td>
<td>76</td>
<td>74</td>
</tr>
<tr>
<td>Anchorage</td>
<td>17</td>
<td>13</td>
<td>42.5</td>
<td>52</td>
</tr>
<tr>
<td>Dallas</td>
<td>48</td>
<td>87.5</td>
<td>62</td>
<td>118</td>
</tr>
<tr>
<td>Glasgow</td>
<td>110</td>
<td>50</td>
<td>61</td>
<td>112</td>
</tr>
<tr>
<td>Madrid</td>
<td>39</td>
<td>48</td>
<td>11</td>
<td>53</td>
</tr>
<tr>
<td>New York</td>
<td>99</td>
<td>100</td>
<td>115</td>
<td>86</td>
</tr>
<tr>
<td>Tokyo</td>
<td>101</td>
<td>121</td>
<td>189</td>
<td>172</td>
</tr>
<tr>
<td>Toronto</td>
<td>55.2</td>
<td>65.4</td>
<td>71</td>
<td>63.5</td>
</tr>
</tbody>
</table>
3. Create bar and line charts using this data. Enhance the design of your chart to make it more presentable.

4. Calculate the total sales for each city. Create a pie chart representing the total sales of each city.

### ASSESSMENT

**I. Fill in the blanks:**

1. A chart is a ______________ ______________ of data, in which the data is represented by symbols, such as ____ in a bar chart, _____ in a line chart, or ______ in a pie chart.

2. The three tabs that are available after inserting the chart in the spreadsheet are ___________ , _________________ & _______ ________________.

**II. Answer the following:**

1. List seven chart elements.

2. List five chart types available in spreadsheet.

### SESSION 9: SORT AND FILTER DATA

**Relevant Knowledge**

Sort is a feature that helps you arrange the selected data either in an ascending or descending order. Filter is a feature used for extracting particular data using some conditions. Spread sheet offers both these features for sorting and filtering data in the spreadsheet.

Open a new spreadsheet and enter the following data:

![Figure 32](image)

**Now to sort or filter the data do the following:**
• Select the data to be sorted and then click on **Sort** option under **Sort & Filter** group in the **Data** tab. A dialog box appears as shown below.

![Figure 33](image)

**Figure 33**

• You need to specify on what basis you are going to sort the data in the **Sort by** field and select the order that is ascending and descending and then click **OK**. For example, if you wanted to sort the data in Sales 2008, you would select the relevant detail in the Sort by list and click OK. The spreadsheet would be displayed as shown below. You can notice that the data has been sorted as per the data in 2008 and also that values in the Sales 2008 field are arranged in ascending order that is from smallest to largest.

![Figure 34](image)

**Figure 34**

To filter data, do the following:

• Click the **Filter** option available under **Sort & Filter** group in the **Data** tab. Before applying a filter you have to select the data along with the header as shown below.

![Figure 35](image)

**Figure 35**

• Once you click on filter, the headers will be displayed with a down arrow as shown below.

![Figure 36](image)

**Figure 36**
If you want to filter data that is greater than 75 in the Sales 2009 do the following.

• Click the down arrow available under Sales 2009 header, a dropdown list appears as shown below.

![Figure 37]

• You can specify the filter by selecting the available values in the list.
• You can also sort the filtered data by selecting Sort Smallest to Largest or Sort Largest to Smallest option available in the dropdown list.
• Click on Number Filters option under the dropdown list, once you click the following submenu appears.

![Figure 38]

• Here you can select the condition that you want to specify for the data in the list, If you select Greater Than.. option the following dialog box appears.
• Specify the value that you want in the value box, (here it is 75) and click OK. The spreadsheet will be displayed as shown below. Notice that only data greater than 75 is displayed under the Sales 2009.

![Image of spreadsheet](image)

**Figure 39**

**Figure 40**

### EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Sort a dataset in the required order</td>
</tr>
<tr>
<td>2.</td>
<td>Filter data on specified criteria</td>
</tr>
</tbody>
</table>
| 3.    | Create a worksheet with the data given below. Create totals. Calculate percentages. Use this to sort data subject wise and also rank-wise. Save this file as Student_{your name}.

<table>
<thead>
<tr>
<th>Students</th>
<th>Test 1</th>
<th>Test 2</th>
<th>Test 3</th>
<th>Test 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shilpa</td>
<td>50</td>
<td>65</td>
<td>57</td>
<td>77</td>
</tr>
<tr>
<td>Sheela</td>
<td>98</td>
<td>99</td>
<td>78</td>
<td>58</td>
</tr>
<tr>
<td>Avikal</td>
<td>76</td>
<td>78</td>
<td>98</td>
<td>96</td>
</tr>
<tr>
<td>Vaibhav</td>
<td>87</td>
<td>76</td>
<td>92</td>
<td>67</td>
</tr>
<tr>
<td>Abhijeet</td>
<td>56</td>
<td>88</td>
<td>66</td>
<td>88</td>
</tr>
<tr>
<td>Surbhi</td>
<td>68</td>
<td>85</td>
<td>92</td>
<td>99</td>
</tr>
<tr>
<td>Kavita</td>
<td>99</td>
<td>58</td>
<td>78</td>
<td>89</td>
</tr>
<tr>
<td>Tanishk</td>
<td>79</td>
<td>78</td>
<td>56</td>
<td>78</td>
</tr>
<tr>
<td>Vishwank</td>
<td>59</td>
<td>81</td>
<td>78</td>
<td>67</td>
</tr>
</tbody>
</table>
ASSESSMENT

Fill in the blanks:

1. Sort helps you arrange the selected data either in an__________ or __________ order.
2. Using filter you can extract data based on ________.
3. Sort option is available in _______________________ group under the Data tab.
4. Filter option is available in _______________________ group under the Data tab.

SESSION 10: CALCULATE DATA ACROSS WORKSHEETS

Relevant Knowledge

Suppose you were working at the head office maintaining had data for six regions, and you use exactly the same worksheet layout and labels to track the average sales of each region over the previous quarter. Each sheet contains headings by region (such as Region01, Region02 ..... Region06), and in cell H15 on each sheet, the calculated total sales for the quarter appear. If you want to obtain the average sales over the quarter, what would you do?

In this exercise you will learn how to perform calculations on data across different worksheets.

Open a new spreadsheet. Name sheet 1 as year 1 and type the following data.

![Figure 41](image-url)
Now to calculate the data across worksheets do the following.

- Go to sheet 2, name it year 2 sheet, and insert the same data in the Sheet 2 for the next year.

- Go to sheet 2, name it Totals, and insert the same labels.

- Type the sum formula in cell B2, =SUM(, while the parenthesis is opened go to year 1 sheet and go to year 2 sheet and press Enter. Repeat the same step to calculate sum for other expenses. Note the way the range is specified (sheetname!cellnumber).

![Figure 42](image)

To answer the question raised earlier, you could create a new sheet, called Quarter Summary. To find the average, enter the following formula in one of the cells in the Summary sheet:

=AVERAGE(Region01:Region06!H15)

Spreadsheet calculates the average for all values stored in H15 on all sheets in the range Region01:Region06. If you move the Region06 sheet between Region04 and Region05, the software will adjust the calculation to include the sheets for Regions01, 02, 03, 04, and 06; Region05 will be omitted. Similarly, if you delete or add a sheet anywhere between Region01 and Region06, the software will include all the sheets located within the range in its calculation.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Make calculations across worksheets</td>
</tr>
<tr>
<td>2.</td>
<td>Create 2 worksheets populated with subject and marks for 1st and 2nd terms. Create another worksheet called Average and calculate the average of marks for all subjects.</td>
</tr>
</tbody>
</table>
SESSION 11: USING MULTIPLE WORKBOOKS AND LINKING CELLS

Relevant Knowledge

Spreadsheet also allows you to link the cells from various worksheets and from various spreadsheets to summarize data from several sources. In this manner, you can create formulas that span different sources and make calculations using a combination of local and linked information. You can link data from other spreadsheets and keep the information up to date without editing multiple locations every time the data changes. For example, you can display data from multiple departments for an overview of details without sharing information between sources.

In this exercise you will learn how to link cells from different spreadsheet applications.

Open a new spread sheet and enter the following data:

![Figure 43](image)

To link cells from different worksheet do the following:

- Open a new spreadsheet workbook.
- Type some formula, for example sum formula in any cell =sum(), while the parenthesis is opened, click on **Switch Windows** option under **Window** group in the **View** tab. A dropdown list appears with the active workbook names.
- Click on Book1 to select the earlier spreadsheet you had created and select the cells A2:D2.
• Press **Enter**. You are back on the second spreadsheet. The cell where you were entering the formula has the total of the values in the first spreadsheet. Note the way the software gives the cell reference. If you update any values in the first spreadsheet, automatically the sum value in the second spreadsheet is updated! Try this out.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Link cells and make calculations across workbooks</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. Switch Windows option is available in ____________ group under the View tab.

2. Linking cells from different _______ / _________ helps you to summarize data from different sources.

3. Linking data helps you help to keep information __________ without editing at multiple locations.
SESSION 12: SHARING WORKSHEET DATA

Relevant Knowledge

In most office settings, there is a shared drive where teams can store common files for everyone to use. This usually leads to sighting of the message: “The document [file name] is locked for editing by another user. To open a read-only copy of this document, click”!! This message appears because someone else already has the file open. Sometimes however, it is necessary to have multiple people working on a file at the same time. This can be to either speed up data entry or simply make things easier for collaboration purposes.

Spreadsheet software allows the user to share the workbook and place it in the network location where several users can access it simultaneously. In this exercise, you will learn how to share a worksheet.

Open a new spreadsheet and type the following.

![Figure 47](image)

Now to share the spreadsheet do the following.

- Click on Share workbook option under Changes group in the Review tab.
- A dialog box appears as shown below.
Check the option *Allow changes by more than one user at the same time. This also allows workbook merging.*

Click *OK.*

**Note:** Most spreadsheet software automatically turn off some features in shared workbooks. This is to simplify the workbook since multiple people can be working on the file at the same time. For example, shared workbooks don’t allow merging cells, conditional formatting, or inserting pictures/graphs/etc.

**EXERCISE**

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Share worksheet data with other users.</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. Share Workbook option is available in __________ group under the Review tab.

2. Shared workbooks don’t allow __________________, __________________ & inserting __________ or ________.
Unit 5: Digital Presentation (Intermediate)
CONTENTS

Unit 5: Digital Presentation (Intermediate)

SESSION 1: INSERTING A MOVIE CLIP .................................................................183
SESSION 2: INSERTING AN AUDIO CLIP .............................................................187
SESSION 3: WORKING WITH TABLES .................................................................188
SESSION 4: WORKING WITH CHARTS ...............................................................192
SESSION 5: INSERTING TRANSITIONS ...............................................................194
SESSION 6: INSERTING ANIMATIONS ...............................................................196
SESSION 7: GROUPING OBJECTS ......................................................................198
SESSION 8: INSERTING SPEAKER NOTES .........................................................200
SESSION 9: REVIEWING CONTENT ....................................................................202
SESSION 10: PREPARING TO DELIVER A PRESENTATION ..............................205
SESSION 11: PRINT A PRESENTATION .............................................................206
SESSION 1: INSERTING A MOVIE CLIP

Relevant Knowledge

Presentation allows the user to add movie clips to the presentation in order to make the presentation colourful and meaningful. You can insert movies or YouTube videos downloaded from the Internet.

In this exercise you will learn how to insert a movie clip in slides. Open a new file using presentation software.

You can insert a movie in two ways:

- Using Insert tab
- Using Title and Content Layout Option

Click on Movie option under Media clips group in the Insert tab, a drop down appears as shown below.

![Figure 1](image1.png)

You can select the Movie from File... option to insert the movie clip that you have already downloaded from the Internet. A dialog box appears as shown below:

![Figure 2](image2.png)

You can locate the movie clip and click OK to insert the same in the slide. The presentation will be displayed as shown below.
You can set one of the two options available for playing the media clip, i.e. **Automatically** or **When Clicked**.

Alternatively, you can select **Movie from Clip Organizer**... option to insert the movie clips that are available under Clip Organizer. Doing so displays the clip art task pane as shown below:

![Figure 3](image1)

![Figure 4](image2)

You can select any of the movies available and insert it in the slide. Once you have inserted the movie clip in the slide, the presentation will be displayed as shown below:

![Figure 5](image3)
Using Layout Option

Open a new file using presentation software and change the layout of the slide.

Click on **Layout** option available under **Slides** group in the **Home** tab, a dropdown list appears as shown below.

![Figure 6](image)

Click on **Title and Content** option and a slide will be displayed with the layout as shown below.

![Figure 7](image)
You can insert a movie in the slide by clicking the icon in the **Layout** option. Once you click the icon, a dialog appears as shown below.

![Figure 8](image-url)

When you play the slideshow, the movie clip will be played automatically.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Insert a movie clip using Insert option</td>
</tr>
<tr>
<td>2.</td>
<td>Insert a movie clip using Layout option</td>
</tr>
<tr>
<td>3.</td>
<td>Download different clips on either “Effects of thoughts on water” or “Our place in the cosmos” or “Effects of Global Warming”. Create a presentation giving an appropriate name to the file. Insert the relevant video clips and save the presentation. You will use this file in future sessions too.</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. Presentation allows the user to add ______ _______ to the presentation in order to make the presentation colourful and meaningful.

2. You can use two options to insert a movie clip the ________________ & ________________.

3. The two options available under Movie option are ________________ & ________________.

4. Movie option is available in ______________ group under the Insert tab.
SESSION 2: INSERTING AN AUDIO CLIP

Relevant Knowledge

You can include audio clips to a presentation similar to that of videos. For example, you can play mild background music while making your presentation. In this exercise you will learn how to insert an audio clip in slides.

Open a new file using presentation software. Click on Sound option under Media clips group in the Insert tab, a drop down appears as shown in figure 9.

![Figure 9](image)

You can select the Sound from File... option to insert the sound clip. A dialog box appears as shown below.

![Figure 10](image)
You can locate the audio clip and click **OK** to insert the same in the slide. You may follow the same steps as you learnt while inserting a Movie Clip. There is an inbuilt clip organizer for a list of sounds. You can access them via the **Sound from Clip Organizer**… option. Go ahead and insert an audio clip using this option. When you have completed inserting the sound clip, and you play the slideshow, the audio clip will be played automatically.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Insert a sound clip in a presentation</td>
</tr>
<tr>
<td>2.</td>
<td>Download appropriate music and then reopen the file created in the last session. Add the music files to enhance the effect of your presentation.</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. You can include _______________ to a presentation similar to that of videos.
2. Audio Clips are used for playing _______________ while making presentations.
3. Sound option is available in the Media Clips group under the _____________ tab.

**SESSION 3: WORKING WITH TABLES**

**Relevant Knowledge**

Presentation software enables the user to add tables in the slides in order to represent the statistical data meaningfully.

In this exercise you will learn to work with tables.

Open a new file using presentation software. You can insert a table in two ways:

- Using Insert tab
- Using Title and Content Option

Click on Table option under **Tables** group in the **Insert** tab, a drop down appears as shown below.
You can have learnt to create tables in a word processor by dragging the mouse over requisite number of boxes. Follow the same method here and create the table shown below. Now go ahead and try the Insert Table… and Draw Table options to create the table.
Using Title and Content Option

Open a new file using presentation software and change the layout of the slide. To change the layout of a slide do the following:

Click on Layout option available under Slides group in the Home tab, as you did while selecting a movie clip. Click on Title and Content option from the dropdown list. You can insert the table in the slide by clicking the icon available within the layout. Once you click the icon, a dialog appears as shown below.

Now enter the values for the number of columns and rows that you would like to have in the table. For example, if you need a table with 3 columns and 3 rows, type 3 in both Number of columns and Number of rows fields.

Once you have inserted the table into the slide, additional tabs - Design and Layout - are made available. You can use them for editing and formatting the table further.

You can change the design of the table by changing background, borders or effects by using Table Styles group in the Design tab. To use a particular design, Select a design under Table Styles group and double-click on it. If you would like to change a design, choose a different design under Table Styles group and double-click on the new design.

You have learnt to create a table in a presentation, but if the table already exists in a word processor document or a spreadsheet, you can directly import it from there. To do so:
With a slide in edit mode, choose **Object** from the **Insert** menu.

- In the **Insert Object** dialog box, click the **Create From File** option and click **Browse** to locate and choose the document or spreadsheet that contains the table. By default, the presentation software will insert the table.

- When you click **OK**, the entire document or spreadsheet is imported to your slide. Double-click the inserted text to remove extra text if the document contains more than the table.

- If you check the **Link** checkbox while inserting. On doing so, after you update the table in the document or spreadsheet, then right click on the imported table in the presentation software, and select the option **Update Link**, the embedded table gets updated automatically.

- Drag and drop the table on the slide to position it.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Insert a table in a presentation using Insert and Layout tab</td>
</tr>
<tr>
<td>2.</td>
<td>Change the design and format of a table in a presentation</td>
</tr>
<tr>
<td>3.</td>
<td>Import a table from another application</td>
</tr>
<tr>
<td>4.</td>
<td>Open a new file. Try inserting the table given in this exercise with multiple rows and columns and also use different pre-defined styles by using the <strong>Table Styles</strong> option under <strong>Design</strong> tab.</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. ________________ are used to represent the statistical data meaningfully in a presentation.

2. Table option is available in ______________ group under the Insert tab.

3. Two ways to create a table are: ________________ & ________________.

4. Additional tabs that will be available for editing and formatting the table are __________ & ________________.
SESSION 4: WORKING WITH CHARTS

Relevant Knowledge

Presentation software enables the user to insert charts in slides to present statistical table data in a pictorial representation. This ensures that the audience can grasp complex data at a glance.

In this exercise you will learn to work with charts. Open a new file using presentation software. To insert a chart in the slide, click on Chart option under Illustrations group in the Insert tab. A dialog box appears as shown below.

![Insert Chart dialog box](Figure 16)

You will notice different type of the charts that can be used in the presentation.

Select a chart type and click OK. A default chart will be inserted on the slide. The default data table for that chart will be opened in a spreadsheet application separately as shown below.

![Chart and data table](Figure 17)
You can edit the values in the spreadsheet and the presentation software will automatically update the chart. Now enter the following in the spreadsheet window:

<table>
<thead>
<tr>
<th></th>
<th>Day 1 Savings</th>
<th>Day 2 Savings</th>
<th>Day 3 Savings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arun</td>
<td>300</td>
<td>250</td>
<td>500</td>
</tr>
<tr>
<td>John</td>
<td>200</td>
<td>300</td>
<td>300</td>
</tr>
<tr>
<td>Jacob</td>
<td>150</td>
<td>500</td>
<td>600</td>
</tr>
<tr>
<td>Salim</td>
<td>500</td>
<td>750</td>
<td>150</td>
</tr>
</tbody>
</table>

Once you have modified the data table in the spreadsheet the chart in the slide gets modified automatically and the chart will displayed similar to the one below.

Now change the values in the spreadsheet and observe the changes in the chart.

You can change the colors and effects of the chart by using Chart Styles available under Design tab. To change to a different style, select a style from Chart Styles and double-click on it.

**Some Basic Guidelines are as follows:**

- Convey one message per chart. Make the message the heading.
- Make the chart easy to read. Label the X and Y axis and label the lines, bars, or pie wedges. Make the most important text largest, the most important data lines or sections darkest.
- Make bars and columns wider than the spaces between them.
- Be accurate. Always start a numerical axis at zero. Compare only like variables.
- Eliminate all unnecessary details. Avoid grid lines, data points, boxes, etc. unless they relate to the message.
- Use a few (maximum four) colors per visual.
Importing a chart

You can also import a chart from a spreadsheet. The method is the same as importing a table into presentation software. Since the entire sheet is imported, you may need to maneuver around and display the chart in the embedded object. To increase / decrease the size of the object, you can double click on it and resize it.

EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Insert a chart onto a slide</td>
</tr>
<tr>
<td>2.</td>
<td>Modify an already created chart</td>
</tr>
<tr>
<td>3.</td>
<td>Import a chart from another application</td>
</tr>
<tr>
<td>4.</td>
<td>Create a chart using the data below in a spreadsheet. Import the chart onto a slide.</td>
</tr>
</tbody>
</table>

<p>| | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>January</td>
<td>February</td>
<td>March</td>
<td>April</td>
<td>May</td>
<td>June</td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Name | January | February | March | April | May | June |
House Rent | 2500 | 2550 | 2550 | 3000 | 3500 | 5000 |
Electricity Bill | 700 | 750 | 800 | 850 | 900 | 525 |
Grocery Expenses | 1000 | 1200 | 950 | 850 | 1500 | 1250 |
Travel Expenses | 500 | 600 | 750 | 680 | 1000 | 950 |
Phone/Mobile Bill | 400 | 500 | 350 | 600 | 800 | 680 |

ASSESSMENT

Fill in the blanks:

1. Presentation enables the user to insert ____________ in slides to present statistical table data in a pictorial representation.
2. Chart option is available in ____________ group under the Insert tab.

SESSION 5: INSERTING TRANSITIONS

Relevant Knowledge

Transition effects can help in increasing audience’s interest during a presentation.

A slide transition is the visual motion when one slide changes to the next during a presentation. By default, one slide simply replaces the previous one on screen, just like a slide show of photographs.
would change from one to the next. Most presentation software provides many different transition effects that you can use to liven up your slide show.

In this exercise you will learn to add transitions in the presentation. Open a new file using presentation software and add contents to the presentation based on the guidelines provided earlier. To work with transition effects, click the **Animations** tab. You will be displayed with list of transition effects similar to the one below.

![Transitions tab](image)

To apply, select an effect from **Transitions to this slide** group and double-click on it.

You can also increase or decrease the duration of the transition effect by setting up the time interval (in seconds) in **duration** option under **Timing** group. Try setting the duration as 1 minute and observe the effect by performing the slide show.

You can set sound effects during transitions by selecting a sound scheme available in **Sound** option under **Timing** group. Try using different sound schemes and observe the sound effect by performing the slide show.

If you would like to keep the same transition and sound effect across the entire presentation, click **Apply to all** under the **Timing** group. Selecting this option will apply all the selected effects across all slides.

**Note:** A common mistake made is using too many transitions, or using one that doesn’t fit well with the subject matter. Try to find one transition that doesn’t detract from the presentation and use it throughout the show. Using too many makes your presentation looks amateurish. A transition is the final effect to be given to your presentation so edit and arrange all slides in the preferred order before setting them.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Apply transitions to slides</td>
</tr>
</tbody>
</table>
2. Now open the presentation created in Exercise 1 (either “Effects of thoughts on water” or “Our place in the cosmos” or “Effects of Global Warming”) and try applying different transition effects to your presentation slides.

**ASSESSMENT**

Fill in the blanks:

1. ___________ effects can help in increasing audience’s interest during a presentation.

2. A ___________ is the visual motion when one slide changes to the next during a presentation.

3. The list of transition effects will be available under _____________ tab.

4. Transition effects are available in ________________ group under the Animations tab.

5. _____________, ________________, ________________, ________________, ________________ are some of the transition effects available in a presentation software.

**SESSION 6: INSERTING ANIMATIONS**

**Relevant Knowledge**

While transition occurs between each slide, animation allows you to put slide elements, such as text and graphics, in motion within a slide! Animations are helpful way to make your slides look more dynamic. Besides adding action, they help steer audience focus and emphasize important points. They are also a great way to reveal text or object on a slide one step at a time. For example, you could have five bullet points of text, and reveal them one-by-one on the slide with each click.

In this exercise you will learn to add animations in a presentation. Open a new file using presentation software and add contents to the presentation based on the guidelines provided earlier. To work with animations, Click **Animations** tab. You will see Animation options similar to the one below.
To apply, select the graphical object and click **Animate** under **Animations** group. Select the animation effect under the **Animate** dropdown list. You can apply an animation effect by selecting different animation scheme from the dropdown menu.

Once you have selected an animation scheme, play the slideshow to preview the effect.

Surveys show that animation effects are one of the most annoying elements in presentations. However, when used effectively, these effects can insert a dramatic moment to a particular message and add spice to a dull presentation.

**To summarize the effective uses of animation effects:**

- Helps focus audience attention on information.
- Controls the flow of information especially while explaining a diagram.
- Reveal concepts one by one.

**EXERCISE**

**Perform the following activities till you are confident:**

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Apply animation on slide objects</td>
</tr>
<tr>
<td>2.</td>
<td>Create a presentation with 3 slides on your favorite sport. Use different animation effects available in the presentation software to enhance your presentation as per your choice. Make your presentation in the class.</td>
</tr>
</tbody>
</table>
**ASSESSMENT**

Fill in the blanks:

1. __________________ enables you to put slide elements, such as text and graphics, in motion within a slide.

2. __________ are helpful way to make your slides look more dynamic.

3. To apply an animation, select the Animate option available in ________ group under the Animations tab.

**SESSION 7: GROUPING OBJECTS**

**Relevant Knowledge**

Grouping can help when you want to move, rotate or resize multiple objects in a presentation. You can group objects such as pictures, clip art, shapes and text box; once grouped they appear as a single object.

In this exercise you will learn to work with grouping and ungrouping of objects. Open a new file using presentation software and add graphical objects to the presentation based on the guidelines provided earlier. To group the graphical objects, select all the objects that you want to group in the slide. To select more than one objects in the slide hold down the ctrl key and select the object in the slide.

To group the objects, click **Format** tab.

![Figure 22](image)

You can select the **Group** option available under **Arrange** group in the **Format** tab. Once you select the option, you should see a dropdown similar to one displayed below.
Click on **Group**, to group all the selected graphical objects in the slide.

Similarly you can ungroup the grouped objects by selecting the ungroup option available under **Group** dropdown menu.

### EXERCISE

**Perform the following activities till you are confident:**

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Group objects on a slide</td>
</tr>
<tr>
<td>2.</td>
<td>Open a new presentation, and create the following images and add small textboxes as headers to describe them:</td>
</tr>
</tbody>
</table>

Now try selecting the objects, practice grouping and ungrouping functions.

### ASSESSMENT

**Fill in the blanks:**

1. __________ helps to move, rotate or resize multiple objects in a presentation.

2. The Group option is available in __________ group under the Format tab.

3. The three options available under Group dropdown option are: _____________, _____________ & _____________.
SESSION 8: INSERTING SPEAKER NOTES

Relevant Knowledge

Good presenters always rehearse their presentations well but there’s often one more thing that helps them deliver flawless presentation – speaker notes. Speaker notes are guided text used by the presenter during a presentation. Speaker notes can be short or long texts that can be used as a reference by the presenter while making a presentation. An area of a PowerPoint or OpenOffice Impress slide that is hidden during the presentation is reserved for notes for the speaker. Here you as the presenter can note important key points that you wish to cover during the presentation.

You can print these notes out, accompanied by a thumbnail version of the appropriate slide, to keep as a handy reference to use when you are making your oral presentation. This can help you to communicate specific points related to each slide and make the presentation effective for the audience.

In this exercise you will learn to add speaker notes. Open a new file using presentation software. To add notes to a particular slide, select the slide and type the notes in the Click to add notes area located at the bottom of the presentation software (Figure below).

![Click to add notes area](Figure 24)
Alternatively, you can select View tab and click Notes page under Presentation Views Group.

Key things to remember about speaker notes:

1. They should not restate the contents of the slide.
2. Speaker notes should support the content of the slide with in-depth information.

While the regular presentation slides are shown on the main screen for the audience, the view on your computer screen is slightly different – you can not only see the current slide but also the text notes and other key points that should be discussed with that slide. To do so, open the presentation file using your presentation software, go to the Slide Show tab and check the option Use Presenter View.

EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Insert speaker notes on slides</td>
</tr>
<tr>
<td>2.</td>
<td>Open the presentation you had created in Exercise 1 (either “Effects of thoughts on water” or “Our place in the cosmos” or “Effects of Global Warming”) and enhanced in Exercise 5. Add speaker notes to each of your slides.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. _______________ are guided text used by the presenter during a presentation.

2. _______________ can be short or long texts that can be used as a reference by the presenter.

3. Notes page option is available in _______________ group under the View tab.
SESSION 9: REVIEWING CONTENT

Relevant Knowledge

You should always review the presentation and make changes if required before you present it to the audience. Presentation software includes options such as spell checks for correcting errors in a presentation. However, it is the presenters’ responsibility to check each and every point manually on each slide before attempting to make a presentation.

In this exercise you will learn to make an effective presentation. Making effective presentations takes practice, but with a few tips up your sleeve, you are ready to take on the challenge.

1. Know your topic.

You may want to charge right in and start using the presentation software.

However, do the research first and know your material, think through what and how you will present get comfortable with the matter before beginning the project on the computer. Creating the presentation is the easy part. The best classroom presentations are created by people who are comfortable with what they are going to talk about.

2. Use key phrases about your topic.

Good presenters use key phrases and include only the most important information. Choose only the top three or four points and make them several times throughout the presentation. Highlight key points that are necessary for the audience to remember. Keep the points as short as possible, use 5-6 words to describe the point.

3. Avoid too much text on each slide.

Do not write your whole speech on the slides. The slide show is meant to accompany your oral presentation. Summarize the content as bullet points. Use simple language and limit the number of bullets to three or four per slide.

4. Limit the number of slides.

Too many slides in a presentation may cause you to rush to get through them and your audience might end up paying more attention to the changing slide than to what you are saying. On average, one slide per minute is about right in a classroom presentation.

5. Plan the layout of your slide.

Make your slides easy to follow. Put the title at the top. Phrases should read left to right and top to bottom. Keep important information near the top of the slide.
6. **Avoid fancy fonts.**

Make sure the fonts, design and colors are consistent throughout the presentation; don’t use different styles for each slide. Use fonts that are readable; recommended fonts are Arial, Tahoma, Verdana. Use standard font size that is readable even from the last row if presented in a large hall or to a large audience. Use combination of capital and small letters; Do NOT use all capital letters as it may be difficult to read. Use bold, italics or underline only if required or to highlight key points.

7. **Use contrasting colors for text and background.**

Use reasonable mix of text color and background; preview to check if it is readable without any difficulty. Dark text on a light background is usually the best as this combination offers the maximum visibility. Keep your slide color scheme consistent throughout your presentation.

8. **Use a slide design template to keep your presentation look consistent.**

Use a single background on all slides; do NOT use multiple backgrounds. Use a pleasant template or style set; do NOT use different style sets for different slides as it will distract the audience and they might lose the focus.

9. **Use animations and transitions sparingly.**

You may enjoy applying animations and transitions in every place that you can. This will certainly be entertaining, but at the same time very distracting. So use this feature with prudence.

10. **Also, always review the presentation 2-3 times before making a presentation;**

this can help in reducing or eliminating any errors in it. Remove irrelevant points during the review, add or remove images during review. Try presenting to a smaller audience, make necessary corrections before presenting it to a larger audience

**Note:** Most presentation software includes many features; do NOT try to overuse them!!!

Once you have created the presentation of your choice using the guidelines, you may now proceed to reviewing the presentation. Use the additional guidelines below:

- Do a thorough spell check across all slides
- Perform a manual spell check for terms that is not included during the standard spell check in the presentation software; NOT all terms (particularly technical terms such as biological names, etc.) will be checked
- Remove irrelevant content such as images or clip arts, terms, etc. if they are not required.
EXERCISE

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Prepare a presentation with a topic of your choice or as assigned by your teacher. Review using the guidelines and have it validated by your teacher.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. Presentation software includes options such as ____________ spell checks for correcting errors in a presentation.

2. Tips to make an effective presentation are:
   
a) ________________________________________________________
   
   ________________________________________________________
   
   b) ________________________________________________________
   
   ________________________________________________________
   
   c) ________________________________________________________
   
   ________________________________________________________
   
   d) ________________________________________________________
   
   ________________________________________________________
   
   e) ________________________________________________________
   
   ________________________________________________________
SESSION 10: PREPARING TO DELIVER A PRESENTATION

Relevant Knowledge

Now that you have a presentation ready, you can customize the delivery of the presentation. For example, you can customize to display selected slides to be displayed to the audience or configure for multiple monitors, etc.

In this exercise, you will learn to deliver a presentation.

To work with Slide Show, open an existing presentation in the presentation software.

Click on Set Up SlideShow option under Set Up group in the Slide Show tab.

Once you click Set Up SlideShow, a dialog box appears as shown below.

Figure 25

If the presentation is to be made to an audience, use the Presented by a speaker (full screen) option.

If the presentation is to be made to an individual, use Browsed by an individual (window) option.

If the presentation is to be made at Kiosks, use the Browser at a Kiosk (full screen) option.

Note: A kiosk is a computer terminal featuring specialized hardware and software designed within a public exhibit that provides access to information and applications for communication, commerce, entertainment, and education.

In addition, you can configure the presentation to be automated (run continuously), with or without animation by using the options under Show Options group.

You can display selective slides from a presentation using the Show slides option.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a slide show</td>
</tr>
<tr>
<td>2.</td>
<td>Reopen the presentation created in Exercise 1 (either “Effects of thoughts on water” or “Our place in the cosmos” or “Effects of Global Warming”.) and enhanced in Exercises 5 and 8. Prepare to deliver the presentation based on all you have learnt in this session, preview and make your presentation.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. Set Up Slide Show option is available in _______________ group under the Slide Show tab.

2. The _______________ option should be used while presenting the presentation to an audience.

3. The _______________ option should be used while presenting the presentation to an audience.

4. A ____________ is a computer terminal featuring specialized hardware and software designed within a public exhibit that provides access to information and applications for communication, commerce, entertainment, and education.

SESSION 11: PRINT A PRESENTATION

Relevant Knowledge

Sometimes you may need to provide print outs of the presentation to the audience as a reference material. You can print notes, handouts or outline of the presentation using the presentation software. In this exercise, you will learn to print notes, handouts and outline.

To print, open an existing presentation and select the Print option.

Select the Notes Page option under Print what: dropdown list (figure 26.)
Click OK once you are ready to print the notes.

You can print handouts for audience reference by selecting the **Handouts** option under **Print what** dropdown list. To save paper, you can print multiple slides on a single sheet.

To print multiple slides, select the number of slides that you would like to print by choosing the number displayed under **Slides per page** dropdown under Handouts Group (figure 27).

If you would to print only the text part of the presentation, you can use the Outline option in the presentation software.

To print the outline, select the **Outline View** option under **Print what** dropdown list.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Print a presentation</td>
</tr>
</tbody>
</table>
| 2.    | Create a presentation (10-12 slides) on any two of the following topics.  
        • School Annual Day function.  
        • Sports Day.  
        • Independence Day.  
        • Healthy Diet.  
        • Savings Plan (Post Office).  
        • Creating Presentations. |

While making the presentations use the following features based on the presentation guidelines learnt earlier.  
• Use Transition effects for slides.  
• Use Animation effects for text and objects.  
• Group related pictures.  
• Use tables and format them with different table styles.  
• Use charts to represent data in graphical form.  
• Download and use templates.

ASSESSMENT

Fill in the blanks:

1. Print option is used to print _________, _________ & _________ of a presentation.

2. Handouts option is available under _________ dropdown list.

3. The _____________ option is used to print only the text part of the presentation.
# CONTENTS

## Unit 6: Email Messaging (Intermediate)

<table>
<thead>
<tr>
<th>Session</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Working with Calendar</td>
<td>211</td>
</tr>
<tr>
<td>2</td>
<td>Schedule an Appointment</td>
<td>214</td>
</tr>
<tr>
<td>3</td>
<td>Categorize an Appointment</td>
<td>218</td>
</tr>
<tr>
<td>4</td>
<td>Share a Calendar</td>
<td>220</td>
</tr>
<tr>
<td>5</td>
<td>Print a Calendar</td>
<td>225</td>
</tr>
<tr>
<td>6</td>
<td>Creating a Meeting Request</td>
<td>226</td>
</tr>
<tr>
<td>7</td>
<td>Respond to a Meeting Request</td>
<td>228</td>
</tr>
<tr>
<td>8</td>
<td>Create and Edit a Task</td>
<td>229</td>
</tr>
<tr>
<td>9</td>
<td>Create and Edit a Note</td>
<td>231</td>
</tr>
<tr>
<td>10</td>
<td>Create and Edit a Journal Entry</td>
<td>232</td>
</tr>
</tbody>
</table>
SESSION 1: WORKING WITH CALENDAR

Relevant Knowledge

Time Management is the act of planning to stay organized that will result in increased efficiency and productivity. Time management can be performed using simple techniques such as a paper and pen; you can also use calendar software to plan your time.

Calendaring software provides the user an electronic version of a calendar. It is a time management tool, a system of organizing days for social, religious, commercial, or administrative purposes. Most email applications include support for working with Calendar; you can also use online calendar such as Google Calendar however this requires internet connectivity.

In this exercise, you will learn to work with a calendar application. In these exercises, you will be practicing on Outlook Calendar. At the end of the sessions, you can easily navigate on any other calendar software as the features are almost the same. To learn about Google calendar you can explore the site http://services.google.com/apps/resources/overviews_breeze/Calendar/index.html.

Start the email program by:
Click Start > Programs > Microsoft Office > Microsoft Outlook.
Click Calendar located at the bottom left corner (figure below).

A window similar to the one below appears.
You can create appointments and schedule day-to-day activities using calendar. The application provides three views:

- **Day**
- **Week**
- **Month**

For example, to schedule an activity for a particular time in the day, choose Day view. The default view is by “Day”.

You can select either the **Show work week** (Monday to Friday) or **Show full week** (Sunday to Saturday) to view the appropriate days in the week by selecting one of the given options.

Selecting the Month view shows calendar for a month. You can plan your monthly schedule here. Any appointments/meetings/commitments previously set in the day/week view will also be reflected here.

You can switch over to a specific date in the calendar by selecting the date in the data navigator.
You can set the options for the calendar by selecting **Tools > Options**. A dialog box appears as shown below.

![Figure 6](image)

Figure 6

Click on **Calendar Options…** and a dialog box appears as shown below.

![Figure 7](image)

Figure 7

You can make changes to the calendar by using appropriate options in the dialog box.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Try each of the options in the Calendar Options dialog box and observe the changes. Make a note of all changes in your notebook.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. _____________ is the act of planning to stay organized that will result in increased efficiency and productivity.

2. A _____________ software provides the user an electronic version of a calendar.

3. The three view supported by a calendaring software are _______ , _______ & ______.

SESSION 2: SCHEDULE AN APPOINTMENT

Relevant Knowledge

You can create appointments using the calendar. For example, you can create an appointment for visiting a dentist.

In this exercise, you will learn to schedule an appointment.

You can schedule an appointment in two ways:

1. Using menu bar.
2. Using calendar view.

Go to **File > New > Appointment**, a window similar to the one below will be displayed.
Once you have created an appointment, click the **Save & Close** option for the calendar to store this information. The details will be reflected in the calendar.

Calendar software prompts you with an alert based on entries scheduled in the calendar.
You can create appointments on a daily, weekly, monthly or yearly basis. You can create recurring appointments, for example, you create your breakfast schedule everyday between 7:30 to 8:00 AM. To do so, right-click on the calendar and click *New Recurring Appointment*.

An *Appointment Recurrence* window appears. You can specify the appointment time, recurrence pattern and the range of recurrence here.
Enter a recurring event, select multiple days and click **OK**.

Recurring appointments appear on the calendar as a daily activity as displayed below.

### EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Schedule a onetime and a recurring appointment</td>
</tr>
<tr>
<td>2.</td>
<td>Create appointments for the following items:</td>
</tr>
<tr>
<td></td>
<td>1. Daily class schedule.</td>
</tr>
<tr>
<td></td>
<td>2. Exam schedule.</td>
</tr>
<tr>
<td></td>
<td>4. Visit to Circus (One time activity).</td>
</tr>
<tr>
<td></td>
<td>5. Parent / Teacher Meeting (Monthly activity).</td>
</tr>
<tr>
<td></td>
<td>6. Visit to a book store (One time activity).</td>
</tr>
<tr>
<td></td>
<td>7. Vaccine Schedule (Yearly activity).</td>
</tr>
</tbody>
</table>

Save the appointments, you will use them in the next exercise.
ASSESSMENT

Fill in the blanks:

1. The two ways to schedule an appointment are: __________________________ & __________________.

2. Calendar software prompts with an __________ based on entries scheduled in the calendar.

3. ______________ appointments can be used for scheduling repetitive tasks.

SESSION 3: CATEGORIZED AN APPOINTMENT

Relevant Knowledge

You can categorize the appointments in time management software by giving the specific colors to the appointments. For example, you can use green color for all school related activities and blue for all personal activities. Using Calendar you can name colors (and change the names when you want to). You use colors to make specific entries stand out at a glance and catch your eye. In this exercise, you will learn to categorize appointments.

You can either categorize the appointments at the time of creation of the appointment or categorize after creating the appointment.

To use a category while creating an appointment, select a color from the Categorize dropdown list (figure above). To apply category for an existing appointment, double-click on the appointment and select a color from the Categorize dropdown list.

Figure 14
You can name all the categories. A sample has been shown below:

![Figure 15](image)

**EXERCISE**

Perform the following activity till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create appointments with different categories and apply categories to existing appointments created in the previous exercise. Also, try to rename a named category and to remove a category you have created.</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. You can categorize appointments in time management software by giving specific _________ to appointments.

2. Some of the categories in the time management software are:
   a) ____________________________
   b) ____________________________
   c) ____________________________
   d) ____________________________
   e) ____________________________
   f) ____________________________
SESSION 4: SHARE A CALENDAR

Relevant Knowledge

You can also share your calendar with someone else by sending the calendar to the concerned person’s email id. The question that comes to the mind is why should I? Sharing your calendar helps to share various segments of your time-centric life with your spouse, family, and others. You are able to receive time-centric news and updates from trusted providers. Calendar sharing is the last frontier for true collaboration and social networking. Moreover, you can create calendar folders and choose specific folders to share. For example, you can create a calendar folder for a particular project and share it with your co-workers. You can also grant them permission to modify the events and appointments in the calendar.

In this exercise, you will learn to share a copy of your calendar in an email message using email server. The calendar will be uploaded to the mail server and can be accessed by others using their email id.

Click on Publish My Calendar… option available in the Navigation Pane of the Calendar as shown below.

![Figure 16](image)

Note: In order to upload your calendar to the mail server, you must have an email account in Microsoft Mailing service. Click Sign in, to login with your account, if you having one; otherwise create an email account by selecting click here to sign up for a free account available in the window. Enter your email ID and password and click Sign in. The following window appears:
Click **Finish** to publish the calendar on the mail server. The following dialog box appears:

![Figure 17](image17.png)

**Figure 17**

Select the time span in the calendar to be shared by selecting the drop down values. You can configure what details are to be shared with others using the **Detail** list and **Permissions** options. After specifying necessary details, click **OK**. The following dialog box appears as shown below.

![Figure 18](image18.png)

**Figure 18**

You are asked to enter your email account details to publish the calendar.

![Figure 19](image19.png)

**Figure 19**
Once you enter all the details, click **OK**. Once you click **OK** the following message box appears.

![Figure 20](image.png)

**Figure 20**

To send the invitation, click **Yes**. The **Calendar - Share** window appears.

![Figure 21](image.png)

**Figure 21**

Enter the email accounts to whom you would like to share the calendar with and click **Send** and the invitation will be sent to their email accounts.

When others sign in into their mail accounts, the following message will be displayed to the recipients.

![Figure 22](image.png)

**Figure 22**

To view the shared calendar, the recipients have to click on **Subscribe to this Calendar** option available at the top of the message. The following dialog box appears:

![Figure 23](image.png)

**Figure 23**
Click **Yes** to subscribe to the shared calendar. Once you click **Yes**, the recipients will be displayed with a window similar to the one below to enter their account details.

![Authentication window](image)

**Figure 24**

Once the authentication is complete, the calendar will be downloaded and made available on their calendar program.

![Calendar download](image)

**Figure 25**

Now other users can view your calendar.

You can also send a copy of your calendar to other users as a standard email message. The calendar will be displayed as an attachment to the recipients in the email. To do so, click on **Send a Calendar via E-mail** option available in the Navigation Pane of the Calendar as shown below.

![Email attachment](image)

**Figure 26**
The *Send a Calendar via E-mail* dialog box appears.

![Figure 27](image)

You can send either the entire calendar or particular week or day in the calendar by selecting the appropriate option and click **OK**.

![Figure 28](image)

You can specify the address of the user to whom you want to share the calendar and click **Send** to send the calendar to the person.

**EXERCISE**

**Perform the following activities till you are confident:**

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Share the calendar you have created in the previous sessions with your classmates using both the methods you have learnt in this exercise.</td>
</tr>
</tbody>
</table>
ASSESSMENT

Fill in the blanks:

1. _____________ your calendar helps to share various segments of your time-centric life with your spouse, family, and others.

2. _____________ is the last frontier for true collaboration and social networking.

3. To share a calendar you have to select ________________ option available in the Navigation Pane.

SESSION 5: PRINT A CALENDAR

Relevant Knowledge

You can print the calendar and keep it for reference. This might be useful in situations when you don’t have access to a computer. In this exercise, you will learn to print a calendar.

Go to File > Print, the Print dialog box appears.
Select the range of the calendar by specifying the dates that you need to be printed and click \textbf{OK}.

Now try printing using different styles (Daily, Weekly, and Monthly) available in the \textit{Print style} box (figure above).

To print the details of private appointments, uncheck the \textit{Hide details of private appointments} check box.

To print non-adjacent days, change to Week or Month view and then select the days you want to print, and then click \textit{File > Print}.

\textbf{EXERCISE}

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Print a calendar using options in the print dialogue box. You may opt for either the daily, monthly or weekly style as per your choice.</td>
</tr>
</tbody>
</table>

\textbf{ASSESSMENT}

Fill in the blanks:

1. Print option is available under \underline{___________} menu.

2. To print the details of private appointments you have to uncheck \underline{____________________} checkbox.

\textbf{SESSION 6: CREATING A MEETING REQUEST}

\textbf{Relevant Knowledge}

A meeting is an appointment to which you invite people or reserve resources for (meeting hall, equipment etc.). You can create and send meeting requests and reserve resources for face-to-face meetings or for online meetings. To create a meeting, you identify the people to be invited, the resources to be reserved and pick a meeting time. Responses to your meeting request appear in your Inbox. You can also add people to an existing meeting or reschedule a meeting if the schedule is not convenient. In this exercise, you will learn to create a meeting request. You can schedule a meeting request using email application software.
Go to *File > New > Meeting Request*, the following window will be displayed:

![Meeting Request Window](image)

**Figure 30**

You can send the meeting details to another user by setting the Subject, Location and Timings of the meeting in the window shown above.

Click *Send*.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
</table>
| 1.    | Create meeting request for the following items:  
       | 1. School Annual Day function discussion.  
       | 2. Blood donation camp discussion |

**ASSESSMENT**

Fill in the blanks:

1. A _________ is an appointment to which you invite people or reserve resources.
2. You can specify ________, _________ & ________ while sending a meeting request.
SESSION 7: RESPOND TO A MEETING REQUEST

Relevant Knowledge

Calendar software allows the user to respond to other users meeting requests. In this exercise, you will learn to respond to a meeting request.

Open the email application to view the request. To respond, select *Accept*, *Tentative*, *Decline* or *Propose New Time* options (figure below)

![Figure 31](image1)

![Figure 32](image2)

As a meeting attendee, you can propose an alternative meeting time. However, the meeting organizer must accept the new time. Meeting organizers can send meeting requests that restrict the ability to propose alternate meeting times. If the meeting organizer has restricted meeting proposals, the *Propose New Time* command is not available. By default, when you propose a new time, you tentatively accept the meeting. However, if you click the text *Propose New Time*, you have the additional options to click *Tentative and Propose New Time* or *Decline and Propose New Time*.

EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Respond to the meeting requests sent by one of your classmates using mentioned procedure you have learnt today.</td>
</tr>
</tbody>
</table>
2. Respond to requests from other classmates using options such as Accept, Tentative, etc. and observe the results sent to your mail.

**ASSESSMENT**

Fill in the blanks:

1. Calendar software allows the user to _________ to other users meeting requests.

2. Responses to your meeting request appear in your ____________.

3. Some of the response options for meeting request are ____________, ____________, ____________ & ____________.

4. You have received a meeting request for which the schedule is not convenient to you; however you would like to reschedule this meeting. Which option should be used when responding to this meeting request? ______________

**SESSION 8: CREATE AND EDIT A TASK**

**Relevant Knowledge**

Tasks refers to actions that can be performed by an user; tasks may include action items such as booking a conference room, booking tickets, reminder for a task completion itself, etc. In this exercise, you will learn to create and edit a task.

You can create tasks in email calendar application software.

Go to *File > New > Task*, a *Task* window will be displayed as shown below.

![Figure 33](image-url)
Here you can define a subject name for the task; the start date and end date of the task; the status of the task and the priority of the task. Once you have given the entire details click **Save & Close** at the top of the page. A window is displayed as shown below.

![Figure 34](image)

You can also edit the task by double clicking the task name available in the email application software.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a new task</td>
</tr>
<tr>
<td>2.</td>
<td>Edit an existing task</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. ______ refers to actions that can be performed by a user.

2. While creating a task you can define______________, ____________, ____________, ____________, ____________ & ____________ of a task.
SESSION 9: CREATE AND EDIT A NOTE

Relevant Knowledge

Notes are short text messages that can be used for taking quick notes. You can create notes in the calendar software. In this exercise, you will learn to create and edit a note.

Go to File > New > Note, a window will be displayed as shown below.

![Figure 35](image)

You can type the content of the note and click the icon. Once you click the icon, a dropdown list appears as shown below.

![Figure 36](image)

To view the notes that you have created, click Notes in the calendar application. If you would like to edit the note, double-click on it and edit as required.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a note</td>
</tr>
<tr>
<td>2.</td>
<td>Edit a note</td>
</tr>
<tr>
<td>3.</td>
<td>Create note for the following items:</td>
</tr>
<tr>
<td></td>
<td>1. Grocery list.</td>
</tr>
<tr>
<td></td>
<td>2. Books to buy list.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. __________ are short text messages that can be used for taking quick notes.

2. To view the list of notes you select the ____________ option in the Calendar application.

SESSION 10: CREATE AND EDIT A JOURNAL ENTRY

Relevant Knowledge

Journal entry creates a timeline of transactions that can be linked to a contact. A transaction might be an email, task, appointment etc. The following activities can be automatically recorded:

- Emails Sent & Received
- Telephone calls
- Meeting requests & responses
- Office documents you manage

By automatically recording all documents you work on, email sent to specific contacts, and phone calls made, the journal logs all your activity. This is very useful when you need to know how long you worked on a document or spent on a phone call because the journal tracks the elapsed time along with the event; or when a manager might want to know the number of calls made or email sent by the team members or track the number of documents created per hour.

In this exercise, you will learn to work with journal entries.
If you would like to track the usage of an application such as Microsoft Word, go to **Tools > Options**, a dialog box will be displayed as shown below.

![Figure 37](image-url)

Click on **Journal Options** button.

Once you click the button, a dialog box will be displayed as shown below.

![Figure 38](image-url)

Check **Microsoft Word** under **Also record files from** Section and Click **OK**. Close the time management software.
Now open the word processing software, create a document and save it. Close the Word Processing software. Open the time management software.

Select **Go > Journals.**

Following window will be displayed:

![Figure 39](image)

Notice the document that you created earlier is listed. You can edit the journal entry by double-clicking the entry or by right-clicking the entry and selecting **Open Journal Entry.**

![Figure 40](image)

A window similar to the one below will be displayed:
Notice the following items that are displayed:

- Document file name and path
- Created time and date
- Duration (Amount of time spent on that document)
- Shortcut to the document itself! (Double-clicking the shortcut will open the document)

Similarly if you would like to track emails send to your contacts, Go to Tool > Options. Click on Journal Options button.
Under **For these contacts:** section, select the contacts that you wish to track by placing a check against each contact. Click **OK**.

**Note:** The contacts added in the calendar application will be visible here.

Now send mail to the contacts (selected in the previous step). Once you have completed sending the mails, Click **Go > Journals.** A window similar to the one will be displayed.

![Figure 43](image)

Notice the mail entries (sent & received) displayed. Right-click on the entry and select **Open Journal Entry.**

![Figure 44](image)
Notice the following items that are displayed:

- Mail Subject
- Timestamp (time and date)
- Shortcut to the mail itself! (Double-clicking the shortcut will open the mail)

Now that you have learnt to work with Journal, work with different other options such as task requests, meeting requests, etc. and observe the tracking in the time management software.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a new journal entry</td>
</tr>
<tr>
<td>2.</td>
<td>Edit an existing journal entry</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. __________ creates a timeline of transactions that can be linked to a contact.

2. ______________, ______________, ______________, ______________ are some of the items that can be automatically recorded by the Calendar Software.
Unit 7: Database Development (Basic)
## CONTENTS

**Unit 7: Database Development (Basic)**

| SESSION 1: DATABASE CONCEPTS | 240 |
| SESSION 2: DATA STORAGE      | 243 |
| SESSION 3: MANIPULATING DATA | 248 |
| SESSION 4: CREATING A DATABASE OBJECT | 250 |
| SESSION 5: CREATING A TABLE  | 253 |
| SESSION 6: BUILDING FORMS   | 257 |
| SESSION 7: CREATE AND MANAGE QUERIES | 263 |
| SESSION 8: DESIGN REPORTS   | 269 |
SESSION 1: DATABASE CONCEPTS

Relevant Knowledge

A database is an organized collection of data. You can visualize it as a container of information. The data is typically organized to model relevant aspects of reality (for example, the availability of rooms in hotels), in a way that supports processes requiring this information (for example, finding a hotel with vacancies).

Suppose if you own a stationary shop, you need to keep detailed records of the materials available in your shop. You also need to store information about pricing, stock levels for reordering, old stocks, etc. While in the manual system, you would maintain several files with different bits of information; in the computerized system you would use database programs such as Microsoft Access, OpenOffice.org Base, and MySQL, to organize the data as per your business need.

The database concept has evolved since the 1960s to ease increasing difficulties in designing, building, and maintaining complex information systems (typically with many concurrent end-users, and with a large amount of diverse data).

In this lesson, you will learn database concepts and to work with a Database Management System (DBMS).

Database Management System

A database management system is a software package with computer programs that controls the creation, maintenance, and use of a database. It allows organizations to conveniently develop databases for various applications. A database is an integrated collection of data records, files, and other objects. A DBMS allows different user application programs to concurrently access the same database.

Well known DBMSs include Oracle, IBM DB2, Microsoft SQL Server, Microsoft Access, PostgreSQL, MySQL, FoxPro, and SQLite.

Data can be organized into two types:

- **Flat File**: Data is stored in a single table. Usually suitable for less amount of data.
- **Relational**: Data is stored in multiple tables and the tables are linked using a common field. Relational is suitable for medium to large amount of data.

Database Servers

Database servers are dedicated computers that hold the actual databases and run only the DBMS and related software. Typically databases available on the database servers are accessed through command line or graphic user interface tools referred to as Frontends; database servers are referred to as Back-ends. Such type of data access is referred to as a client-server model.
RDBMS

A relational database management system (RDBMS) is a database management system that is based on the relational model as introduced by E. F. Codd, of IBM’s San Jose Research Laboratory. Most popular databases currently in use are based on the relational database model.

The relational model for database management is a database model based on first-order predicate logic, first formulated and proposed in 1969 by Edgar F. Codd. In the relational model of a database, all data is represented in terms of tuples, grouped into relations. A database organized in terms of the relational model is a relational database.

The purpose of the relational model is to provide a declarative method for specifying data and queries: users directly state what information the database contains and what information they want from it, and let the database management system software take care of describing data structures for storing the data and retrieval procedures for answering queries.

Database Concepts

Database contains objects that are used for storing and managing information. To understand a database in very simple language, let’s look at the example of your address book. What do you store in an address book? You may have people’s name, people’s address, people’s phone number and maybe even people’s birthdays. There is a common element here – people. In this example, each person is considered an “item”. So, an item is what the database is storing information about. When you were recording information in your address book, what did you ask the people? What is your address? What is your phone number? etc. Each question that we ask about our item is a “field”. Now, say you make new friends and want to add their information to your address book. You will ask questions, get the answers and create a new “record”. So a record is a set of information (made up of fields) stored in your database about one of the items. A “value” is the actual text or numerical amount or date that you put in while adding information to your database. When you put all the information together in a grid (like you do in a spreadsheet), a collection of similar records creates a table.

A database can have one or many tables. An address book example is a very simple one, in real life there are many more details involved. A big company would have in its database, one table for its products, one table for its suppliers, one table for its customer details, one for orders received and maybe many others. Basically each table in a database contains information about one type of item. So a database is basically a container that holds tables and other objects and manages how they can be used.

Another very important thing to remember is that when we put in information, we may have people with the same name (there can be more than one Charu Arora) or the same address (members of a family). But when creating a database an important feature is record uniqueness in every table. It is important to be able to distinguish between different items having duplicate values.
Uniqueness helps to avoid accidental duplication of records caused by user or computer error. This can be achieved by using some number or value that uniquely identifies a record. If such a unique value does not exist in your fields, as the database designer, you can create a special additional field in a table where unique numbers or values can be assigned for each new entry. Therefore, every table has a key field which ensures that there are 100% unique values throughout the database.

Every database table should have one or more fields designated as key. You can assign a unique value to this key for differentiating records that may have similar names or address. Look at the following example of student database:

<table>
<thead>
<tr>
<th>Name</th>
<th>Standard</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ram</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>Ravi</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>Ravi</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>Sanjay</td>
<td>X</td>
<td>B</td>
</tr>
</tbody>
</table>

In this table, it will be extremely difficult to differentiate between student records as they have names that are similar. To differentiate, you can add additional field - roll number - that will be unique for each record (example below).

<table>
<thead>
<tr>
<th>Rollno</th>
<th>Name</th>
<th>Standard</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>Ram</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>20</td>
<td>Ravi</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>21</td>
<td>Ravi</td>
<td>X</td>
<td>A</td>
</tr>
<tr>
<td>22</td>
<td>Sanjay</td>
<td>X</td>
<td>B</td>
</tr>
</tbody>
</table>

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Analyze database requirements for a retail shop. Record the business requirements and document. (You can use this information for creating a database to suit this business requirement)</td>
</tr>
<tr>
<td>2.</td>
<td>Analyze database requirement for your school; visit different departments such as library, student admission centre, to gather requirements. Document the business requirement. (You can use this information for creating a database to suit this requirement)</td>
</tr>
</tbody>
</table>
ASSESSMENT

Short Answer Questions

1. What does DBMS stands for?
2. What does RDBMS stands for?
3. How is data organized in a RDBMS?

Fill in the blanks:

1. A __________ is an organized collection of data.
2. A ______________ is a software package that can be used for creating and managing databases.
3. A __________________________ is a database management system that is based on the relational model.
4. Three popular DBMS software are _______________, _______________, & ________________.

SESSION 2: DATA STORAGE

Relevant Knowledge

Data in a relational database management system (RDBMS) is organized in the form of tables. You will now quickly recap what you learnt in the last session and assimilate more concepts.

Tables:

A table is a set of data elements (values) that is organized using a model of vertical columns (which are identified by their name) and horizontal rows. A table has a defined number of columns, but can have any number of rows. Each row is identified by the values appearing in a particular column identified as a unique key index or the key field.

Columns or Fields:

A column is a set of data values of a particular simple type, one for each row of the table.
The columns provide the structure according to which the rows are composed. For example, cFirstName, or cLastName are fields in a row.

**Rows or Records or Tuples:**

A row also called a record or tuple represents a single, data item in a table. In simple terms, a database table can be visualized as consisting of rows and columns or fields. Each row in a table represents a set of related data, and every row in the table has the same structure.

**Data types:**

Datatypes are used to identify which type of data (value) we are going to store in the database. Fields themselves can be of different types depending on the data they contain. Data types in OpenOffice base is broadly classified into five categories listed below.

- Numeric Types
- Alphanumeric Types
- Binary Types
- Date time
- Other Variable types

**Numeric Types:**

Numeric data types are used for describing numeric values for the field used in the table of a database. Numeric data types in a database can be using for storing information such as mobile number, roll number, door number, year of school admission, true or false statements, statistical values, etc. The different types of numeric data types available are listed here.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOLEAN</td>
<td>Yes / No</td>
<td>Values as 0 or 1. Example: True or False, Yes or No.</td>
</tr>
<tr>
<td>TINYINT</td>
<td>Tiny Integer</td>
<td>Store integer range between 0 to 255</td>
</tr>
<tr>
<td>SMALLINT</td>
<td>Small Integer</td>
<td>Store integer range between -215 to +215-1</td>
</tr>
<tr>
<td>INTEGER</td>
<td>Integer</td>
<td>Store integer range between -231 to +231-1</td>
</tr>
<tr>
<td>BIGINT</td>
<td>Big Integer</td>
<td>Range between -2^63 to +2^63-1</td>
</tr>
<tr>
<td>NUMERIC</td>
<td>Number</td>
<td>Maximum precision of e(1+231)</td>
</tr>
<tr>
<td>DECIMAL</td>
<td>Decimal</td>
<td>Maximum precision of e(1+231)</td>
</tr>
<tr>
<td>REAL</td>
<td>Real</td>
<td>2^-1074 to (2-2^52)* 2^1023</td>
</tr>
<tr>
<td>FLOAT</td>
<td>Float</td>
<td>2^-1074 to (2-2^52)* 2^1023</td>
</tr>
<tr>
<td>DOUBLE</td>
<td>Double</td>
<td>2^-1074 to (2-2^52)* 2^1023</td>
</tr>
</tbody>
</table>
Alphanumeric Types:

<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LONGVARCHAR</td>
<td>Memo</td>
<td>Stores up to the max length or number indicated by user. It accepts any UTF 8 Character.</td>
</tr>
<tr>
<td>CHAR</td>
<td>Text (fix)</td>
<td>Stores exactly the length specified by user. Pads with trailing spaces for shorter strings. Accepts any UTF 8 Character.</td>
</tr>
<tr>
<td>VARCHAR</td>
<td>Text</td>
<td>Stores up to the specified length. No padding (Same as long var char)</td>
</tr>
<tr>
<td>VARCHAR_IGNORECASE</td>
<td>Text</td>
<td>Stores up to the specified length. Comparisons are not case sensitive but stores capitals as you type them.</td>
</tr>
</tbody>
</table>

Binary Types:

Binary data types are used for storing data in binary formats. Binary data types in a database can be using for storing photos, music files, etc. In general, files of any format can be stored using the binary data type. The different types of binary data types available are listed here.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LONGVARBINARY</td>
<td>Image</td>
<td>Stores any array of bytes (images, sounds, etc.). No validation required.</td>
</tr>
<tr>
<td>BINARY</td>
<td>Binary (fix)</td>
<td>Stores any array of bytes. No validation required.</td>
</tr>
<tr>
<td>VARBINARY</td>
<td>Binary</td>
<td>Stores any array of bytes. No validation required.</td>
</tr>
</tbody>
</table>

Date time:

Date time data types are used for describing date and time values for the field used in the table of a database. Date time data types in a database can be using for storing information such as date of birth, date of admission, date of product sale, etc. The different types of date time data types available are listed here.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Stores month, day and year information</td>
<td>1/1/99 to 1/1/9999</td>
</tr>
<tr>
<td>Time</td>
<td>Stores hour, minute and second information</td>
<td>Seconds since 1/1/1970</td>
</tr>
<tr>
<td>Timestamp</td>
<td>Stores date and time information</td>
<td></td>
</tr>
</tbody>
</table>
Other Data Types:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other/Object</td>
<td>Stores serialized Java objects “user application must supply serialization routines”</td>
</tr>
</tbody>
</table>

You had used the example of an address book in the previous lesson. An address book uses only one table. But look at a different situation. If you are a dealer selling a single type of item and want to record details of your sales in the past month and also want the details of the client who purchased the item (name, address, phone, date purchased, number of items bought etc), what would you do?. You create a table Sales with all the details:

<table>
<thead>
<tr>
<th>OrderID</th>
<th>Customer Name</th>
<th>Customer Address</th>
<th>Phone</th>
<th>Sale Date</th>
<th>#ItemsBought</th>
</tr>
</thead>
<tbody>
<tr>
<td>000789</td>
<td>Sheela Arora</td>
<td>xxxxxNoida</td>
<td>2444490</td>
<td>01/11/12</td>
<td>3</td>
</tr>
<tr>
<td>000790</td>
<td>Vaibhav Mittal</td>
<td>xxxxGhaziabad</td>
<td>2443358</td>
<td>01/11/12</td>
<td>4</td>
</tr>
<tr>
<td>000791</td>
<td>Saurabh Tayal</td>
<td>xxxxNew Delhi</td>
<td>2678945</td>
<td>02/11/12</td>
<td>12</td>
</tr>
<tr>
<td>000792</td>
<td>Vaibhav Mittal</td>
<td>xxxxGhaziabad</td>
<td>2443258</td>
<td>02/11/12</td>
<td>23</td>
</tr>
<tr>
<td>000793</td>
<td>Prashant Singh</td>
<td>xxxxRohtak</td>
<td>6784534</td>
<td>02/11/12</td>
<td>4</td>
</tr>
<tr>
<td>000794</td>
<td>Shila Arora</td>
<td>xxxxxNoida</td>
<td>2444490</td>
<td>03/11/12</td>
<td>18</td>
</tr>
<tr>
<td>000795</td>
<td>Vaibhav Mittal</td>
<td>xxxxGhazibad</td>
<td>2443258</td>
<td>03/11/12</td>
<td>45</td>
</tr>
</tbody>
</table>

Do you see a problem here? Every time you sell an item to Sheela or Vaibhav or any other customer (client) you need to store the details again. So, what is the solution? Create one table for client details and another for sale details. Since each record has to be unique, you can insert a ClientID field to uniquely identify each client in the client table. In the Sales table, you would give a point of reference which “points” to a particular record in the Client table.

In the example here, the field ClientID occurs once in the Client table, but since one client can place many orders, it occurs a number of times in the Sales table. Since we cannot have an order without a customer, we call Client the parent and Sales the child table. Related tables like these share a common field. You store data about people once, but refer to those people many times in the database.

This unique field is called the **primary key (PK)**. A primary key is a unique value that identifies a row in a table. In our example, ClientID is the primary key in the Client table. Primary Keys are also indexed in the database, making it faster for the database to search for a record.

The referred field ClientID which occurs in the Sales table is called the **foreign key (FK)**. Hence, the foreign key identifies a column or set of columns in one (referencing) table that refers to a column or set of columns in another (referenced) table. The “one” side of a relation is always the
parent, and provides the PK attributes to be copied. The “many” side of a relation is always the child, into which the FK attributes are copied. **Memorize it: one, parent, PK; many, child, FK.**

Another point to remember is that the end users will/may never have direct access to the database. They can only see what you permit them to and can select only from the options you give them.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
</table>
| 1.    | Create a database for a stationery shop.  
        Hint: Create fields for items, price, color, vendor, etc. |
ASSESSMENT

Short Answer Questions
1. List the data types used in a DBMS /RDBMS?
2. State the relationship and difference between a primary and foreign key?
3. List datatypes available in Numeric Datatype?
4. List datatypes available in Alphabetic Datatype?
5. List datatypes available in Numeric Datatype?
6. List datatypes available in Data Datatype?

Fill in the blanks:
1. A _______ is a set of data elements that is organized using a model of vertical columns and horizontal rows.
2. A ________ is a set of data values of a particular simple type, one for each row of the table.
3. A ___________ represents a single, data item in a table.
4. ____________ are used to identify which type of data we are going to store in the database.
5. A __________ is a unique value that identifies a row in a table.

SESSION 3: MANIPULATING DATA

Relevant Knowledge
In a database you can define the structure of the data and manipulate the data using some commands. There are two types of languages for this task. These are:
• Data Definition Language (DDL)
• Data Manipulation Language (DML)

Data Definition Language (DDL)
A data definition language or data description language (DDL) is a standard for commands that define the different structures in a database. DDL statements create, modify, and remove database...
objects such as tables, indexes, and users. Common DDL statements are CREATE, ALTER, and DROP.

**Data Manipulation Language (DML)**

A data manipulation language (DML) is a language that enables users to access and manipulate data in a database. The goal is to provide efficient human interaction with the system. Data manipulation involves:

- Retrieval of information from the database - SELECT statement
- Insertion of new information into the database - INSERT statement
- Deletion of information in the database - DELETE statement
- Modification of information in the database - UPDATE statement

A query language is a part of DML involving information retrieval only. The terms DML and query language are often used synonymously.

A popular data manipulation language is Structured Query Language (SQL). This is used to retrieve and manipulate data in a relational database. Other forms of DML are those used by IMS/DLI, CODASYL databases, such as IDMS and others. Data manipulation language comprises the SQL data change statements, which modify stored data but not the schema or database objects.

**There are two types of DML:**

- **Procedural:** The user specifies what data is needed and how to get it
- **Nonprocedural:** The user only specifies what data is needed. This is easier for the user but may not generate code as efficient as that produced by procedural languages.

**ASSESSMENT**

**Fill in the blanks:**

1. Types of languages used for creating and manipulating the data in the Database are ______________ & ______________.

2. A ______________ is a standard for commands that define the different structures in a database.

3. A ______________ is a language that enables users to access and manipulate data in a database.

4. A ______________ is a part of DML involving information retrieval only.

5. A popular data manipulation language is ______________.

6. Common DDL statements are __________, __________ and __________.
SESSION 4: CREATING A DATABASE OBJECT

Relevant Knowledge

There are a variety of DBMS/RDBMS available; in this exercise, you will learn about OpenOffice Base an Open Source RDBMS.

Launching Openoffice

- To launch OpenOffice, click **Start>Programs>OpenOffice.org 3.4.1>OpenOffice.org**. Alternatively, you can also double-click on the OpenOffice.org 3.4.1 shortcut on the desktop if available. You should see a Window similar to the one displayed below.

![OpenOffice Base Application](image)

Select the option database to launch the base application.

You can also directly launch the OpenOffice Base Application by doing the following:

- Click **Start>Programs>OpenOffice.org 3.4.1>OpenOffice.org Base**. You should be guided through the Database Wizard for creating a database. You will see a dialog box similar to the one displayed below.
You can create a new database by selecting the option **Create a new database**.

You can also open an existing database file that you have already created by selecting the option **Open an existing database file**.

Click **Next**. A dialog box similar to the one displayed below appears.

Click **Finish**. The **Save As** dialog box appears as shown below.
Specify a name for the database in the **File name:** field and click **Save.** A window similar to the one displayed below.

Now that you have created a database, you can work with the database as outlined in the next few sessions.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a database</td>
</tr>
</tbody>
</table>

ASSESSMENT

Short Answer Questions:
1. What is the file extension for databases created using OpenOffice.Org Base?
2. List any three file formats that can be managed using OpenOffice.Org Base?

SESSION 5: CREATING A TABLE

Relevant Knowledge

Tables are the basic building blocks of a database. You store the data in the database in the form of tables. In the previous exercise you have learnt how to create database objects in OpenOffice.

In this exercise you will learn how to create a table in a database.

After creating the database, you see a window as shown below.

![Figure 6](image_url)
Click on **Create Table in Design View**... option available under Tasks and a **Table Design** window appears as shown below.

![Figure 7](image_url)

Specify the field name and data type of the field to be created by selecting the appropriate type available under Field type dropdown list.

Now create a table with the following fields displayed below:

Specify the field name and the data type for each field name. For example, the table contains Name field and the data type of the Name is TEXT [VARCHAR]. You can specify the length of the field value.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data type</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>VARCHAR</td>
<td>50</td>
</tr>
<tr>
<td>Rollno</td>
<td>TINYINT</td>
<td>3</td>
</tr>
<tr>
<td>DOB</td>
<td>Date</td>
<td>DD/MM/YY</td>
</tr>
<tr>
<td>Class</td>
<td>Char</td>
<td>1</td>
</tr>
<tr>
<td>Phone</td>
<td>INTEGER</td>
<td>10</td>
</tr>
<tr>
<td>Email</td>
<td>VARCHAR</td>
<td>75</td>
</tr>
<tr>
<td>Colour</td>
<td>VARCHAR</td>
<td>15</td>
</tr>
<tr>
<td>Location</td>
<td>VARCHAR</td>
<td>30</td>
</tr>
</tbody>
</table>

After specifying the field name and data type for the field variables, save the table by clicking on **File>Save** shown below.
Specify the table name. The default name is Table1. Click OK.

A dialog box appears, similar to the one displayed below.

You are asked to set a primary key for the table you just created. You can select the appropriate option to set the primary key or leave the table without a primary key.

If you click Yes, the application will set the primary key for the first field created automatically. If you click No, you should see a window similar to the one displayed below.
Notice the table by the name SDetails created and visible under Tables section.

Create the following records:

<table>
<thead>
<tr>
<th>Name</th>
<th>Roll no</th>
<th>DOB</th>
<th>Class</th>
<th>Phone</th>
<th>Email</th>
<th>Color</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ravi Kaul</td>
<td>23</td>
<td>13/08/99</td>
<td>X</td>
<td>123456</td>
<td><a href="mailto:ravikaul@gmail.com">ravikaul@gmail.com</a></td>
<td>Blue</td>
<td>Delhi</td>
</tr>
<tr>
<td>Bijendar Dalal</td>
<td>13</td>
<td>15/01/99</td>
<td>X</td>
<td>567889</td>
<td><a href="mailto:dalal@gmail.com">dalal@gmail.com</a></td>
<td>Green</td>
<td>Mumbai</td>
</tr>
<tr>
<td>Radha swami</td>
<td>7</td>
<td>01/02/00</td>
<td>X</td>
<td>234353</td>
<td><a href="mailto:radhasw@gmail.com">radhasw@gmail.com</a></td>
<td>Orange</td>
<td>Gujarat</td>
</tr>
<tr>
<td>Vikas Maheswari</td>
<td>32</td>
<td>17/11/98</td>
<td>X</td>
<td>233445</td>
<td><a href="mailto:vikawari@gmail.com">vikawari@gmail.com</a></td>
<td>Blue</td>
<td>Maharashtra</td>
</tr>
<tr>
<td>Vimla Rani</td>
<td>14</td>
<td>23/09/99</td>
<td>X</td>
<td>242526</td>
<td><a href="mailto:Vimla99@gmail.com">Vimla99@gmail.com</a></td>
<td>Yellow</td>
<td>Orissa</td>
</tr>
<tr>
<td>Sandhya Reddy</td>
<td>26</td>
<td>19/12/98</td>
<td>X</td>
<td>213141</td>
<td><a href="mailto:sandhyared@gmail.com">sandhyared@gmail.com</a></td>
<td>Blue</td>
<td>Delhi</td>
</tr>
</tbody>
</table>

To insert values into the table, just double-click the table name, you should see a window similar to the one displayed below.

![Figure 12](imageURL)

Start typing the records in the table with the data provided in the excel sheet and select File > Save current record to save data in the table.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a table and enter data in it</td>
</tr>
</tbody>
</table>
| 2.    | Create a database to store your academic records using the guidelines below:  
  - Use your roll number as the file name for your database.  
  - Create fields such as subject name, required score, passing score and your percentage.  
  - Set the subject name field as the primary key.  
  Populate your database with your most recent exam results. |
ASSESSMENT

Fill in the blanks:

1. __________ are the basic building blocks of a database.

2. To design a table, you need to select __________ _____in __________ _____ option available under Task.

SESSION 6: BUILDING FORMS

Relevant Knowledge

A form provides the user a systematic way of storing information into the database. It is an interface in a user specified layout that lets users to view, enter, and change data directly in database objects such as tables.

In this exercise, you will learn to create a form.

To create a form, Click on Forms option located under Database section (Figure below).

Click Use Wizard to Create Form… option under Tasks group. The Form Wizard dialog box appears as shown below.

![Figure 13](image-url)
You can select selective fields to be sent onto the form by selecting the field name and clicking > button. You can select individual fields in a database or all fields in a database.

To use all the fields in the table in a form, click the >> button.

Notice the fields displayed under **Fields in the forms** section (Figure below).

Click **Next>**. You see the **Set up a sub form** step dialog box of the wizard as shown below.
You can select the option **Add Subform** if you need to insert the contents in the table in a separate form. Click **Next >**.

Now you need to arrange selected fields in a form. You can use different styles from the list displayed below:

![Figure 17](image1.png)

Once you have selected a style, click **Next >**

A dialog box appears wherein you can select the data entry model.

![Figure 18](image2.png)

Click **Next >**. You should see a dialog box wherein you can specify the styles to be used in the form.

![Figure 19](image3.png)
Click *Next >*. You see a dialog box where you can specify the name of the form. Click *Finish*.

![Figure 20](image)

A form window appears. Notice that the records in the table are displayed automatically within the form that you just created.

![Figure 21](image)

You can add new records to the table using the form by clicking the symbol located at the bottom as shown below.

![Figure 22](image)

Once you click the symbol, you will be displayed with a window for creating records (Figure below).
You have learnt to create records using design view in the earlier sessions. You can add records using the form as displayed below. Type the following data in the textbox provided in the box as shown below:

<table>
<thead>
<tr>
<th>Name</th>
<th>Gautam</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollno</td>
<td>43</td>
</tr>
<tr>
<td>DOB</td>
<td>10/12/99</td>
</tr>
<tr>
<td>Class</td>
<td>X</td>
</tr>
<tr>
<td>Phone</td>
<td>325476</td>
</tr>
<tr>
<td>Color</td>
<td>Pink</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:gautam43@gmail.com">gautam43@gmail.com</a></td>
</tr>
<tr>
<td>Location</td>
<td>Assam</td>
</tr>
</tbody>
</table>

To view the saved records, Double-click **SDetails** (Table name) under Tables section. A window similar to the one below will be displayed; notice the record that you created using a form is also displayed along with other records (Figure below)
Now enter three more records using the form and view them using the above mentioned procedure.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a form</td>
</tr>
<tr>
<td>2.</td>
<td>Enter data in a table using a form</td>
</tr>
<tr>
<td>3.</td>
<td>Create a form for the academic database created in the earlier session. Populate the academic database with mark results using the form.</td>
</tr>
</tbody>
</table>

**ASSESSMENT**

Fill in the blanks:

1. A _______ helps the user to systematically store information in the database.

2. A _______ enables users to view, enter, and change data directly in database objects such as tables.

3. To create a form you need to select _______ option available under Database section.
SESSION 7: CREATE AND MANAGE QUERIES

Relevant Knowledge

Having created the tables and entering data into them, now you want to extract some information. That’s when you query the database. As the name suggests, query is to collect specific information from the pool of data. A query helps us join information from different tables and filter that information. **Filtering** means that the query uses criteria you provide it to hide some data and present only what you want to see.

Some RDBMS provide a graphical means to create queries, but most RDBMS do not do so. That’s where you use SQL (pronounced as “sequel”) or Structured Query Language. Query languages are computer languages used to make queries into databases and information systems. Queries are commands that are used to define the data structure and also to manipulate the data in the database.

A SELECT statement retrieves zero or more rows from one or more database tables or database views. In most applications, SELECT is the most commonly used Data Manipulation Language (DML) command.

The SELECT statement has many optional clauses:
- **WHERE** specifies which rows to retrieve.
- **ORDER BY** specifies an order in which to return the rows.

To retrieve all the columns in a table the syntax is: `SELECT * FROM <TABLENAME>;`

In order to execute queries click on the **Queries** option available on the left side under database section, click **Create Query in SQL View** as shown below.

![Figure 25](image)

A window appears similar to the one displayed below.
You can type the query in the above window and execute it by using the F5 function key or by clicking the icon in the window.

For example, if you want to display all the data in the table that you created in the early session, then the select statement will be: \textit{select * from SDetails;}

After executing the select query the output will be shown similar to the one displayed below.

![Figure 26](image)

To get details about the list of students whose favorite color is blue, you can use: \textit{select * from SDetails where Color='Blue';}

After executing the select query the output will be shown similar to the one displayed below.

![Figure 27](image)

![Figure 28](image)
To view records in ascending order of RollNo, from the table the select statement will be:

```
select * from SDetails order by “Rollno” ASC;
```

![Figure 29](image)

You can add, modify or delete records using the **Insert, Update and Delete** commands.

To type and execute SQL commands, click on **Tools > SQL**. A window similar to the one below will be displayed.

![Figure 30](image)

You can type the SQL Commands in the **Command to execute** space and click on Execute.

**INSERT statement**

INSERT statement is used to add one or more records to a database. The general syntax of the insert statement is shown below.

```
INSERT INTO <table_name><column1, column2, column3...> VALUES <value1, value2, value3 ...>;
```

To add a record in the database created earlier, type the following and click Execute.

```
insert into SDetails ("ID", "Name", "Rollno", "DOB", "Class", "Phone", "Email", "Color", "Location")
values ('8', 'Ranjith Singh', '67', '12-03-99','X', '435363', 'ranjth99@gmail.com', 'White', 'Bihar');
```
After inserting the data into the table, use select query to view the updated table. After execution you should see a window similar to the one displayed below.

![Figure 31](image1)

**UPDATE statement**

Update statement is used for modifying records in a database. The general syntax of the update statement is as follows:

```
UPDATE <table_name> SET <column_name> = value [, column_name = value ...] [WHERE <condition>]
```

To update a record using update statement, type the following and click Execute.

`update SDetails set Location = 'Bhubaneswar' where Rollno = 14;`

Execute select query to view the updated table. After execution you should see a window similar to the one displayed below.

![Figure 32](image2)

**DELETE statement**

Delete Statement is used to remove one or more records in a database. The general syntax of the delete statement is as follows:

```
DELETE FROM <table_name> [WHERE] <condition>;
```
To delete one of the records in the table created earlier using delete statement, type the following and click **Execute:**

```sql
DELETE from SDetails where ID=8;
```

Execute select query to view the updated table. After execution you should see a window similar to the one displayed below.

![Figure 33](image)

Notice the record with the Roll no 8 is deleted from the database.

**CREATE Statement**

Create statement is used for creating a database or a table in any RDBMS Software. A commonly used CREATE command is the CREATE TABLE command. The general syntax of the create statement is shown below.

```
CREATE TABLE <TABLENAME> ([column definitions]) [table parameters]
```

Column definitions: A comma-separated list consisting of any of the following

Column definition: [column name] [data type] {NULL | NOT NULL} {column options}

Primary key definition: PRIMARY KEY ([comma separated column list])

For example, if you would like to create a table using the Create statement, type the following and click Execute.

```sql
CREATE TABLE Employee (ID INTEGER, Name VARCHAR (50),
  Department VARCHAR (50),
  Address VARCHAR (120),
  Contact_number INTEGER);
```

Now create 5 records in the table and use the SQL statements to view, modify and delete them.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Open the academic database created in the previous sessions.</td>
</tr>
<tr>
<td>2.</td>
<td>Use the select query statement to query and sort on subjects marks scored was greater than 50%.</td>
</tr>
<tr>
<td>3.</td>
<td>Create a database for a school library.</td>
</tr>
<tr>
<td></td>
<td>Hint : Create fields for book title, cost, provider, availability, etc</td>
</tr>
<tr>
<td>4.</td>
<td>Create a database for maintaining a song collection.</td>
</tr>
<tr>
<td></td>
<td>Hint : Create fields for fields such as artist, movie, year released, etc.</td>
</tr>
<tr>
<td>5.</td>
<td>Create a database for collecting and maintaining census data.</td>
</tr>
<tr>
<td></td>
<td>Hint : Create fields for fields such as First Name, Last Name, DOB, Place of birth, Employment Status, etc.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. A __________ is helps to collect specific information from the pool of data in the database.
2. __________ statement retrieves zero or more rows from one or more database tables or database views.
3. __________ statement is used to add one or more records to a database.
4. __________ statement is used for modifying records in a database.
5. __________ statement is used to remove one or more records in a database.
6. __________ statement is used for creating a database or a table in any RDBMS Software.
SESSION 8: DESIGN REPORTS

Relevant Knowledge

A report is used to generate the overall work outcome in a clear format. You can also create reports in database.

Click on Reports section under Database in the OpenOffice base application.

Once you select the option, you should see a window similar to the one displayed below.

![Figure 34]

Now we can generate the report for the table created earlier.

Click on Use Wizard to Create Report… option available under Tasks.

Once you select the Use Wizard to Create Report… option. You should see a window similar to one displayed below.

![Figure 35]

You have to select all the table fields by selecting the >> button, once you click the button >> you should see a dialog box similar to the one displayed below.
Click **Next >**.
Once you click **Next >**, you should see a dialog box similar to the one displayed below.

You can redefine the label of the fields in the reports or else you can set the default name.
Click **Next >**.
Once you click **Next >**, you should see a dialog box similar to the one displayed below.
You can define grouping for the fields of the table.

Click **Next >**.

Once you click **Next >**, you should see a dialog box similar to the one displayed below.

![Figure 39](image)

You can sort the field variables in the report by selecting the appropriate field and sorting method.

Click **Next >**.

Once you click **Next >**, you should see a dialog box similar to the one displayed below.

![Figure 40](image)

You can select the layout of the report by selecting the appropriate option available under the Layout of data down list and you can also select the orientation of the report.

Click **Next >**.

Once you click **Next >**, you should see a dialog box similar to the one displayed below.
You can define a name for the report or you can use the name of the table itself for the report also.

Click Finish.

Once you click Finish you should see a window similar to the one displayed below with the report.

Now create a report containing only Name, RollNo and Phone details. Use different layouts for the report design.
EXERCISE

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a report to display data from table</td>
</tr>
<tr>
<td>2.</td>
<td>Open the academic database created earlier.</td>
</tr>
<tr>
<td>3.</td>
<td>Design a report to display your entire academic score card.</td>
</tr>
</tbody>
</table>

ASSESSMENT

Fill in the blanks:

1. A __________ is used to generate the overall work outcome in a clear format.

2. To create reports you need to select _________________ option available under Tasks.